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Introduction

This chapter contains information on the following:

Introduction to Wireless Networking
Mesh Networking

Guidelines for Roaming

Management and Monitoring Capabilities

Introduction to Wireless Networking

An Access Point extends the capability of an existing Ethernet network to devices on a wireless network. Wireless
devices can connect to a single Access Point, or they can move between multiple Access Points located within the same
vicinity. As wireless clients move from one coverage cell to another, they maintain network connectivity.

In a typical network environment (see Figure 1-1), the AP functions as a wireless network access point to data and voice
networks. An AP network provides:

Seamless client roaming for both data and voice (VolP)
Easy installation and operation

Over-the-air encryption of data

High speed network links

-

Internet

Coverage +_
Area

Figure 1-1 Typical Wireless Network Access Infrastructure
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Mesh Networking
Using the ORINOCO Mesh Creation Protocol (OMCP), the AP-4000MR supports structured Mesh networking.

In a Mesh network, access points use their wireless interface as a backhaul to the rest of the network. Access points
connected directly to the wired infrastructure are called “Portals;” Mesh Access Points relay packets to other Mesh
Access Points to reach the Portal, dynamically determining the best route over multiple “hops.”

Mesh networks are self-configuring (a Mesh access point will scan for other Mesh Access Points periodically and choose
the best path to the portal) and self-healing (the network will reconfigure data paths if an AP or link fails or becomes
inactive).

Mesh Network Convergence

Mesh networks are formed when Mesh APs on the same channel have the identical Mesh SSID, security settings, and
management VLAN ID when VLAN is enabled. As these Mesh APs come online, they discover and set up links with each
other to form the Mesh network.

Mesh Portal

[

Mesh AP".| MAP2

Mesh Portal

Figure 1-2 Mesh Startup Topology Example — Step 1

In Figure 1-2, MP1 and MP9 are APs configured as Mesh portals, each on a different channel. When they are up and
running, they will transmit beacons with a Mesh information element (IE) containing a Mesh SSID, and respond to probe
requests that contain Mesh IEs with the same Mesh SSID.

To find Mesh connections, Mesh AP (MAP) 2 through 8 will scan all allowed channels, either actively or passively. In
active scanning, the MAP sends a broadcast probe request; in passive scanning, the MAP listens for beacons. Active
scanning is used in regulatory domains that do not use Dynamic Frequency Selection (DFS); passive scanning is used in
DFS-controlled regulatory domains (see Dynamic Frequency Selection/Radar Detection (DFS/RD)). As other Mesh APs
are discovered, MAP2 through MAP8 will build a neighbor table from the beacons and probe responses they receive. The
neighbor table contains three kinds of links:

10
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» Active: Link with a Mesh neighbor that has gone through association and authentication, and the port is open.

» Connected: Link with a Mesh neighbor that has gone through association and authentication, but the port is closed.
» Disconnected: Possible link to a Mesh neighbor that has not gone through association and authentication.

From the neighbor table, MAP2 through MAP8 will select the best possible connection to the backbone network. This

connection is the active link. If a link to the backbone on a different channel is significantly better than any on the current
channel, then MAP2 through MAP8 will switch to a new channel and join the Mesh network on that channel.

In Figure 1-2 through Figure 1-4, the circles approximately indicate the range of the respective Mesh radios. As shown in
these figures, MAP2 and MAP4 will discover Mesh Portal (MP) 1, and MAP7 and MAP8 will discover MP9. MAP3 is also
within reach of MAP2 and MAP4, but they will not allow MAP3 to connect until they have established a Mesh link to the
Mesh Portal.

Assume that links are established as shown in Figure 1-3. Solid lines indicate established links.

Mesh Portal

Mesh Portal | ..-""""""-5L

Figure 1-3 Mesh Startup Topology Example — Step 2

After the first Mesh links are formed, MAP2,4,7 and 8 will add the Mesh IE to their beacon and respond to probe requests
with a Mesh IE containing the same Mesh SSID and security settings. Eventually MAP 3 will find both MAP2 and 4 and

will setup a Mesh link with the one with the best path to the portal, say MAP2. Optimal paths have low “path costs;” path
costs are calculated based on the number of hops to the portal, RSSI (relative signal strength), and medium occupancy.

Once MAP4 has established a path to the Mesh portal, MAP 3 will also establish a Mesh link with MAP4, but that
connection will remain inactive. It will only be used as a possible alternative uplink for MAP3, and at the same time an
alternative uplink for MAP4. If for some reason the link from MAP4 to MP1 fails, MAP4 can still reach the backbone via
MAP3 and MAP2. The same goes for other MAPs that discover each other.

After a short while, the network in this example will look like Figure 1-4, where solid lines indicate active Mesh links and
dotted lines indicate established but inactive Mesh links.

1
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Mesh Portal

Mesh Portal | ..-""""""-5

Figure 1-4 Mesh Startup Topology Example — Step 3

In this example, if MAP8 loses the Mesh link to MP9, MAP8 will immediately activate the Mesh link to MAP7. If the link to
MAP7 has a higher path cost than a possible link to MAP4, which has the same Mesh SSID and security mode but is on
a different channel, then MAP7 may decide to switch channels and establish and activate a link to MAP4.

Mesh Network Configuration

In the AP-4000MR, either of the wireless interfaces may be configured for Mesh functionality, with the following
considerations in mind:

» To form or join a Mesh network, Mesh APs must have identical Mesh SSIDs and security modes (None or AES). If
using AES, the shared secret should also be identical.

» All Mesh APs connected to a Portal will be on the same channel. The channel used by the Mesh Portal will determine
the channel used by all of its connected Mesh APs.

* On Mesh APs, Mesh and WDS functionality cannot co-exist on the same wireless interface. Mesh and WDS can
co-exist on Mesh Portals.

* The maximum number of links downlinks from a Mesh Portal to Mesh APs in the tree is 32. Proxim recommends a
maximum of 30-40 APs total per portal (whether connected directly to the Portal or to another Mesh AP) for an
average per-client throughput of 300-500 Kbps. This recommendation is based on the following assumptions:

— 18 Mbps throughput is available at the portal (max is 25 Mbps, but rates decrease as distance between APs
increases).

— 20 wireless clients are supported per AP.
— Average utilization (time that a client is actually transferring data) is 10%.

12



Introduction AP-4000MR User Guide
Guidelines for Roaming

If the conditions on your network are different than the assumptions above, then the maximum number of APs should
be adjusted accordingly.

NOTE: Clients whose traffic must traverse multiple hops in order to reach the portal will have lower throughput than
clients whose traffic traverses fewer hops.

Although this solution is designed to be flexible and have a short convergence time after a topology change, it is not
recommended for high-speed roaming or a highly dynamic environment.

The Mesh network assumes that the uplink to the backbone will be provided by Mesh only.

NOTE: To avoid loops, the administrator should not configure alternate links to the backbone through Ethernet or
WDS connections.

Mesh APs will avoid loops caused by Mesh links; similarly, Spanning Tree will detect and correct loops caused by
WDS and wired links.

NOTE: Neither Mesh APs nor Spanning Tree will detect loops caused by a mixture of Mesh and WD S/wired links.
Administrators should avoid any such scenario while deploying Mesh.

When VLAN is enabled, all APs in a Mesh network must have the same Management VLAN ID.

For information on configuring Mesh using the HTTP interface, see Mesh. For information on configuring Mesh using the
Command Line Interface (CLI), see Mesh Parameters in the Command Line Interface chapter.

Guidelines for Roaming

Typical voice network cell coverages vary based on environment. Proxim recommends having a site survey done
professionally to ensure optimal performance. For professional site surveyors, Ekahau™ Site Survey software is
included in the Xtras folder of the Installation CD.

An AP can only communicate with client devices that support its wireless standards.
All Access Points must have the same Network Name to support client roaming.

All workstations with an 802.11 client adapter installed must use either a Network Name of “any” or the same Network
Name as the Access Points that they will roam between. If an AP has Closed System enabled, a client must have the
same Network Name as the Access Point to communicate (see Reboot the AP.).

All Access Points and clients must have matching security settings to communicate.

The Access Points’ cells should overlap to ensure that there are no gaps in coverage and to ensure that the roaming
client will always have a connection available. To ensure optimal AP placement, Proxim recommends having a site
survey done professionally to ensure optimal performance. For professional site surveyors, Ekahau™ Site Survey
software is included in the Xtras folder of the Installation CD.

All Access Points in the same vicinity should use a unique, independent channel. By default, the AP automatically
scans for available channels during boot-up but you can also set the channel manually (see Interfaces for details).
Access Points that use the same channel should be installed as far away from each other as possible to reduce
potential interference.

If a Mesh AP switches to a new uplink, by default it will send a deauthentication message to clients connected to it.
Administrators can prevent the sending of this message by disabling the “Notify Clients on Uplink Change” parameter
on the Configure > Interfaces > Mesh > Advanced page.

In countries that require passive scanning for Mesh, the roam time may be higher.

Management and Monitoring Capabilities

There are several management and monitoring interfaces available to the network administrator to configure and
manage an AP on the network:

HTTP/HTTPS Interface

13
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* Command Line Interface
*«  SNMP Management
» SSH (Secure Shell) Management

HTTP/HTTPS Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s Ethernet Port.

HTTPS provides an HTTP connection over a Secure Socket Layer. HTTPS is one of three available secure management
options on the AP; the other secure management options are SNMPv3 and SSH. Enabling HTTPS allows the user to
access the AP in a secure fashion using Secure Socket Layer (SSL) over port 443. The AP supports SSLv3 with a 128-bit
encryption certificate maintained by the AP for secure communications between the AP and the HTTP client. All
communications are encrypted using the server and the client-side certificate.

The AP comes pre-installed with all required SSL files: default certificate, private key and SSL Certificate Passphrase
installed.

Command Line Interface

The Command Line Interface (CLI) is a text-based configuration utility that supports a set of keyboard commands and
parameters to configure and manage an AP.

Users enter Command Statements, composed of CLI Commands and their associated parameters. Statements may be
issued from the keyboard for real time control, or from scripts that automate configuration.

For example, when downloading a file, administrators enter the download CLI Command along with IP Address, file
name, and file type parameters.

You access the CLI over a HyperTerminal serial connection or via Telnet. During initial configuration, you can use the CLI
over a serial port connection to configure an Access Point’s IP address. When accessing the CLI via Telnet, you can
communicate with the Access Point from over your LAN (switch, hub, etc.), from over the Internet, or with a “crossover”
Ethernet cable connected directly to your computer’s Ethernet Port. See Command Line Interface (CLI) for more
information on the CLI and for a list of CLI commands and parameters.

SNMP Management

In addition to the HTTP and the CLI interfaces, you can also manage and configure an AP using the Simple Network
Management Protocol (SNMP). Note that this requires an SNMP manager program, like HP Openview or Castlerock’s
SNMPc. The AP supports several Management Information Base (MIB) files that describe the parameters that can be
viewed and/or configured over SNMP:

* MIB-Il (RFC 1213)

+ Bridge MIB (RFC 1493)

+ Ethernet-like MIB (RFC 1643)

+ 802.11 MIB

* ORINOCO Enterprise MIB

Proxim provides these MIB files on the CD-ROM included with each Access Point. You need to compile one or more of

the above MIBs into your SNMP program’s database before you can manage an Access Point using SNMP. See the
documentation that came with your SNMP manager for instructions on how to compile MIBs.

The Enterprise MIB defines the read and read-write objects that can be viewed or configured using SNMP. These objects
correspond to most of the settings and statistics that are available with the other management interfaces. See the
Enterprise MIB for more information; the MIB can be opened with any text editor, such as Microsoft Word, Notepad, or
WordPad.

14
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SNMPv3 Secure Management

SNMPv3 is based on the existing SNMP framework, but addresses security requirements for device and network
management.

The security threats addressed by Secure Management are:

» Modification of information: An entity could alter an in-transit message generated by an authorized entity in such a
way as to effect unauthorized management operations, including the setting of object values. The essence of this
threat is that an unauthorized entity could change any management parameter, including those related to
configuration, operations, and accounting.

* Masquerade: Management operations that are not authorized for some entity may be attempted by that entity by
assuming the identity of an authorized entity.

* Message stream modification: SNMP is designed to operate over a connectionless transport protocol. There is a
threat that SNMP messages could be reordered, delayed, or replayed (duplicated) to effect unauthorized
management operations. For example, a message to reboot a device could be copied and replayed later.

» Disclosure: An entity could observe exchanges between a manager and an agent and thereby could learn of notifiable
events and the values of managed objects. For example, the observation of a set command that changes passwords
would enable an attacker to learn the new passwords.

To address the security threats listed above, SNMPv3 provides the following when secure management is enabled:

« Authentication: Provides data integrity and data origin authentication.
» Privacy (a.k.a Encryption): Protects against disclosure of message payload.
» Access Control: Controls and authorizes access to managed objects.

The default SNMPv3 username is administrator, with SHA authentication, and DES privacy protocol.

SSH (Secure Shell) Management

You may securely also manage the AP using SSH (Secure Shell). The AP supports SSH version 2, for secure remote CLI
(Telnet) sessions. SSH provides strong authentication and encryption of session data.

The SSH server (AP) has host keys - a pair of asymmetric keys - a private key that resides on the AP and a public key
that is distributed to clients that need to connect to the AP. As the client has knowledge of the server host keys, the client
can verify that it is communicating with the correct SSH server.

NOTE: The remainder of this guide describes how to configure an AP using the HTTP Web interface or the CLI interface.
For information on how to manage devices using SNMP or SSH, see the documentation that came with your
SNMP or SSH program. Also, see the MIB files for information on the parameters available via SNMP and SSH.

IMPORTANT!

The remainder of the User Guide discusses installing your AP and managing it using the Web and CLI
interfaces only.
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Installation and Initialization

In this chapter:

AP-4000MR Hardware Description

— Overview

— Power/Ethernet Port LEDs

— Power Injector

— Serial Connection

— Antenna Connectors
Prerequisites

— General Prerequisites

— Mesh Prerequisites

— PXU (ProximUnify) Prerequisites
System Requirements

Product Package

Hardware Installation

— Step 1: Choose a Location

— Step 2: Unpack Shipping Box

— Step 3: Assemble the Cable

— Step 4: Assemble Mounting Hardware
— Step 5: Mount the Unit

— Step 6: Plug in the Cables

— Step 7: Power on the Unit

— Step 8: View LEDs

— Step 9: Tighten the Cables

— Step 10: Weatherproof the Connectors
Information for Professional Installers
— Adjusting Tx Output Power

— Antenna Types and Maximum Gain
Initialization

— Using ScanTool

— Logging In

— Using the Setup Wizard

— Installing the Software
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AP-4000MR Hardware Description

Overview

The AP-4000MR is a ruggedized tri-mode AP optimized for outdoor deployments and equipped with one embedded
5 GHz (802.11a) radio and one embedded 2.4 GHz (802.11b/g) radio, enabling simultaneous support of 802.11a,
802.11b, and 802.11g clients. The unit also supports Mesh operation on either the 2.4 GHz or the 5 GHz band.

Each unit is equipped with:

* Power/Ethernet port: used for Ethernet connection and Power-over-Ethernet (PoE) using the supplied power
injector.

« Serial connection: used for entering commands in the Command Line Interface (CLI).

» LED indicator(s): dual LEDs used to indicate the power and operational states of the unit.

« External antenna connectors (two): one for 2.4 GHz operation, the other for 5 GHz operation.

* Grounding screws (two)
NOTE: This product does not contain internal antennas. At least one external antenna must be used to make the

product operational. For information on antennas authorized for use with this product, refer to Information for
Professional Installers or to Safety and Regulatory Compliance Guide on the installation CD.

See the following for more information:

» Power/Ethernet Port LEDs
* Power Injector

» Serial Connection

* Antenna Connectors

r’r —_——— Power and Ethernet Port with LED Indicators

Serial Connection

|
L A0 N RN B R R RN O N JJJl

PWR/ETHERNET] SERIAL |

| .\® & 0 N — Grounding Screw

2.4 GHz (802.11b/g) Radio 5 GHz (802.11a) Radio
Antenna Connector (capped) Antenna Connector (capped)

Figure 2-1 AP-4000MR Unit (Back View)

Power/Ethernet Port LEDs

Two LED indicators are available on the Ethernet port of the unit. These LEDs display the power state of the unit and the
activity of the Ethernet and radios. See Step 8: View LEDs for LED behavior.
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Figure 2-2 LED Indicators

Power Injector

PWR/ETHERNET

Radio
LED

The power injector provides Power-over-Ethernet (PoE), supplying electricity and wired connectivity to the unit over a
single 24 AWG CAT5 (diameter .114 to .250 inches/2.9 to 6.4 mm). The unit is not 802.3af-compatible. Always use the
supplied power injector to ensure that the unit is powered properly. Note that the PoE module provides +48 VDC over a

standard CAT5 Ethernet cable.

Depressing the Reload button (located on the side of the power injector) for five seconds during power-up remotely
resets the unit to its factory default settings. You will need to use the end of a paper clip or pin to depress the Reload

button.

Serial Connection

The serial connection is used for issuing CLI commands using a terminal emulator. The serial connection is made with an
DB9 to mini-DIN 8-pin plug (also referred to as a “dongle”). During hardware installation, plug the mini-DIN 8-pin plug to

the radio and connect the serial end to your PC.

Connections are as follows:

DB9 Connector Color Mini-DIN Plug
2 White/Orange 1
3 Orange
5 White/Blue
— Blue 3,6
— White Green

Antenna Connectors

AP-4000MR units have two external antenna connectors (Type-N female). These units have no internal antennas.
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2.4 GHz (802.11b/g) Radio 5 GHz (802.11a) Radio

Figure 2-3 AP-4000MR Antenna Connectors

External connector specifications are as follows:

Characteristic

Limit

Connector type

Type-N, female

Impedance

50 Ohms over the operating frequency band

Antenna Return Loss

-10 dB maximum
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Prerequisites

General Prerequisites

Before installing your unit, you need to gather certain network information. The following table identifies the information

you need.

Network Name (SSID of the
wireless cards)

You must assign the Access Point a Network Name before wireless users can
communicate with it. The clients also need the same Network Name. This is not the
same as the System Name, which applies only to the Access Point. The network
administrator typically provides the Network Name.

AP’s |IP Address

If you do not have a DHCP server on your network, then you need to assign the
Access Point an IP address that is valid on your network.

HTTP Password

Each Access Point requires a read/write password to access the web interface. The
default password is public.

CLI Password

Each Access Point requires a read/write password to access the CLI interface. The
default password is public.

SNMP Read Password

Each Access Point requires a password to allow get requests from an SNMP
manager. The default password is public.

SNMP Read-Write Password

Each Access Point requires a password to allow get and set requests from an SNMP
manager. The default password is public.

SNMPv3 Authentication
Password

If Secure Management is enabled, each Access Point requires a password for
sending authenticated SNMPv3 messages. The default password is public. The
default SNMPv3 username is administrator, with SHA authentication, and DES
privacy protocol.

SNMPv3 Privacy Password

If Secure Management is enabled, each Access Point requires a password when
sending encrypted SNMPv3 data. The default password is public.

Security Settings

You need to determine what security features you will enable on the Access Point.

Authentication Method

A primary authentication server may be configured; a backup authentication server is
optional. The network administrator typically provides this information.

Authentication Server Shared
Secret

This is a password shared between the Access Point and the RADIUS authentication
server (so both passwords must be the same), and is typically provided by the
network administrator.

Authentication Server
Authentication Port

This is a port number (default is 1812) and is typically provided by the network
administrator.

Client IP Address Pool
Allocation Scheme

The Access Point can automatically provide IP addresses to clients as they sign on.
The network administrator typically provides the IP Pool range.

DNS Server IP Address

The network administrator typically provides this IP Address.

Gateway IP Address and
Subnet Mask

The gateway IP address and subnet mask of the network environment where the
Access Point is deployed.
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Mesh Prerequisites

Before setting up a Mesh network, gather the following information:

Mesh Mode

The mode in which the AP will be used. If the AP will be connected directly to the
wired backbone, it should be configured for Mesh Portal mode; if it will connect to the
Portal and backbone wirelessly, it should be configured for Mesh AP mode. If the AP
will not be used in a Mesh network, Mesh Mode can be disabled.

Mesh Interface Number

The interface on which the Mesh functionality will be enabled. For Wireless A, the
interface number is 3; for Wireless B, the interface number is 4.

Mesh SSID

The name of the Mesh network. The Mesh SSID should be between 1 and 16
characters.

Mesh Security Mode

Mesh links may be secured through AES encryption. You may also choose to use
Mesh functionality without security enabled (not recommended).

Mesh AP Shared Secret

The password shared between Mesh Access Points when AES is enabled (AES is
enabled by default). This password should be between 6 and 32 characters. The
default password is public.

PXU (ProximUnify) Prerequisites

Before setting up a PXU Profile, gather the following information:

Parameter

Description

Module Parameters

Configure the Primary and Secondary Modules parameters

PXU IP Address

This field is for IP address of the PXU unit. The default is 0.0.0.0.

Domain Name

The field where the domain name will be written.

Secret

Shared Secret/ Confirm Shared

The password is shared by the PXU module and the AP. The same password must
also be configured on the PXU module. The default password is “public.”

Response Time

This is the maximum time, in seconds, that the AP should wait for the PXU module to
respond to a request. The range is 1-10 seconds; the default is 3 seconds.

Retransmission

The maximum number of times an authentication request may be transmitted. The
range is 0 to 4, the default is 3.

Module Status

The status of the PXU Profile

System Requirements

To begin using an AP, you must have the following minimum requirements:

* A 10Base-T Ethernet or 100Base-TX Fast Ethernet switch or hub or cross-over Ethernet cable

* At least one of the following IEEE 802.11-compliant devices:
— An 802.11a, 802.11b, or 802.11b/g client device

* A computer that is connected to the same IP network as the AP and has one of the following Web browsers installed:
- Microsoft® Internet Explorer 6 with Service Pack 1 or later and patch Q323308

- Netscape® 7.1 or later
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Product Package

Each AP-4000MR shipment includes the items in the following table. Verify that you have received all parts of the
shipment.

NOTE: Unless noted in this table, cables are not supplied with the unit.

AP-4000MR Unit |
| . Y
i
i
{

8 ey ey ey wu A

DB9 to Mini-DIN Serial Connector C;

Power Injector and Cord

Cable Termination Kit Kit includes the following:

ESRERwmer
b c d

a e

RJ45 connectors (2)
Sealing caps (2)
Lock nut

Sealing nut

e. Grounding screws
Mounting Kit Kit includes the following:

oo oo

Mounting clamp for wall/pole
Extension arm

Mounting plate to enclosure
Mounting clamp for pole mounting

oo oo
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Mounting Hardware The following mounting hardware, included with the mounting kit:

Quantity Description

6 ea. Plain washer #5/16 -
2 ea. Hex Cap Screw NC 5/16-18 x 35 I
2 ea. Nut NC 5/16-18 -
4 ea. Helical Spring Lock Washer #1/4 .
~
4 ea. Helical Spring Lock Washer #1/16 .
S
2 ea. Hex Cap Screw NC 5/16-18 x 80 -
4 ea. 68764, Screw, Machine, Pan,
Philips, 1/4"-20, 5/8"L .

Rubber Tape Strip

Installation CD t

Quick Installation Guide

Bros em
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Hardware Installation

This section describes the steps required to install and mount the unit. The installation procedure does not include the
mounting and connection of antennas. See Information for Professional Installers or the Safety and Regulatory
Compliance Guide on the installation CD for important information regarding antennas.

IMPORTANT:
All AP-4000MR units must be installed by a suitably trained professional installation technician or by
a qualified installation service.

IMPORTANT:
Proxim recommends you to visit the Proxim Support site at http://support.proxim.com for Regulatory
Information and latest product updates.

NOTE: Be sure to read the Release Notes file on the product CD as it contains software version and driver information
that may not have been available when this document was produced.

NOTES: Equipment is to be used with, and powered by, the power injector provided or by a power injector that meets
these requirements:
* UL-Listed/ITE (NWGQ)
* Limited Power Source Output per UL/IEC 60950
* CE-marked
» Approved for Power-over-Ethernet
* Rated output, 48 Vdc/0.42 A
* Pinout follows 802.3af standard for mid-span devices

WARNING:

To ensure proper grounding, use the hole at the bottom point on the back of each unit and the provided
grounding screws to attach a ground wire of at least 10 AWG stranded to each unit. This wire must be as
short as possible and must be connected to a low-impedance earth ground. Use proper wire grounding
techniques in accordance with local electric codes.

See the following sections for installation instructions:

» Step 1: Choose a Location

+ Step 2: Unpack Shipping Box

» Step 3: Assemble the Cable

» Step 4: Assemble Mounting Hardware
» Step 5: Mount the Unit

» Step 6: Plug in the Cables

» Step 7: Power on the Unit

» Step 8: View LEDs

» Step 9: Tighten the Cables
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» Step 10: Weatherproof the Connectors
» Step 11: Install Documentation and Software

Step 1: Choose a Location

To make optimal use of the unit, you must find a suitable location for the hardware. The range of the radio unit largely
depends upon the position of the antenna. Proxim recommends you do a site survey, observing the following
requirements, before mounting the hardware.

» The location must allow easy disconnection of power to the radio if necessary.

* Air must be able to flow freely around the hardware.

* The radio unit must be kept away from vibration and excessive heat.

» The installation must conform to local regulations at all times.

The unit is designed to directly mount to a pole or wall. Using the supplied brackets and hardware, you can mount it to a

1.25 inch to 4.5-inch pole (outside diameter). Using just one of the pole mounting brackets, you can mount it to a wall or
other flat surface.

CAUTION: Proxim recommends the use of a lightning arrestor at the building ingress point. You can purchase the
Proxim Lightning Protector; see the documentation that comes with the Lightning Protector for more
information and installation instructions.

Step 2: Unpack Shipping Box
1. Unpack the unit and accessories from the shipping box.

2. Note the Ethernet and MAC addresses of the unit, as well as the serial number. The addresses may be used when
configuring the unit. The serial number is required to obtain support from Proxim. Keep this information in a safe
place.
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Step 3: Assemble the Cable

You will be attaching an outdoor-rated 24 AWG CAT5 cable (diameter .114 to .250 inches/2.9 to 6.4 mm) (not provided)
to the Power-over-Ethernet port on the back of the unit and weatherproofing the assembly later in the installation
procedure. First, you must construct the cable and assemble the weatherproofing cable covers as described in the
following steps. Proxim greatly simplifies this assembly process by offering pre-assembled CAT5 cable kits in 25m, 50m,
and 75m lengths (part numbers 69819, 69820, and 69821, respectively).

1. Slide the sealing nut (A) over the bare end of the CAT5 cable.

2. Slide the lock nut (B) over the bare end of the CAT5 cable.

3. Slide the sealing cap (C) over the bare end of the CAT5 cable. Make sure the red rubber gasket is inside the cap.

4

. Apply two wraps of 0.5” wide Teflon tape (not supplied with unit) around the threads of the lock nut (B) that will go
inside the sealing cap.

Thread the lock nut (B) onto the sealing cap (C), and hand tighten.

Terminate the RJ45 connectors (D) to both ends of the CAT5 cable; test for proper wiring (using a straight-through
cable).

o o

D C T B A

Apply Teflon
tape here

NOTE:

» The cable must feed through all parts of the weatherproof cap before the RJ45 is crimped on the outdoor
Ethernet cable.

» The cable between the power injector and the unit must be a straight-through Ethernet cable (without
crossover).

* Due to variance in CAT5 cable diameter, termination techniques of the installer, and the application of proper
tightness of the connectors, it is strongly recommended that all cable connectors are secured by external
weatherproofing. This process will be described in Step 10: Weatherproof the Connectors.
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Step 4: Assemble Mounting Hardware

1. Attach the mounting plate (A) using the provided screws and washers (Torque 9 N-m/75 in-Ibs).

|

|

.J|_' Torque 9 N-m/75 in-lbs
B |

@1

3. Attach the mounting bracket (C) to extension arm (B) with the screw, nut, and washers provided.

4. Tighten assembly (Torque 15 N-m/130 in-Ibs).

Torque 15 N-m/130 in-lbs

The following figure shows the full assembly attached to the unit.
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Step 5: Mount the Unit

WARNING: If the AP is going to be used as part of a Mesh network, you will need to perform initial configuration
of the parameters mentioned in the Prerequisites section of this chapter before you mount the AP.

See Initialization and Mesh to configure the parameters.
CAUTION: To ensure that water does not gather around the antenna connectors, mount the unit with the antenna
connectors facing downward
1. To pole-mount, insert the provided screws through bracket F. Fasten around the pole to bracket E and secure (Torque

11 N-m/100 in-lbs).

Torque 11 N-m/100 in-lbs
2 screws

2. To wall-mount the unit, mount bracket (E) to the wall using 4 screws (not provided), as shown:

_—

i
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Step 6: Plug in the Cables
1. Plug one end of the CAT5 cable (A) into the RJ45 jack of the unit (B).

@

2. Connect the free end of the CAT5 cable to the “Data and Power Out” port on the power injector.

3. To connect the unit through a hub or a switch to a PC, connect a straight-through Ethernet cable between the
network interface card in the PC and the hub, and between the hub and the RJ45 “Data In” port on the PoE adapter.

To connect the unit directly to a PC, connect a cross-over Ethernet cable between the network interface card in the
PC and the RJ45 “Data In” port on the power injector.
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Step 7: Power on the Unit

Once you have connected the power injector to the Ethernet cabling and plugged the power injector cord into an AC
outlet, the unit is powered on. There is no ON/OFF switch on the unit. To remove power, unplug the AC cord from the AC
outlet or disconnect the RJ45 connector from the “Data and Power Out” port on the power injector.

WARNING: To avoid damaging your router/switch, do not connect the RJ45 port labeled "Data & Power Out”
from the power injector to your router/switch.
Step 8: View LEDs

When the unit is powered on, it performs startup diagnostics. When startup is complete, two LEDs show the unit’s
operational state. The LEDs are located on the unit's Ethernet connector.

NOTE: Make sure the domed sealing nut is loose before unscrewing the cap or the Ethernet cable may be twisted and
become damaged.

L= % -

PWR/ETHERNET

Power/Ethernet Radio
LED LED
Figure 2-4 LED Indicators
LEDs exhibit the following behavior:
LED State Power/Ethernet LED Radio LED
Flashing Green Power is on, unit is booting up, Ethernet | Radios are being initialized.
link is down.
Solid Green Power is on, Ethernet link is up. Both radios are operational.

30



Installation and Initialization AP-4000MR User Guide
Hardware Installation

Step 9: Tighten the Cables

1. Apply two wraps of Teflon tape around the threads of the unit's RJ45 jack (A) in a clockwise direction.
2. Make sure that the red rubber gasket is still seated in the sealing cap of the sealing cap/lock nut assembly (B);

3. Slide the sealing cap/lock nut assembly (B) over the RJ45 jack (A) and thread onto enclosure. Hand tighten first, then
use a pipe wrench or similar tool to tighten one more quarter turn.

CAUTION: Do not over-tighten!
4. Tighten the lock nut (C) (Torque 4 N-m/35 in-lbs).
5. Thread the sealing nut (D) onto the sealing cap/lock nut assembly (B) and tighten (Torque 3 N-m/25 in-lbs).

CAUTION: The lock nut (C) on the sealing cap/lock nut assembly (B) must be fully tightened over the RJ45 connector
before the sealing nut (D) is fully tightened. Otherwise, the Ethernet cable may twist and damage.

a2
i
f—
o

F -
A (Apply Teflon

/ tape here)

Torque 4 N-m/35 in-lbs
Torque 3 N-m/25 in-lbs
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Step 10: Weatherproof the Connectors

After you have fully assembled and tightened the cable, use the provided self-fusing, rubber-based tape strip and
electrical tape (not provided; Proxim recommends Scotch™ Super 33+ Vinyl Electrical Tape) to seal the connection, as

follows.

1. Remove the film liner from the rubber-based tape strip, and stretch the tape until it is approximately half of its original
width. This activates the self-fusing action of the tape, which will set up over time to create a single, waterproof mass.

2. Stretch and wrap the tape around the connector tightly, starting below the connector cap and against the unit and
wrapping in a clockwise direction. Wrap the tape once around the base of the connector cap (A). Continue to wrap
the tape spirally around the connector in a clockwise direction, maintaining a 50% width overlap (B). Continue
wrapping the tape spirally upward (C) until the tape extends onto the cable and you have used the entire length of
tape. Seal the tape tightly against the connector and the cable (D).

NOTE: Be sure to wrap the tape in a clockwise direction; wrapping the tape in a counterclockwise direction may
loosen up the connector.

Start below connector cap Continue onto cable

3. In the same manner as described in Step 2 above, apply a layer of black electrical tape (not provided) over the
rubber-based tape for further protection. Make sure the electrical tape also extends beyond the rubber-based tape to

seal it.

4. Repeat the weatherproofing procedure for other connectors as appropriate.
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Step 11: Install Documentation and Software

To install the documentation and software on a computer or network:
1.

Place the installation CD in a CD-ROM drive. The installer normally starts automatically. (If the installation program

does not start automatically, click setup.exe on the installation CD.)

Follow the instructions displayed on the installer windows. The following documentation and software products are
installed:

Available from Start > All Programs > ORINOCO > AP-4000MR:

Available from C:\Program Files\ORiNOCO\AP-4000MR:

Scan Tool
Online Help
User Guide

ScanTool program

Read Me

License agreement

Problem report form

PDF folder, containing:

— User Guide

— Quick Install Guide

— Safety and Regulatory Compliance Guide
HTML folder, containing:

— Online Help (double-click on index.htm to launch)
Xtras folder, containing:

— TFTP Server

— Acrobat Reader
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Information for Professional Installers

Adjusting Tx Output Power

Use the following formula in combination with the table of EIRP limits to calculate system transmit power (based on EIRP
limits):

Tx Power Allowed (dBm) = EIRP Limit (dBm) + CL (dB) — G (dB)
where:

Tx Power = Output power measured at the antenna input

EIRP Limit = EIRP limits specified below

CL = Coax cable loss including loss of connectors

G = Antenna Gain

Band EIRP Limit (dBm)
2.4 GHz 20
5.15 - 5.25 GHz* 23
5.25 - 5.35 GHz* 23
5.47 - 5.725 GHz 30

* For EU countries, 5.15-5.35 GHz are for indoor use only.

Antenna Types and Maximum Gain

Professional installers should select only the antenna types listed in the following table, with gain not exceeding the listed
maximum gain for each type.

Frequency Band Antenna Type Maximum Gain (dBi)
2.4 GHz Omni Directional 10
Flat Panel 14
Yagi 14
Parabolic 24
5 GHz Omni Directional 13
Flat Panel 28.2
Sector 17
Parabolic 33.4
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Initialization

The following sections detail how to initialize the AP using ScanTool, log in to the HTTP interface, perform an initial
configuration of the AP using the Setup Wizard, and download the required AP software.

* Using ScanTool

* Logging In

* Using the Setup Wizard
* Installing the Software

Using ScanTool

ScanTool is a software utility that is included on the installation CD-ROM. It is an initial configuration tool that allows you
to find the IP address of an Access Point by referencing the MAC address in a Scan List, or to assign an IP address if one
has not been assigned.

The tool automatically detects the Access Points installed on your network, regardless of IP address, and lets you
configure each unit’s IP settings. In addition, you can use set initial device parameters that will allow the AP to retrieve a
new software to an AP that does not have a valid software image installed (see Client Connection Problems).

To access the HTTP interface and configure the AP, the AP must be assigned an IP address that is valid on its Ethernet
network. By default, the AP is configured to obtain an IP address automatically from a network Dynamic Host
Configuration Protocol (DHCP) server during boot-up. If your network contains a DHCP server, you can run ScanTool to
find out what IP address the AP has been assigned. If your network does not contain a DHCP server, the Access Point’s
IP address defaults to 169.254.128.132. In this case, you can use ScanTool to assign the AP a static IP address that is
valid on your network.

ScanTool Instructions
Follow these steps to install ScanTool and initialize the AP:

1. Power up, reboot, or reset the AP.

2. Double-click the ScanTool icon on the Windows desktop to launch the program (if the program is not already
running). If the icon is not on your desktop, click Start > All Programs > ORiNOCO > AP-4000MR > ScanTool.

NOTE: If your computer has more than one network adapter installed, you will be prompted to select the adapter that
you want ScanTool to use before the Scan List appears. You can use either an Ethernet or wireless adaptor.
If prompted, select an adapter and click OK. You can change your adapter setting at any time by clicking the
Select Adapter button on the Scan List screen.

ScanTool scans the subnet and displays all detected Access Points. The ScanTool's Scan List screen appears, as
shown in the following example.

MmN -0l x|
MAL Ackdwzs | Syster Mirne T | Uiptise: | Zystem Darcrgiion Anmcan
AP 324128132 0d3RSn0 AP w2 3.0 SHAAUT ABSTIS:
_Owge |
Sebect Adapier
Eboed Cencel

Figure 2-5 Scan List

3. Locate the MAC address of the AP you want to initialize within the Scan List.
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NOTE: If your Access Point does not appear in the Scan List, click the Rescan button to update the display. If the unit
still does not appear in the list, see Troubleshooting for suggestions. Note that after rebooting an Access
Point, it may take up to five minutes for the unit to appear in the Scan List.
4. Do one of the following:
» If the AP has been assigned an IP address by a DHCP server on the network:
a. Highlight the entry for the AP you want to configure.
b. Click the Change button. The Change screen appears.
c. Click on the Web Configuration button at the bottom of the change screen.
d. Proceed to the Logging In section for information on how to access the HTTP interface using this IP address.

» If the AP has not been assigned an IP address (in other words, the unit is using its default IP address,
169.254.128.132), follow these steps to assign it a static IP address that is valid on your network:

a. Highlight the entry for the AP you want to configure.
b. Click the Change button. The Change screen appears.

chamge x|
WAL Aujdesss |
Hare | }
IF Addiest Type F Bratid " Dynamc
IF Ak |-n:|n:|3:|
Subnet Matk. 252550
Galeway [P Addwss  [1B9.254120133

TR Serent IP Address ||

Image Fie Mame [

Readwiln Pagswond |

et Comtiguaation| ok | cewe |

Figure 2-6 Scan Tool Change Screen

c. SetIP Address Type to Static.

d. Enter a static IP Address for the AP in the field provided. You must assign the unit a unique address that is
valid on your IP subnet. Contact your network administrator if you need assistance selecting an IP address for
the unit.

e. Enter your network’s Subnet Mask.

f. Enter your network’s Gateway IP Address.

g. Enter the SNMP Read/Write password in the Read/Write Password field (for new units, the default SNMP
Read/Write password is public).

NOTE: The TFTP Server IP Address and Image File Name fields are only available if ScanTool detects that
the AP does not have a valid software image installed. See Client Connection Problems.
h. Click OK to save your changes.

i. The Access Point will need to reboot to apply any changes you made. When the reboot message appears,
click OK to reboot the device and return to the Scan List screen.

j.  After allowing sufficient time for the device to reboot, click Rescan to verify that your changes have been
applied.
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k. Click the Change button to return to the Change screen.
I.  Click the Web Configuration button at the bottom of the Change screen.
m. Proceed to the Logging In section for information on how to access the HTTP interface using this IP address.

Logging In

Once the AP has a valid IP Address and an Ethernet connection, you may use your web browser to monitor and
configure the AP. (To configure and monitor using the command line interface, see Command Line Interface (CLI).)

1. Open a Web browser on a network computer.
2. If necessary, disable the browser’s Internet proxy settings. For Internet Explorer users, follow these steps:

Select Tools > Internet Options.

Click the Connections tab.

Click LAN Settings.

If necessary, remove the check mark from the Use a proxy server box.
Click OK twice to save your changes and return to Internet Explorer.

3. Enter the Access Point’s IP address in the browser’s Address field and press Enter or Go.

This is either the dynamic IP address assigned by a network DHCP server or the static IP address you manually
configured. See Using ScanTool for information on how to determine the unit’s IP address and manually configure a
new IP address, if necessary.

The Enter Network Password screen appears.

e

?‘) Pleate lype pour uer name and password

Site: 169.254/50.2
Realm Access-Product
Uset Mame |

Password | ..... 1

™ Save thir passwcrd in pour pacsword st

(o] oo |

Figure 2-7 Enter Network Password

4. Enter the HTTP password in the Password field. Leave the User Name field blank. For new units, the default HTTP
password is public.

If you are logging on for the first time the Setup Wizard will launch automatically.

NOTE: Setup Wizard will not relaunch on subsequent logins. To force the Setup Wizard to launch upon login, click

Management > Services and choose Enable from the Setup Wizard drop down menu.

5. To configure the AP using the Setup Wizard, see Using the Setup Wizard; to configure the AP without using the Setup
Wizard, click Exit. Upon clicking Exit, the System Status screen will appear.
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Initialization
tal SN-04UT45570522
System Status
y v3.1.0
Soniduie IF Address Contact Name
System Name Contact Phone
HMonit System Location yE Loc Contact Email
L Up Time (DD:HH:MW:SS)  02:00:40:21 ObjectiD
Commands System Alarms
This table displays information on the alarms (SNMP Traps) generated by the access point. They should be
Help deleted once they are reviewed and resolved. The alarm severity levels are: Critical, Major, Minor, and
Informational.
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Figure 2-8 System Status Screen

The buttons on the left of the screen provide access to the monitoring and configuration options for the AP. See
Advanced Configuration to begin configuring the AP manually.

You can also exit the Web interface or reboot the AP using these buttons.

The Command Line Interface (CLI) also provides a method for monitoring and configuring the AP using Telnet or a
serial connection. For more information about monitoring and configuring the AP with the CLI, see Command Line

Interface (CLI).

Using the Setup Wizard

The first time you connect to an AP’s HTTP interface, the Setup Wizard launches automatically. The Setup Wizard
provides step-by-step instructions for how to configure the Access Point’s basic operating parameters, such as Network
Name, IP parameters, system parameters, and management passwords.

Step 1:
Introduction

Step X
System
Configuration

Step X:
[
Configuration

Step 4:
Passerord
Configuration

Step 5
Wireless
Interfaces
Configuration

Step 6
Summarny

Wekcome 1o the Access Point Setup Wisand. The setup wizard provides & sel of pages for
configuring basic soess poind parameters, which are isted belos.

Systeem is used to configure device nformation such as Sysiem name and contact informason
iguration i uked b configure the miarned (TCPAP) s&ing for the Siceas poind,

PaR 118 wEed b confegure the SAMP, Talnest RE LI}, & HT TE (el detaul]l passwords.
Wireless Interfaces (& used to configure the characteristics of the wirelegs medium

Cllick the Setup Wizand button and the wizand will kead you through & step-by-step guide 1o
configuring your sccees poant. Far more advanced configurstion optons, click the axit button below
& At tha Confegisaation section of this wob interlacs

Oince you have completed the setup wizard, you must reboot the scoess point in order for the
changes to take effect.

H you siart the Setup Wizard but do not complete i, sny changes that you ssved up to the poant that
you exiled e wizard will be asved by ihe Access Poant and applied the next lime tha uwnil reboals,

Satup iz ad g Exid |

Figure 2-9 Setup Wizard

Setup Wizard Instructions
1. Click Setup Wizard to begin. The Setup Wizard supports the following navigation options:
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Save & Next Button: Each Setup Wizard screen has a Save & Next button. Click this button to submit any
changes you made to the unit’'s parameters and continue to the next page. The instructions below describe how to
navigate the Setup Wizard using the Save & Next buttons.

Navigation Panel: The Setup Wizard provides a navigation panel on the left-hand side of the screen. Click the
link that corresponds to the parameters you want to configure to be taken to that particular configuration screen.
Note that clicking a link in the navigation panel will not submit any changes you made to the unit’s configuration on
the current page.

Exit: To exit from the Setup Wizard at any time, click Step 1: Introduction on the navigation panel, and then click
the Exit button.

CAUTION: If you exit from the Setup Wizard, any changes you submitted (by clicking the Save & Next button) up
to that point will be saved to the unit but will not take effect until it is rebooted.

2. Configure the System Configuration settings and click Save & Next. See System for more information.

NOTE: On APs with model numbers ending in -WD, you must select the operating country on this page or on the

Configure > System tab. Setting the country makes the AP automatically compliant with the rules of the
regulatory domain in which it is used by configuring the allowed frequency bands, channels, Dynamic
Frequency Selection status, Transmit Power Control status, and power levels. If the country is not selected,
an informational message will appear on the Status page, and you will be unable to configure interface
parameters.

3. Configure the Access Point’s IP Configuration, including basic IP address settings, if necessary, and click Save &
Next. See Basic IP Parameters for more information.

4. On the Password Configuration screen, assign the AP new passwords to prevent unauthorized access and click
Save & Next. Each management interface has its own password:

SNMP Read Password
SNMP Read-Write Password
CLI Password

HTTP (Web) Password

By default, each of these passwords is set to “public’. See Passwords for more information.
5. Configure the basic Wireless Interface Configuration settings:

Select the Operational Mode as follows and click Save & Next:

The Wireless-A interface operates in 802.11a mode .

The Wireless-B interface can be configured to operate in the following modes:
+ 802.11b only mode: The radio uses the 802.11b standard only.

+ 802.11g only mode: The radio is optimized to communicate with 802.11g devices. This setting will provide the
best results if this radio interface will only communicate with 802.11g devices.

+ 802.11b/g mode: This is the default mode. Use this mode if you want to support a mix of 802.11b and 802.11g
devices.

+ 802.11g-wifi mode: The 802.11g-wifi mode has been defined for Wi-Fi testing purposes. It is not
recommended for use in your wireless network environment.

In general, you should use either 802.11g only mode (if you want to support 802.11g devices only) or 802.11b/g
mode to support a mix of 802.11b and 802.11g devices.

Configure the following available options and click Save & Next:

— Primary Network Name (SSID): Enter a Network Name (between 1 and 32 characters long) for the wireless
network. You must configure each wireless client to use this name as well. Note that the unit supports up to 16
SSIDs/VLANSs per wireless interface. Please see the Advanced Configuration chapter for information on the
detailed rules on configuring multiple SSIDs, VLANSs, and security profiles.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to
misinterpret the name.
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7.

— Auto Channel Select: By default, the AP scans the area for other Access Points and selects the best
available communication channel, either a free channel (if available) or the channel with the least amount of
interference. Remove the check mark to disable this option. See Dynamic Frequency Selection/Radar
Detection (DFS/RD) for information and Available Channels for a list of available channels.

NOTE: When an AP is configured to function as a Mesh AR, its channel will depend on the channel of its
Portal.

— Frequency Channel: When Auto Channel Select is enabled, this field is read-only and displays the Access
Point’s current operating channel. When Auto Channel Select is disabled, you can specify the Access Point’s
channel. If you decide to manually set the unit's channel, ensure that nearby devices do not use the same
frequency. Available Channels vary based on regulatory domain. See Dynamic Frequency Selection/Radar
Detection (DFS/RD) for information and Available Channels for a list of available channels.

NOTE: When an AP is configured to function as a Mesh AR, its channel will depend on the channel of its
Portal.

— Transmit Rate: Use the drop-down menu to select a specific transmit rate for the AP. The values depend on
the Operational mode. Auto Fallback is the default setting; it allows the AP unit to select the best transmit rate
based on the cell size.

+ For 802.11a only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/s.
» For 802.11b only -- Auto Fallback, 1, 2, 5.5, 11 Mbits/sec.
» For 802.11g only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/sec
+ For 802.11b/g -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec
» For 802.11g-wifi -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec
NOTE: 802.11g-wifi has been defined for Wi-Fi testing purposes. It is not recommended for use in your
wireless network environment.
Additional advanced settings are available on the Interfaces tab.

Also see Security Profile for a description of security features, Management VLAN for a description of VLAN
capabilities, and Configuring Security Profiles for detailed security configuration procedures.

Review the configuration Summary. If you want to make any additional changes, use the navigation panel on the
left-hand side of the screen to return to an earlier screen. After making a change, click Save & Next to save the
change and proceed to the next screen.

When finished, click Reboot on the Summary screen to restart the AP and apply your changes.

Installing the Software

Proxim periodically releases updated software for the AP on its Web site, http://support.proxim.com. Check the Web site
for the latest updates after you have installed and initialized the unit.

CAUTION: Downgrading a unit shipped with version 3.6 software could cause unstable hardware and is not

recommended.

Download the Software

1.
2.

In your web browser, go to http://support.proxim.com.

If prompted, create an account to gain access.

NOTE: The Knowledgebase is available to all website visitors. First-time users will be asked to create an account to
gain access.

Click Search Knowledgebase.

In the Search Knowledgebase field, enter 2334.

Click Search.
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6. Click on the appropriate link to access the download page.
7. Use the instructions in the following sections to install the new software.

Install Software with HTTP Interface
Use the Update AP via HTTP tab to update the AP with the latest software image.
1. Click Commands > Update AP > via HTTP.

Uptate AP \ RetieveFile | Reboat | Reset | HepLink  \
via TFTP  viaHTTP \

This page is vsed to update soffware images, license file and configuration files in
the Access Point uging HTTR file tranafer. Click on the browse bution to seanch for
the file or entér the path in the text box. Select the file type and click the Update AP
bution to start the file transfer,

Hoate: On updating configuration fie the Acceas Poant will reboot by staell,

System Information

Sofware Version KX

Bool Leadar Version X KX

File Type Irma ge vI

File Name  [AP.sei Browse..
Update AP | Cancel |

Figure 2-10 Update AP via HTTP Command Screen

2. From the File Type drop-down menu, select Image.

3. Use the Browse button to locate or manually type in the name of the file (including the file extension) you downloaded
from the Proxim Knowledgebase. If typing the file name, you must include the full path and the file extension in the file
name text box.

4. To initiate the HTTP Update operation, click the Update AP button.
A warning message advises you that a reboot of the device will be required for changes to take effect.

%

? ) Youare updatng Image fle ta the AP, You wil resd i reboat the devte for changas 1o take effect. Do you want o procesd 7

e

Figure 2-11 Warning Message

5. Click OK to continue with the operation or Cancel to abort the operation.

6. If the operation is unsuccessful, you will receive an error message. If this occurs, see the Troubleshooting chapter or
attempt installing the software with a TFTP server, as described in the next section.

If the operation is successful, you will receive a confirmation message.
7. Reboot the AP as follows:

* Click Commands > Reboot.

* Enter 0 in the Time to Reboot field.

* Click OK.
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Install Software with TFTP Server

A Trivial File Transfer Protocol (TFTP) server allows you to transfer files across a network. You can upload files from the
AP for backup or copying, and you can download the files for configuration and AP Image upgrades. The Solarwinds
TFTP server software is located on the AP Installation CD-ROM. You can also download the latest TFTP software from
Solarwind’s Web site at http://www.solarwinds.net. The instructions that follow assume that you are using the Solarwinds
TFTP server software; other TFTP servers may require different configurations.

NOTE: If a TFTP server is not available in the network, you can perform similar file transfer operations using the HTTP
interface.See Update AP via HTTP.

After the TFTP server is installed:

» Check to see that TFTP is configured to point to the directory containing the AP Image.

» Make sure you have the proper TFTP server IP address, the proper AP Image file name, and that the TFTP server is
operational.

* Make sure the TFTP server is configured to both Transmit and Receive files (on the TFTP server’s Security tab), with
no automatic shutdown or time-out (on the Auto Close tab).
The following types of files can be downloaded to the AP from a TFTP server:

» Config (configuration file)

* Image (AP software image or kernel)

» UpgradeBspBIl (BSP/Bootloader firmware file)
* License File

+ SSL Certificate

* SSL Private Key

* SSH Public Key

* SSH Private Key

+ CLI Batch File

Install Updates from your TFTP Server using the Web Interface

1. Download the latest software from http://support.proxim.com. See Download the Software for instructions.
2. Copy the latest software updates to your TFTP server.

In the Web Interface, click the Commands button and select the Download tab.

Enter the IP address of your TFTP server in the field provided.

Enter the File Name (including the file extension). If the file is located in the default TFTP directory, you need enter
only the file name. Otherwise, enter the full directory path and file name.

6. Select the File Type from the drop-down menu (use Img for software updates).
7. Select Download & Reboot from the File Operation drop-down menu.
8. Click OK. The Access Point will reboot automatically when the download is complete.

o w

Install Updates from your TFTP Server using the CLI

1. Download the latest software to http://support.proxim.com. See Download the Software for instructions.
2. Copy the latest software updates to your TFTP server.

Open the CLlI interface via Telnet or a serial connection.

Enter the CLI password when prompted.

Enter the command: download <tftpaddr> <filename> img

The download will begin, and the image will be downloaded to the Access Point.

6. When the download is complete, type reboot 0 and press Enter.

U
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System Status

The first screen displayed after Logging In is the System Status screen. You can always return to this screen by clicking
the Status button.

SN-04UT45570522
System Status
y v3.1.0
Soniduie IF Address Contact Name
System Name Contact Phone
HMonit System Location tion Contact Email
L Up Time (DD:HH:MW:SS)  02:00:40:21 ObjectiD
Commands System Alarms
This table displays information on the alarms (SNMP Traps) generated by the access point. They should be
Help deleted once they are reviewed and resolved. The alarm severity levels are: Critical, Major, Minor, and
Informational.
Exit
SelectAl g Deselect All 3
Reboot
Description Severity Time Stamp
r Link Up. Informational OdaysOhrs0Om24s
Delete 3

Figure 3-1 System Status Screen

The System Status screen provides the following information:

» System Status: This area provides system-level information, including the unit’s IP address and contact information.
See System for information on these settings.

+ System Alarms: System traps (if any) appear in this area. Each trap identifies a specific severity level: critical, major,
minor, and informational. See Alarms for a list of possible alarms.

NOTE: On APs with model numbers ending in -WD, an operating Country must be selected (during the Setup Wizard
or on the Configure > System tab). If a country has not been selected, an informational message will appear
in the System Alarms list, and you will be unable to configure interface parameters.

From this screen, you can also access the AP’s monitoring and configuration options by clicking on the buttons on the
left of the screen.
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Advanced Configuration

This chapter contains information on configuring settings in the following categories:

System: Configure specific system information such as system name and contact information.

Network: Configure IP, DNS client, DHCP server, DHCP Relay Agent, DHCP Relay Servers, Link Integrity, and SNTP
settings.

Interfaces: Configure the Access Point’s interfaces: Wireless A, Wireless B, Ethernet, and Mesh. Configure the and
a Wireless Distribution System (WDS).

Management: Configure the Access Point’'s management Passwords, IP Access Table, and Services such as
configuring secure or restricted access to the AP via SNMPv3, HTTPS, or CLI. Configure Secure Management, SSL,
Secure Shell (SSH), and RADIUS Based Access Management. Set up Automatic Configuration for Static IP.

Filtering: Configure Ethernet Protocol filters, Static MAC Address filters, Advanced filters, and Port filters.

Alarms: Configure the Alarm (SNMP Trap) Groups, the Alarm Host Table, and the Syslog features.

Bridge: Configure the Spanning Tree Protocol, Storm Threshold protection, Intra BSS traffic, and Packet Forwarding.
QoS: Configure Wireless Multimedia Enhancements/Quality of Service parameters and QoS policies.

Radius Profiles: Configure RADIUS features such as RADIUS Access Control and Accounting.

PXU (ProximUnify) Profile and VLAN Roaming: Configure ProximUnify features to enable VLAN support.

SSID/VLAN/Security: Configure SSIDs, VLANSs, and security profiles for each interface. Configure security features
such as MAC Access Control, WPA, 802.11i (WPA2), WEP Encryption, and 802.1x.

To configure the AP using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for
instructions.

You may also configure the AP using the command line interface. See Command Line Interface (CLI) for more
information.

To configure the AP via HTTP/HTTPS:

1. Click the Configure button located on the left-hand side of the screen.
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System Network nterfaces Management Filtering

Alarms Bridge ! QoS RADIUS Profiles. SSDM_ANIBM:JM‘
I

AW

Configure

There are ten main categories of config
network properties and configuration.

ion for the access point, which may be changed to suit your

System is used to configure specific system information such as system name and contact information.
Hetwork is used to configure IP settings, DNS client, DHCP server, DHCP relay agent, and Link Integrity.
Interfaces is used to configure the access point operational modes and interfaces: Wireless and Ethernet,

Management is used to configure the access point management Passwords, IP Access Table, Services
and Auto Configuration, and Configurable Hardware Reset to Defaults feature.

Filtering is used to configure Ethernet Protocol filters, Static MAC Address filters, Advanced filters, and
Port filters.

Alarms is used to enable and disable Alarm (SNMP Trap) Groups, configure the Alarm Host Table, the
Syslog, and the Rogue Scan feature.

Bridge is used to configure the Spanning Tree Protocol, Storm Threshold protection, intra BSS traffic, and
Packet Forwarding.

008 is used to configure the Quality of Service (QoS5) feature. This tab can be used to configure QoS
Policies, Priority Mapping and EDCA values.

RADIUS Profiles is used to configure RADIUS Profiles for servers used for MAC based RADIUS
Authentication, EAPIE02.1x; and Accounting

SSIDVL AN Security is used to configure multiple SSID's for each wireless interface(s), VLAN properties,
MAC Access Control, and Security Profiles.

Figure 4-1 Configure Main Screen

2. Click the tab that corresponds to the parameter you want to configure. For example, click Network to configure the

Access Point’'s TCP/IP settings.

Each Configure tab is described in the remainder of this chapter.
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System

You can configure and view the following parameters within the System Configuration screen:

Name: The name assigned to the AP. See the Dynamic DNS Support and Access Point System Naming Convention
sections for rules on naming the AP.

Country: The country in which the AP will be used. Note that some countries have two selectable options (one for
indoor use and one for outdoor use). Setting the country makes the AP automatically compliant with the rules of the
regulatory domain in which it is used by configuring the allowed frequency bands, channels, Dynamic Frequency
Selection status, Transmit Power Control status, and power levels. See Interfaces for more information about these
settings.

NOTE: You must reboot the AP in order for country selection to take effect.

NOTE: Country selection is available only on APs with model numbers ending in -WD. If country selection is available,
however, it must be set before any interface parameters can be configured.
Location: The location where the AP is installed.

GPS Longitude: The longitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

GPS Latitude: The latitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

GPS Altitude: The altitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

Contact Name: The name of the person responsible for the AP.
Contact Email: The email address of the person responsible for the AP.
Contact Phone: The telephone number of the person responsible for the AP.

Object ID: This is a read-only field that displays the Access Point’s system object identification number; this
information is useful if you are managing the AP using SNMP.

Ethernet MAC Address: This is a read-only field that displays the unique MAC (Media Access Control) address for
the Access Point’s Ethernet interface. The MAC address is assigned at the factory.

Descriptor: This is a read-only field that reports the Access Point’'s name, serial number, current image software
version, and current bootloader software version.

Up Time: This is a read-only field that displays how long the Access Point has been running since its last reboot.

46



Advanced Configuration AP-4000MR User Guide
System
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\ Metwork \ Interfaces \ Management \ Filtering \

Slatus
This tab allows for configuration of system unique parameters and contact information.
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Note: Name can only conlain alphanumeric characters. Hyphen is the only special character allowed No
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T
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Exit -121.8853
[37.3321
. [10
Reboot

Contact Name
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Contact Fhona Numbar
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Up Time (DD:HH:MI:SS

OK___J Cancel

Figure 4-2 System Tab

Dynamic DNS Support

DNS is a distributed database mapping the user readable names and IP addresses (and more) of every registered
system on the Internet. Dynamic DNS is a lightweight mechanism which allows for modification of the DNS data of host
systems whose |IP addresses change dynamically. Dynamic DNS is usually used in conjunction with DHCP for mapping
meaningful names to host systems whose IP addresses change dynamically.

Access Points provide DDNS support by adding the host name (option 12) in DHCP Client messages, which is used by
the DHCP server to dynamically update the DNS server.

Access Point System Naming Convention

The Access Point's system name is used as its host name. In order to prevent Access Points with default configurations
from registering similar host names in DNS, the default system name of the Access Point is uniquely generated. Access
Points generate unique system names by appending the last 3 bytes of the Access Point's MAC address to the default
system name.

The system name must be compliant with the encoding rules for host name as per DNS RFC 1123. According to the
encoding rules, the AP name:

* Can contain alphanumeric or hyphen characters only.

» Can contain up to 31 characters.

« Cannot start or end with a hyphen.

» Cannot start with a digit.
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The Network tab contains the following sub-tabs:

» |P Configuration

+ DHCP Server

+ DHCP Relay Agent

» Link Integrity

*  SNTP (Simple Network Time Protocol)

IP Configuration
This tab is used to configure the internet (TCP/IP) settings for the access point.

These settings can be either entered manually (static IP address, subnet mask, and gateway IP address) or obtained
automatically (dynamic).The DNS Client functionality can also be configured, so that host names used for configuring the
access point can be resolved to their IP addresses.

Alamms 1 Bridge l||_ QoS ‘\ IQ"|:|;.|:I‘F"~.; \l SSIONVLANSecurily
System et jl‘ Interfaces '{ MWanagement -\I\ Fillering A

Slatus = -
N\ DHCPSever | DHCPRA | Linkintsgry § SNTP |

This tab is used to configure the internet (TCPIP) settings for the access point, These
settings can be either entered manually | static IP address, subnet mask, and gateway IP
address) or obtained automatically (dynamic).The DNS Client functionality can also be

Mognitar configured, so that host names uséd for configuring the access point can be résolved to
their IP sddresses. IP address type will remain static if dhep server is enabled.

Commands Note: Changes (o e Daramelers rogquire acces point reboot in order to take effect
Help

Exit

Rebooat

Figure 4-3 IP Configuration

You can configure and view the following parameters within the IP Configuration sub-tab:

NOTE: You must reboot the AP in order for any changes to the Basic IP or DNS Client parameters to take effect.

Basic IP Parameters

* IP Address Assignment Type: Set this parameter to Dynamic to configure the Access Point as a Dynamic Host
Configuration Protocol (DHCP) client; the Access Point will obtain IP settings from a network DHCP server
automatically during boot-up. If you do not have a DHCP server or if you want to manually configure the Access
Point’s IP settings, set this parameter to Static.
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» |IP Address: The Access Point’s IP address. When IP Address Assignment Type is set to Dynamic, this field is
read-only and reports the unit’s current IP address. The Access Point will default to 169.254.128.132 if it cannot obtain
an address from a DHCP server. Though the Access Point starts functioning with the default IP address, it will
continue to renew as a DHCP address and will get one if DHCP server is available.

* Subnet Mask: The Access Point’s subnet mask. When IP Address Assignment Type is set to Dynamic, this field is
read-only and reports the unit’'s current subnet mask. The subnet mask will default to 255.255.0.0 if the unit cannot
obtain one from a DHCP server.

» Gateway IP Address: The IP address of the Access Point’s gateway. When IP Address Assignment Type is set to
Dynamic, this field is read-only and reports the IP address of the unit's gateway. The gateway IP address will default
to 169.254.128.133 if the unit cannot obtain an address from a DHCP server.

DNS Client

If you prefer to use host names to identify network servers rather than IP addresses, you can configure the AP to act as a
Domain Name Service (DNS) client. When this feature is enabled, the Access Point contacts the network’s DNS server to
translate a host name to the appropriate network IP address. You can use this DNS Client functionality to identify
RADIUS servers by host name.

» Enable DNS Client: Place a check mark in the box provided to enable DNS client functionality. Note that this option
must be enabled before you can configure the other DNS Client parameters.

* DNS Primary Server IP Address: The IP address of the network’s primary DNS server.
* DNS Secondary Server IP Address: The IP address of a second DNS server on the network. The Access Point will
attempt to contact the secondary server if the primary server is unavailable.

* DNS Client Default Domain Name: The default domain name for the Access Point’s network (for example,
“proxim.com”). Contact your network administrator if you need assistance setting this parameter.

Advanced
* Default TTL (Time to Live): Time to Live (TTL) is a field in an IP packet that specifies the number of hops, or routers
in different locations, that the request can travel before returning a failed attempt message. The Access Point uses the
default TTL for generated packets for which the transport layer protocol does not specify a TTL value. This parameter
supports a range from 0 to 255. By default, TTL is 64.

DHCP Server

If your network does not have a DHCP Server, you can configure the AP as a DHCP server to assign dynamic IP
addresses to Ethernet nodes and wireless clients.

CAUTION: Make sure there are no other DHCP servers on the network and do not enable the DHCP server without
checking with your network administrator first, as it could disrupt normal network operation. Also, the AP
must be configured with a static IP address before enabling this feature.

When the DHCP Server functionality is enabled, you can create one or more IP address pools from which to assign
addresses to network devices.
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Figure 4-4 DHCP Server Configuration Screen

You can configure and view the following parameters within the DHCP Server Configuration screen:

NOTE: You must reboot the AP before changes to any of these DHCP server parameters take effect.

Enable DHCP Server: Place a check mark in the box provided to enable DHCP Server functionality.

NOTE: You cannot enable the DHCP Server functionality unless there is at least one IP Pool Table Entry configured.
Subnet Mask: This field is read-only and reports the Access Point’s current subnet mask. DHCP clients that receive
dynamic addresses from the AP will be assigned this same subnet mask.

Gateway IP Address: The AP will assign the specified address to its DHCP clients.

Primary DNS IP Address: The AP will assign the specified address to its DHCP clients.

Secondary DNS IP Address: The AP will assign the specified address to its DHCP clients.

Number of IP Pool Table Entries: This is a read-only field that reports the number of entries in the IP Pool Table.
IP Pool Table Entry: This entry specifies a range of IP addresses that the AP can assign to its wireless clients. Click
Add to create a new entry. Click Edit to change an existing entry. Each entry contains the following fields:

— Start IP Address: The first IP address in the pool. IP addresses must be within the same subnet as the AP.

— End IP Address: The last IP address in the pool. IP addresses must be within the same subnet as the AP.

— Default Lease Time (optional): The default time value for clients to retain the assigned IP address. DHCP
automatically renews IP Addresses without client notification. This parameter supports a range between 3600 and
86400 seconds. The default is 86400 seconds. If this field is left blank, the default (86400) is used.

— Maximum Lease Time (optional): The maximum time value for clients to retain the assigned IP address. DHCP
automatically renews IP Addresses without client notification. This parameter supports a range between 3600 and
86400 seconds. The default is 86400 seconds. If this field is left blank, the default (86400) is used.

NOTE: The Default Lease Time cannot be larger than the Maximum Lease Time. If you set the Maximum Lease
Time, you should also set the Default Lease Time to ensure that the Default Lease Time is less than the
Maximum.

— Comment (optional)
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— Status: IP Pools are enabled upon entry in the table. You can also disable or delete entries by changing this
field’s value.

NOTE: You must reboot the AP before changes to any of these DHCP server parameters take effect.

DHCP Relay Agent

When enabled, the DHCP relay agent forwards DHCP requests to the set DHCP server.

Click the Configure > Network > DHCP R A to configure DHCP relay agent servers and enable the DHCP relay agent.
NOTE: At least one DHCP server must be enabled before DHCP Relay Agent can be enabled.

NOTE: If the DHCP relay agent is unable to reach the external DHCP Server specified in the DHCP Server IP Address
Table, the requesting client will receive an IP address from the IP Pool table of the AP’s internal DHCP Server,
even if the internal DHCP Server is disabled.

NOTE: If a client requests an available IP address from the IP Pool table of the AP’s internal DHPC Server, the client will
receive this address, even if the DHCP server on the AP is disabled. To ensure that clients receive IP addresses
only from the DHCP Relay Agent, disable all entries in the IP Pool table of the AP’s internal DHCP server.

The DHCP Relay functionality of the AP supports Option 82 and sends the system name of the AP (as a NAS identifier)
as a sub-option of Option 82.

The AP makes a DHCP Request for lease renewal five minutes ahead of the expiration of the Rebinding time as
specified in the DHCP Offer from the DHCP server obtained during the last renewal.

Stalus

Relsy Agent in the scoets point allows for dynamic P addré s 58 Signiment 1o
wireless clients from a DHCP Server in a different subnet

Momilog Note: The DHCP Relay Agent can only be enabled
[ 1 v K 1 raf in addition fo this, T T . )
i Ty for the el i Hic. Ghanges to hese
Commands paramelers require access point rebool in arger (o lake effect.

Retool DHCP Server IP Address Table

DHCP Server IP Address Comment Status

Figure 4-5 DHCP Relay Agent

DHCP Server IP Address Table

The AP supports the configuration of a maximum of 10 server settings in the DHCP Relay Agents server table. At least
one server must be configured to enable DHCP Relay.

To add entries to the table of DHCP Relay Agents, click Add in the DHCP Server IP Address Table; to edit existing
entries, click Edit. The following window is displayed.
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Figure 4-6 DHCP Server IP Address Table - Edit Entries

To add an entry, enter the IP Address of the DHCP Server and a comment (optional), and click OK.

To edit an entry, make changes to the appropriate entry. Enable or disable the entry by choosing Enable or Disable from
the Status drop-down menu, and click OK.

Link Integrity

The Link Integrity feature checks the link between the AP and any nodes on the backbone. These nodes are listed by IP
address in the Link Integrity IP Address Table. The AP periodically pings the nodes listed within the table. If the AP loses
network connectivity (that is, the ping attempts fail), the AP disables its wireless interface(s). Note that this feature does
not affect WDS links (if WDS links are configured and enabled).

NOTE: Link integrity cannot be configured when the AP is configured to function as a Mesh AP.
You can configure and view the following parameters within the Link Integrity Configuration screen:

* Enable Link Integrity: Place a check mark in the box provided to enable Link Integrity.

* Poll Interval (milliseconds): The interval between link integrity checks. Range is 500-15000 ms in increments of
500 ms; default is 500 ms.

* Poll Retransmissions: The number of times a poll should be retransmitted before the link is considered down.
Range is 0 to 255; default is 5.

» Target IP Address Entry: This entry specifies the IP address of a host on the network that the AP will periodically poll
to confirm connectivity. The table can hold up to five entries. By default, all five entries are set to 0.0.0.0. Click Edit to
update one or more entries. Each entry contains the following field:

— Target IP Address

— Comment (optional)

— Status: Set this field to Enable to specify that the Access Point should poll this device. You can also disable an
entry by changing this field’s value to Disable.
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Figure 4-7 Link Integrity Configuration Screen

SNTP (Simple Network Time Protocol)

SNTP allows a network entity to communicate with time servers in the network/internet to retrieve and synchronize time

of day information. When this feature is enabled, the AP will attempt to retrieve the time of day information from the
configured time servers (primary or secondary), and, if successful, will update the relevant time objects in the AP.

Requests are sent every 10 seconds. If the AP fails to retrieve the information after three attempts, the AP will use the
system uptime and update the relevant time objects. If this feature is disabled, the user can manually configure the date
and time parameters.
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Figure 4-8 SNTP Configuration Screen

You can configure and view the following parameters within the SNTP screen:

*  SNTP Status: Select Enable or Disable from the drop-down menu. The selected status will determine which of the
parameters on the SNTP screen are configurable.

NOTE: When SNTP is enabled, it will take some time for the AP to retrieve the time of day from the configured time
servers and update the relevant date and time parameters.

* Addressing Format: If SNTP is enabled, choose whether you will use the host name or the IP address to configure
the primary/secondary SNTP servers. If these servers are configured with the host name, the DNS client feature must
be enabled and configured properly.

* Primary Server Name or IP Address: If SNTP is enabled, enter the host name or IP address of the primary SNTP
server.

» Secondary Server Name or IP Address: If SNTP is enabled, enter the host name or IP address of the secondary
SNTP server.

» Time Zone: Select the appropriate time zone from the drop down menu.
» Daylight Savings Time: Select the number of hours to adjust for daylight savings time.

» Time and Date Information: When SNTP is disabled, the following time-relevant objects are manually configurable.
When SNTP is enabled, these objects are grayed out:

— Year: Enter the current year.

— Month: Enter the month in digits (1-12).

— Day: Enter the day in digits (1-31).

— Hour: Enter the hour in digits (0-23).

— Minutes: Enter the minutes in digits (0-59).
— Seconds: Enter the seconds in digits (0-59).
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Interfaces

From the Interfaces tab, you configure the Access Point’s operational mode settings, power control settings, wireless
interface settings and Ethernet settings. You may also configure a Wireless Distribution System for AP-to-AP
communications. The Interfaces tab contains the following sub-tabs:

* Operational Mode

*  Wireless-A (802.11a) and Wireless-B (802.11b/g Radio)

» Ethernet

* Mesh

NOTE: On APs with model numbers ending in -WD, the operating country must be selected on the System tab before
any of these sub-tabs are available.

Operational Mode

From this tab, you can configure and view the operational mode for the Wireless-A (802.11a radio) or Wireless-B
(802.11b/g radio) interface.

2 RADIUSFXU i P
Alams " Bridge '\ QoS 1 e 1 SSIDVLANSecurity
Profiles
System Metwork terface \ Management \ Filtering ]
Status EE— . : . .
1 Wireless - A \ Wireless -B \ Ethemet \ Mesh \
The operational mode of the wireless interface determines the mode of communication
between wireless clients and the access point
Manitor Note: Changes to these parameters require access point reboot in order to take effect.
Commands
Hal Note: Transmit Power Control back off is between 0-35 for products without amplifier and
] between 0 -8 for products with amplifier
Exit
Wireless - A
Operational Mode | 802.118 oaly =]
Reboot Channel B dth [ -
Enable Super Mode I
Enable Turbo Mode F

Wireless -B

Cperational Mode [802.110g =]
Enable Super Mode r
Enable Turbo Mode E

r
Enable TX Power Control C
Wireless - A Transmil Power Level Back-off
Wireless - B: Tranamil Power Lewve| Back-off
I Cancel 3

Figure 4-9 Operational Mode Screen

The Wireless-A interface operates in 802.11a mode.
The Wireless-B interface can be configured to operate in the following modes:
* 802.11b only mode: The radio uses the 802.11b standard only.
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+ 802.11g only mode: The radio is optimized to communicate with 802.11g devices. This setting will provide the best
results if this radio interface will only communicate with 802.11g devices.

» 802.11b/g mode: This is the default mode. Use this mode if you want to support a mix of 802.11b and 802.11g
devices.

+ 802.11g-wifi mode: The 802.11g-wifi mode has been defined for Wi-Fi testing purposes. It is not recommended for
use in your wireless network environment.

In general, you should use either 802.11g only mode (if you want to support 802.11g devices only) or 802.11b/g mode to
support a mix of 802.11b and 802.11g devices.

Enable H Band Support

In compliance with FCC regulations, Dynamic Frequency Selection is required in the middle frequency band (M band:
5.26 GHz - 5.32 Ghz) and high frequency band (H band: 5.470 GHz - 5.725 GHz). DFS is enabled automatically when
you use one or both of these frequency bands.

If the AP’s Wireless Card A is variant 2, 3, or 6, the M band channels are enabled by default, and DFS is performed
automatically and cannot be disabled. To add H band channels to the list of available channels, select Enable H Band
Support on the Op Mode page. When the H band is enabled, DFS is enabled automatically, and is performed on both M
and H band channels.

If the AP’s Wireless Card A is variant 8, 10, or 11, both M and H band channels are enabled automatically. DFS is
performed on both M and H band channels and cannot be disabled.

To identify your AP’s software variant, click Monitor > Version to view the Version tab.
For a full discussion of Dynamic Frequency Selection, see Dynamic Frequency Selection/Radar Detection (DFS/RD).

NOTE: You can avail this option by upgrading your pre 3.6 version device to 3.7 version.

Super Mode and Turbo Mode

Super mode improves throughput between the access point and wireless clients that support this capability. For wireless
clients that support this capability the AP will negotiate and treat them accordingly, for other clients that do not support
super mode, the AP will treat them as normal wireless clients.

Super mode can be configured only when the wireless operational mode is one of the following:

+ 802.11a only mode
* 802.11g only mode
* 802.11b/g mode

NOTE: Super mode is not available in 802.11b and 802.11g-wifi operational modes. Turbo mode is available only in
802.11a mode in the FCC regulatory domain. Turbo Mode is not available in frequency bands in which DFS is
required.

Turbo mode is supported in 802.11a mode in the FCC regulatory domain when DFS is not required. Turbo mode
supports turbo speeds at twice the standard data rates, and also dynamically switches between Turbo mode speeds and
normal speeds depending on the wireless client. All connected clients must be using Turbo mode in order for the AP to
operate at Turbo mode speed. If turbo mode is enabled, then this is displayed in the web Ul and the transmit speeds and
channels pull-down menus are updated with the valid values.

When Turbo mode is enabled, only a subset of the wireless channels in the 5.0 GHz spectrum can be used. If any
wireless clients do not support turbo mode, the AP will fall back to normal mode.

Turbo mode can be configured only when Super mode has already been enabled.

Super mode is supported in the 2.4 GHz and 5 GHz frequency bands in all regulatory domains. Turbo mode is available
in the 5 GHz frequency band in the FCC regulatory domain when DFS is not required.
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NOTE: Turbo mode and Mesh mode (either Mesh AP or Mesh Portal) can not be enabled on the same interface
simultaneously.

IEEE 802.11d Support for Additional Regulatory Domains

The IEEE 802.11d specification allows conforming equipment to operate in more than one regulatory domain over time.
IEEE 802.11d support allows the AP to broadcast its radio’s regulatory domain information in its beacon and probe
responses to clients. This allows clients to passively learn what country they are in and only transmit in the allowable
spectrum. When a client enters a regulatory domain, it passively scans to learn at least one valid channel, i.e., a channel
upon which it detects IEEE Standard 802.11 frames.

The beacon frame contains information on the country code, the maximum allowable transmit power, and the channels to
be used for the regulatory domain.

The same information is transmitted in probe response frames in response to a client’s probe requests. Once the client
has acquired the information required to meet the transmit requirements of the regulatory domain, it configures itself for
operation in the regulatory domain.

On some AP models, the regulatory domain and associated parameters are automatically configured when a country is
selected on the System tab. On APs in which country selection is not available on the system tab, the regulatory domain
is pre-programmed into the AP prior to shipment. Depending on the regulatory domain, a default country code is chosen
that is transmitted in the beacon and probe response frames.

Configuring 802.11d Support
Perform the following procedure to enable 802.11d support and select the country code:
1. Click Configure > Interfaces > Operational Mode.

2. Select Enable 802.11d.
3. Select the Country Code from the ISO/IEC 3166-1 CountryCode drop-down menu.

NOTE: On APs with model numbers ending in -WD, this object is not configurable.

4. Click OK.
5. Configure Transmit Power Control and Transmit Power Level if required.

Transmit Power Control/Transmit Power Level

Transmit Power Control uses standard 802.11d frames to control transmit power within an infrastructure BSS (Basic
Service Set, or combination of AP and associated clients that can communicate to each other and/or to the backhaul
connection via the AP). This method of power control is considered to be an interim way of controlling the transmit power
of 802.11d enabled clients in lieu of implementation of 802.11h.

When an AP comes online, it automatically uses the maximum TX power allowed in the regulatory domain. The Transmit
Power Control feature lets the user manually lower the transmit power level by setting a “back-off” value between 0 and
35 dBm.

When Transmit Power Control is enabled, the transmit power level of the card in the AP is set to the maximum transmit
power level minus the back-off value. This power level is advertised in Beacon and Probe Response frames as the
802.11d maximum transmit power level.

When an 802.11d-enabled client learns the regulatory domain related information from Beacon and Probe Response
frames, it learns the power level advertised in Beacon and Probe response frames as the maximum transmit power of the
regulatory domain and configures itself to operate with that power level.

As aresult, the transmit power level of the BSS is configured to the power level set in the AP (assuming that the BSS has
only 802.11d enabled clients and an 802.11d enabled AP).

NOTE: In FCC DFS-enabled bands, power control is adjusted from beacon information only.

57



Advanced Configuration AP-4000MR User Guide
Interfaces

In addition, ATPC (Automatic Transmit Power Control) is a feature to automatically adapt transmit power when the quality
of the link is more than sufficient to maintain a good communication with reduced transmit power. This feature is required
for FCC DFS. It works by monitoring the quality of the link and reducing the output power of the radio by up to 6 dB when
good link quality can still be achieved. When link quality reduces, the output power is automatically increased up to the
original power level to maintain a good link. For a full discussion of DFS, see Dynamic Frequency Selection/Radar
Detection (DFS/RD).

Configuring TX Power Control

1. Click Configure > Interfaces > Operational Mode.
2. Select Enable Transmit Power Control.

3. Enter the desired backoff from the maximum Transmit Power level (between 0 and 35 dBm) in the Wireless-A:
Transmit Power Level Back-Off or Wireless-B: Transmit Power Level Back-Off field.

4. Click OK.
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Note: This page allows configuration of a single SSID (Wireless Network Name); in order to
configure more than one SSID, please visit the SSIDVILANSecurily page.

Note: Changes to these par except Wireless Service Status, DCS, & DCS Threshold

require access point reboot in order to take effect.

Physical Interface Type 802 113 (OFDM 5 GHz)

MAC Address 00:20:A6:6F-95:87
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MNetwork Name (SSID) Wireless Network A
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RTSICTS Medium Reservation (2347 =off) Brer

Antenna Gain (Including Cable Loss) o
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Load Balancing Max Clients [es
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DCS Threshold | ™
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Channel Radar Detected Elapsed Time (Minutes) Blacklist Status
52 FALSE o Disable
56 FALSE 0 Disable
50 FALSE [i] Disable
54 FALSE 0 Disable
100 FALSE 1] Disable
104 FALSE o Disable
108 FALSE 0 Disable
112 FALSE o Disable
16 FALSE 0 Disable
120 FALSE 1] Disable
124 FALSE o Disable
128 FALSE 0 Disable
132 FALSE 0 Disable
136 FALSE 0 Disable
140 FALSE 0 Disable
149 FALSE o Disable
152 FALSE 0 Dizable
157 FALSE 1] Disable
161 FALSE 0 Disable
165 FALSE i} Disable
. ey

Wireless Distribution System (WDS)

WDS can be used to establish point-to-point (Le. wireless backhaul) connections. with other
access points. This table is used to configure WDS partner access points.

—=t

—

Port Index Partner MAC Address Status
1 C0c00:00:00:00:00 Disable
2 00:00:00:00:00:00 Disable
3 00:00:00:00:00:00 Disable
& 00:00:00:00:00:00 Disable
5 00:00:00:00:00:00 Disable
[-] C0c00:00:00:00:00 Disable

Figure 4-10 Wireless Interface A
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You can view and configure the following parameters for the Wireless-A and Wireless-B interfaces:

NOTE: You must reboot the Access Point before any changes to these parameters take effect.

Physical Interface Type: For Wireless Interface A, this field reports “802.11a (OFDM 5 GHz).” For Wireless Interface
B, depending on the operational mode, this field reports:

— For 802.11b mode only: "802.11b (DSSS 2.4 GHz)"

— For 802.11g mode: "802.11g (OFDM/DSSS 2.4 GHz)"

— For 802.11b/g mode: "802.11g (OFDM/DSSS 2.4 GHz)"

— For 802.11g-wifi mode: "802.11g (OFDM/DSSS 2.4 GHz)"

NOTE: 802.11g-wifi has been defined for Wi-Fi testing purposes. It is not recommended for use in your wireless
network environment.

OFDM stands for Orthogonal Frequency Division Multiplexing; this is the name for the radio technology used by
802.11a devices. DSSS stands for Direct Sequence Spread Spectrum; this is the name for the radio technology used
by 802.11b devices.

MAC Address: This is a read-only field that displays the unique MAC (Media Access Control) address for the Access
Point’s wireless interface. The MAC address is assigned at the factory.

Regulatory Domain: Reports the regulatory domain for which the AP is certified. Not all features or channels are
available in all countries.

Network Name (SSID): Enter a Network Name (between 1 and 32 characters long) for the primary wireless network.
You must configure each wireless client using this network to use this name as well. Additional SSIDs and VLANs
may be configured under Configure > SSID/VLAN/Security. Up to 16 SSID/VLANs may be configured per wireless
interface.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the
name.

Enable Auto Channel Select: When the Enable Auto Channel Select option is enabled, the AP scans the area for
other Access Points and selects a free or relatively unused communication channel. This helps prevent interference
problems and increases network performance. By default this feature is enabled. See Dynamic Frequency
Selection/Radar Detection (DFS/RD) for more information and Available Channels for a list of available channels.

NOTE: When an AP is configured to function as a Mesh AP, its channel will depend on the channel of its Mesh Portal.

Frequency Channel: When Auto Channel Select is enabled, this field is read-only and displays the Access Point’s
current operating Channel. When Auto Channel Select is disabled, you can specify the Access Point’s operating
channel. If you decide to manually set the unit's Channel, ensure that nearby devices do not use the same frequency
(unless you are setting up WDS links). Available channels vary based on regulatory domain. See Dynamic Frequency
Selection/Radar Detection (DFS/RD) for more information and Available Channels for a list of available channels.

NOTE: When an AP is configured to function as a Mesh AP, its channel will depend on the channel of its Mesh Portal.

Transmit Rate: Use the drop-down menu to select a specific transmit rate for the AP. The values depend on the
Operational mode. Auto Fallback is the default setting; it allows the AP unit to select the best transmit rate based on
the cell size.

— For 802.11a only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/s.

— For 802.11b only -- Auto Fallback, 1, 2, 5.5, 11 Mbits/sec.

— For 802.11g only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/sec

— For 802.11b/g -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec
— For 802.11g-wifi -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec

NOTE: 802.11g-wifi has been defined for Wi-Fi testing purposes. It is not recommended for use in your wireless
network environment.
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NOTE: Turbo mode is supported in only in 802.11a mode in the FCC regulatory domain when DFS is not required.
If turbo mode is enabled, then this is displayed in the web Ul and the transmit speeds and channels
pull-down menus are updated with the valid values.

DTIM Period: The Deferred Traffic Indicator Map (DTIM) Period determines when to transmit broadcast and multicast
packets to all clients. If any clients are in power save mode, packets are sent at the end of the DTIM period. This
parameter supports a range between 1 and 255; it is recommended to leave the DTIM at its default value unless
instructed by technical support. Higher values conserve client battery life at the expense of network performance for
broadcast or multicast traffic.

RTS/CTS Medium Reservation: The 802.11 standard supports optional RTS/CTS communication based on packet
size. Without RTS/CTS, a sending radio listens to see if another radio is already using the medium before transmitting
a data packet. If the medium is free, the sending radio transmits its packet. However, there is no guarantee that
another radio is not transmitting a packet at the same time, causing a collision. This typically occurs when there are
hidden nodes (clients that can communicate with the Access Point but are out of range of each other) in very large
cells.

When RTS/CTS occurs, the sending radio first transmits a Request to Send (RTS) packet to confirm that the medium
is clear. When the receiving radio successfully receives the RTS packet, it transmits back a Clear to Send (CTS)
packet to the sending radio. When the sending radio receives the CTS packet, it sends the data packet to the
receiving radio. The RTS and CTS packets contain a reservation time to notify other radios (including hidden nodes)
that the medium is in use for a specified period. This helps to minimize collisions. While RTS/CTS adds overhead to
the radio network, it is particularly useful for large packets that take longer to resend after a collision occurs.

RTS/CTS Medium Reservation is an advanced parameter and supports a range between 0 and 2347 bytes. When set
to 2347 (the default setting), the RTS/CTS mechanism is disabled. When set to 0, the RTS/CTS mechanism is used
for all packets. When set to a value between 0 and 2347, the Access Point uses the RTS/CTS mechanism for packets
that are the specified size or greater. You should not need to enable this parameter for most networks unless you
suspect that the wireless cell contains hidden nodes.

Antenna Gain: This parameter modifies the sensitivity of the radio card when detecting radar signals in accordance
with Dynamic Frequency Selection/Radar Detection (DFS/RD) requirements. Given that the radar detection threshold
is fixed by the regulatory codes in the country of operation, and that a variety of antennas with different gains may be
attached to the unit, adjust this threshold to account for higher than expected antenna gains and avoid false radar
detection events. Set this parameter to a value between 0 and 35. The default value is 0.

Wireless Service Status: The user can shut down (or resume) the wireless service on the wireless interface of the
AP through the CLI, HTTP, or SNMP interface. Select Shutdown to shutdown the wireless service on a wireless
interface, or to Resume to resume wireless service. When the wireless service on a wireless interface is shut down,
the AP will:

— Stop the AP services to wireless clients connected on that wireless interface by disassociating them
— Disable the associated BSS ports on that interface

— Disable the transmission and reception of frames on that interface

— Indicate the wireless service shutdown status of the wireless interface through LED and traps

— Enable Ethernet interface so that it can receive a wireless service resume command through CLI/HTTP/SNMP
interface

NOTE: WSS disables BSS ports.

NOTE: The wireless service cannot be shutdown on an interface where Rogue Scan is enabled.

NOTE: Wireless service can be shut down/resumed on each wireless interface individually.

In shutdown state, AP will not transmit and receive frames from the wireless interface and will stop transmitting
periodic beacons. Moreover, none of the frames received from the Ethernet interface will be forwarded to that wireless
interface.

Wireless service on a wireless interface of the AP can be resumed through CLI/HTTP/SNMP management interface.
When wireless service on a wireless interface is resumed, the AP will:
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— Enable the transmission and reception of frames on that wireless interface

— Enable the associated BSS port on that interface

— Start the AP services to wireless clients

— Indicate the wireless service resume status of the wireless interface through LED and traps

After wireless service resumes, the AP resumes beaconing, transmitting and receiving frames to/from the wireless
interface and bridging the frames between the Ethernet and the wireless interface.

Traps Generated During Wireless Service Shutdown (and Resume)

The following traps are generated during wireless service shutdown and resume, and are also sent to any configured
Syslog server.

When the wireless service is shut down on a wireless interface, the AP generates a trap called
oriTrapWirelessService Shutdown.

When the wireless service is resumed on a wireless interface, the AP generate a trap called
oriTrapWirelessServiceResumed.

* Load Balancing Max Clients: Load balancing distributes clients among available access points. Enter a number
between 1 and 63 to specify the maximum number of clients to allow.

» Channel Blacklist Table: The Channel Blacklist table contains all available channels (channels vary based on
regulatory domain). It can be used to manually blacklist channels, and it also reflects channels that have been
automatically blacklisted by the Dynamic Frequency Selection/Radar Detection (DFS/RD) function. In the IC, FCC,
ETSI, and TELEC regulatory domains, a channel is blacklisted automatically if it is found to be busy or occupied by
radar during a scan at start-up. When a channel has been automatically blacklisted, it will remain blacklisted for 30
minutes. Additionally, an administrator can blacklist channels manually to prevent them from being used when ACS is
enabled.

NOTE: Any change in channel-related parameters (e.g., country code, turbo mode, Operational mode, H-band
operation) resets the channel blacklist table.

The channel blacklist table can be configured only through the Web or SNMP interfaces. CLI configuration is not
supported.

To blacklist a channel manually:

1. Click on Configure > Interfaces > Wireless A or Wireless B.

2. Scroll down to the Channel Blacklist heading.
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Channel Blacklist Table

Channgl Radar Detected
i FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FalLSE
FALSE

dn G B2

b D 00 =] 0 LT

(=]

L B3 =

Elapsed Time [Minutes)

oo oooo oo oo oo o

Edit ]

This table is used to configure blacklist channels. A channel can be blacklisted
automatically if radar is detected on the operating channel (this is applicable only 1o specific
regulatory domains). If radar is detected on a channel, that channel will be blacklisted for 30
minutes. A channel can also be blacklisted by the administrator in case that channel is not
o be used when ACS is enabled.

Blacklist Status
Disable
Disable
Disable
Disable
Disable
Disable
Disabla
Disable
Disable
Disable
Disable
Disable
Disable

Figure 4-11 Channel Blacklist Table

3. Click Edit in the Channel Blacklist Table

4. Set Blacklist Status to Enable.

Channel Blacklist Table

Channel
Blacklist Status

Channel
Blacklist Status

Channel
Blacklist Status

This page is used to configure blacklisted channels. You can blacklist a channel by
setting the Blacklist Status to Enable.

1
] Ensble ;I
2
] Diszble ;I
3
] Enable 3

Figure 4-12 Channel Blacklist Table - Edit Screen

* Wireless Distribution System: A Wireless Distribution system can be used to establish point-to-point (i.e. wireless
backhaul) connections with other access points. See Wireless Distribution System (WDS) for configuration

information.

Dynamic Channel Selection (DCS)

Dynamic Channel Selection (DCS) addresses two major requirements in Optimal Channel Configuration. Principally it
enables the on-the-fly channel change without requiring a system reboot on conditions like RADAR
Detection/Configuration change of Channel. In addition to this it houses the functionality to Monitor the Channel Health in
the background and triggers ACS to perform an Auto Scan Function to select the channel with lowest interference and
dynamically switches to the new channel.
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The DCS is triggered under the following conditions:

1. Dynamic channel change required (Radar Detection and Configuration change)
2. Poor Condition of the current operating channel

NOTE: Ifthe AP finds all the channels are busy in a two hour period, DCS no longer changes channels automatically and
sends a trap message.

Configure
Montior Syst
(ST Up Time (DD HHMM-S5)
Commands System Alarms
- This table displays information onthe alams (SHMP Traps) generated by the access point. They should he
Help deleted once they are reviewsd and resolvéd. The alarm sever ity levels ane: Crmical, Major, Minor, and
It mational,

Exit

— _SelectAl_} Desaiect All_J

Reticool

Description Severity Time Stamp

AP Cold Started

A W [

DCS Trap Message

Dedete

The Access Point monitors the current channel for interference and errors. The DCS Threshold controls how
aggressively the Access Point changes the channels. The lowest value of the DCS Threshold is 1 which means channel
switch would happen even for minimum interference and the highest value (10) means the channel has to be significantly
bad. A value of “10” in the DCS threshold dropdown indicates a less Aggressive system and “1” indicates a high
aggressiveness index. Higher the value is lesser the Agressive Index showing an inversely proportional ratio.
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Wireless interface properties determine the characteristics of the wireless medium as
well as how wireless clients will communicate with the access point.

Werify configuration of the desired operational mode prior to configuring the wireless
interface properties below.

Note: This page aliows configuration of a single SSID (Wireless Network Name); in order to
configure more than one SSID, please visit the SSIDVIANSacurily page.

Note: Changes to these paramaters except Wireless Service Status, DCS, & DCS Threshold'
require access point reboot in order to take effect.

Physical Intertace Type 802.11a (OFDM 5 GHz)

MAC Address 00:20:46.6F.95:87

Regulatory Domain LISA (FCC)

Metwork Mame (SSID) iR NeTaok A

Enable Auto Channel Select =

Frequency Channel | 108 - 5.54 GHz E

Transmit Rate IA.uh Fallback E

DTIM Period (1-255 ) | [

RTSICTS Medium Reservation (2347=off) asz

Anfenna Gain (Including Cable Loss) D

Wireless Senice Status [Resume 5]

Load Balancing Max Clients [ea

Enable DCS (]

DCS Threshold | |
—id  emSilild

Channel Blacklist Table

This table is used to ct A channel can be blacklisted

 if radar is on the operating channel (this is applicable only to specific
regulatory doemains). If radar is detected on a channel, that channel will be blacklisted for 20
minutes. A channel can also be blacklisted by the administrator in case that channel is not
to be used when ACS is enabled.

' Ny
Channel Radar Detected Elapsed Time (Minutes) Blacklist Status
52 FALSE 1] Disable
56 FALSE 0 Digable
&0 FALSE 1] Disable
64 FALSE 0 Disable
100 FALSE 1] Disable
104 FALSE 1] Disable
108 FALSE 0 Digable
112 FALSE 1] Disable
116 FALSE 0 Disable
120 FALSE 1] Disable
124 FALSE 0 Disable
128 FALSE o Digable
132 FALSE 1] Disable
136 FALSE 0 Disable
140 FALSE 1] Disable
149 FALSE 1] Disable
153 FalLSE 0 Digable
157 FALSE 1] Disable
161 FALSE 0 Disable
165 FALSE 0 Disable

. >y

Wireless Distribution System (WDS)

WDS5 can be used 10 establish point-to-point (i.e. wireless backhaul) connections with other
access points. This table is used to configure WDS partner access points.

-
Port Index. Partner MAC Address Status
1 00:00:00:00:00:00 Disable
2 00:00:00:00:00:00 Disable
3 00:00:00:00:00:00 Disable
4 00:00:00:00:00:00 Disable
5 00:00:00:00:00:00 Disable
1] 00c00:00:00:00:00 Disable

Figure 4-13 A complete Interfaces page
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DCS can be configured using the following interfaces:
*  Web (HTTP) Interface
¢ Command Line Interface (CLI)
¢ MIB (SNMP) Requirements
Web (HTTP) Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s Ethernet Port.

The user will be able to enable/disable the Dynamic Channel Selection feature in the Wireless subtab. If DCS is disabled,
all DCS configuration options are grayed out showing the text fields are not configurable.

The default value for DCS text field is Disable and for DCS Threshold is 5.
To configure the HTTP (Web) interface, click Configure>Interfaces>Wireless A and B.
To reset your configuration, click Cancel.

You can configure HTTP page for configuring the DCS feature for each interface separately.

A E e o i 3t L . P al iy +
Alafms \ Bridge ]l Q033 “ £ \ SSIDVLANISecunity
rofles
> LY
Syatem Mebaork i Lanagement 1\‘ Filtering 1
. eeeeemesssssssess——— _
) e \ weless - B \'k & K esh 1
Nrelcas mteriace propertics doterming tha characioriatica of tha wircloas meciiurm as
wiell as how wwreles s clients will commumnecate with the accoss rn.'b"-'
I R00
Comimand Note: This page allows configuration of & single S50 (Wirslsss Network Name); in oroer to
configure more than one SSI0 please visit the iy page.
Help Note: Changes (o s Darammiers arcept Wireless Service Stafus, DCS, £ DCS Threahold
FeQUIre access poird rebool inorder o take effecl
Euil
Retoot : e :
Regulalory Domair SA O
e Mame ([ SSIC Riy Wireless Natwsos A
4T=0ff as
wntenna Gain (including Cable L £ = i
e o OC% Configurable
Wireless Serade Status [ -I fields
g @ ng Max Chent &4
[~
I 3 -I
; - F]

Figure 4-14 Configurable DCS fields

NOTE: Changes to these parameters except Wireless Service Status, DCS and DCS Threshold require Access Point
reboot in order to take effect.

Command Line Interface (CLI)

See the Command Line Interface (CLI) section in Appendix A.
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MIB (SNMP) Requirements

DCS feature can be managed and monitored by MIB objects too. All the configuration parameters are present for both
Interface A and Interface B separately. The oriWirelessIfDCSThreshold object stores the DCS Threshold from 1 to 10.

See the table below for defaults and units for all objects.

Feature MIB/Group Object Data type Values Access | Default
DCS orinoco-> orinocolf-> | oriWirelessIf | Integer Enable (1) RwW 2
orinocoWirelesslf -> DCSStatus Disable (2)
oriWirelesslfPropertie
sTable
DCS orinoco-> orinocolf-> | oriWirelessIf | Integer 1to 10 RwW 5
Thresho | orinocoWirelesslf -> DCSThreshol
Id oriWirelesslfPropertie | d
sTable

Dynamic Frequency Selection/Radar Detection (DFS/RD)

In order to prevent interference with radar systems and other devices that occupy the 5 GHz band, 802.11a APs certified
in the ETSI, TELEC, FCC, and IC regulatory domains (see Affected Countries) and operating in the middle and high
frequency bands select an operating channel through a combination of Auto Channel Select (ACS) and Dynamic
Frequency Selection (DFS)/Radar Detection (RD).

During boot-up, ACS scans the available channels and selects the best channel. Once a channel is selected, the AP
performs a channel availability check for 60 seconds to ensure that the channel is not busy or occupied by radar, and
then commences normal operation. (In Canada, if the channel was previously blacklisted, the AP scans for 600 seconds
before commencing normal operation if the selected channel frequency is in the 5600 - 5650 MHz range). When the AP
enters normal operation, DFS works in the background to detect interference in that channel. If interference is detected,
the AP sends a trap, disassociates all clients, blacklists the channel, and reboots. After it reboots, ACS re-scans and
selects a better channel that is not busy and is free of radar interference.

If ACS is disabled, only channels in the lower, upper, and ISM frequency bands are available for use:

* 36:5.180 GHz (default)
* 40:5.200 GHz

e 44:5.220 GHz

* 48:5.240 GHz

* 149:5.745 GHz

* 153:5.765 GHz

« 157:5.785 GHz

* 161:5.805 GHz

* 165:5.825 GHz

If you are using the unit in a country and band that require DFS, keep in mind the following:

» DFS is not a configurable parameter; it is always enabled and cannot be disabled.

* You cannot manually select the device’s operating channel; you must let the unit select the channel. You may make
channels unavailable by manually “blacklisting” them and preventing those channels being selected, in accordance
with local regulations or interference. You can also display the Channel Blacklist Table to view the channels that have
been blacklisted by the AP.
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In compliance with FCC regulations, the AP uses ATPC (Automatic Transmit Power Control) to automatically adapt
transmit power when the quality of the link is more than sufficient to maintain a good communication with reduced
transmit power. See Transmit Power Control/Transmit Power Level for more information.

DFS is required for three purposes:

1.

Radar avoidance both at startup and while operational. To meet these requirements, the AP scans available
frequencies at startup. If a DFS enabled channel is busy or occupied with radar, the system will blacklist the channel
for a period of 30 minutes in accordance with FCC, IC, ETSI, and TELEC regulations. Once fully operational on a
frequency, the AP actively monitors the occupied frequency. If interference is detected, the AP blacklists the channel,
logs a message and rescans to find a new frequency that is not busy and is free of radar interference.

Guarantee the efficient use of available frequencies by all devices in a certain area. To meet this requirement, the AP
scans each available frequency upon startup and selects a frequency based upon the least amount of noise and
interference detected. This lets multiple devices operate in the same area with limited interference. This procedure is
done only at startup; if another UNII device comes up on the same frequency, the AP does not detect this or rescan
because of it. It is expected that other devices using these frequencies also are in compliance with country
regulations, so this should not happen.

Uniform Channel Spreading. To meet this requirement, the AP randomly selects its operating channel from the
available channels with least interference.

Affected Countries

Japan is certified in the TELEC regulatory domain, Canada is certified in the IC regulatory domain, and the USA is
certified in the FCC regulatory domain for operation in the 5 GHz band.

The following countries are certified in the ETSI regulatory domain for operation in the 5 GHz band:

Austria — Greece — Norway
Belgium — Hungary — Poland
Czech Republic — lreland — Portugal
Cyprus — ltaly — Spain
Denmark — Latvia — Sweden
Estonia — Lithuania — Switzerland
Finland — Luxembourg - UK
France — Malta

Germany — Netherlands

VLAN on Ethernet Port

VLANSs are very useful to segment the LAN into different broadcast domains. This helps in reducing the broadcast
domain by separating logical segments of a LAN. VLANs can operate in different modes based on the incoming traffic.

VLAN on Ethernet port of AP can be configured in different ways. Following are the different modes in which VLAN
functions.

Transparent Mode
Access Mode
Trunk Mode
Mixed Mode
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Transparent Mode

Transparent mode is the default mode and is equivalent to the NO VLAN support. The VLAN receievs both the tagged
and untagged frames from the network. Transparent mode simply forwards both the tagged and untagged frames
received on the Ethernet port to WDS, Mesh or BSS and is not able to read any VLAN information.

) ; 1 RADIUSPXU :
A SSIDVLAN, {
j Alarms . \ Bridge ¥ \ QoS \ | _F_'r_’r‘_mf_’ﬁ_ \ : IDVLAMIS ecurity
System Metwork '\ Management \ Filtering \
Status = = ~ T :
Op Mode Wireless - A Wireless -B Ethernet \ Mesh \L

This tab iz used to configure the Ethernet interface speed and transmission mode.

lonitcr Note 1: Changes to Only Speed and Transmission Mode parameter requires access point
raboot in order to take effact,
Gommands Note 2: Ethernat Vian iz Enabled and Mgnt VID is not presont in Access/Trunk tabla, user
cant bo able to manage AP using Ethermet interface,
Help
; MAC Address 00:-2(-AB:62:8E:49
Bl Speed and Transmission Mode |suta—5_=-55c|-sut::—:uplex ;!
Reboot
VLAMN MODE Transparent ;l

Access VLAN ID

Access VLAM Priority

VLAN 1
VLAN 2
VLAN 3
VLAMN 4
VLAN 5
VLAN 6
VLAN 7
VLAN 8
VLAMN 9
VLAN 10
VLAN 11
VLAN 12
VLAN 13
VLAN 14
VLAN 15
VLAN 16

— -
Figure 4-15 Ethernet Interface

Access Mode

Access mode is used when we want to have a non-VLAN aware device connected on ethernet side to be a part of the
VLAN network. Access Point tags or untags the frames for this device. The frames receiving on Ethernet port, which is
destined to WDS, Mesh or BSS, are tagged with Access VLAN ID, Priority and forwards to the corresponding ports.

NOTE: Access mode does not work unless you enable VLAN tagging.
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Mesh/ WDS Camera
N — N —
Client-1 Client-2
Trunk Mode

Trunk mode works as a filter. Trunk links provide VLAN identification for frames travelling between switches. Once this
mode is enabled, the frames received from the WDS, Mesh or wireless ports are filtered and compared with the trunk
tables entries. The device percolates the incoming frames comparing with the trunk table data and forwards to the
respective ports. The trunk table is configurable on the Access Point. The frames with any mismatched tags are dropped
at this point. To distinguish between the traffic flows, a trunk port must mark the frames with special tags as they pass
between the switches.

VLAN Aware Switch

Trunk link /}_{,_‘H(.a—avﬁ—.\h

A %

et [ wa b L VLAN Aware. )
Mesh WDs \. )
e L

o — o —
Client-1 Client-2

Mixed Mode

Mixed mode is the combination of both the Access mode and the Trunk mode. All devices connected to the Ethernet
except for one device have to be VLAN aware. The Access Point puts this device into Access Mode and works as Trunk
Mode for other devices. The frames an Access Point receives are either untagged or tagged. For all incoming untagged
frames, Access mode rules are applied. The frames are tagged with the Access VLAN ID and are forwarded to the
respective ports. Trunk mode works when an Access Point receives tagged frames. The tagged frames are compared
with the Trunk table entries and are forwarded if it matches the entries, otherwise dropped.

NOTE: In Mixed Mode, Access VLAN ID should not be present in Trunk table.
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Client-1 Client-2

Management VLAN Configuration

Trunk Mode: In trunk mode if any management VLAN ID is configured then that management VLAN ID should present in
trunk table, then only we can able to manage the device.

Access Mode : In Access mode if any management VLAN ID is configured then that management VLAN ID should be
same as Access VLAN ID, then only we can able to manage the device .

Mixed Mode: In this mode the management VLAN ID should be present either in Trunk table or Access VLAN ID, and
then only we can able to manage the device.

WARNING: Error in configuring the VLAN management ID may result in loss of management access to the
Access Point. If this occurs, then the AP can only be managed via the serial port (console) port.

Configurable VLAN Parameters

Access VLAN ID: The Access VLAN ID is configurable in Access and Mixed mode. The Access VLAN ID values range
from 1 to 4094; the default value is 1.

Access VLAN Priority: The Access VLAN priority is configurable in Access and Mixed modes. The value in VLAN
Priority ranges from 0 to 7. The type of the Access VLAN Periority is VLAN ID only. The default value is 0.

VLAN 1-16: The VLAN IDs are configurable only in the Trunk and Mixed modes and apply in the both modes. The VLAN
ID values range from -1 to 4094. The default value is 4094. Here -1 represents the untagged frames. The maximum
number of VLAN IDs that can be configured in the AP VLAN table is 16.

Interface Requirements

There are several management and monitoring interfaces available to the network administrator to configure and
manage the unit. These are:

¢ Web Interface
¢ Command Line Interface (CLI)
* SNMP

Web Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s EthernetPort.

To configure the HTTP (Web) interface, click Configure>Interfaces>Ethernet
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Status : . ——— X
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_onfigure
This tab is used to configure the Ethernet interface speed and transmission mode.

fdonitar Note 1: Changes to Only Speed and Transmission Mode parameter requires access point
reboot in order to take effact,

Gommands Note 2: Etherpet Vian is Enabled and Mgnt VID is not present in Access/Trunk table, user
cant boe able to manage AP using Ethernet interface,
Help
; MAC Address 00 20:A6:62:8E:49
Bl Speed and Transmission Mode |Suln—speea—aut:—:uplex ;!

Reboot
VLAN MODE | Transparent _v_’
Access VLAN ID 1
Access VAN Priarity 0
VLAN 1 4054
VLAN 2 I—
VLAM 3 4094
WLAN 4 4054
VLAN 5 4024
VLAN B l—
VLAM 7 I—-—
VLAN 8 4054
VLAN 9 4034
VLAN 10 4054
VLAN 11 4054
WLAN 12 E
VLAN 13 4094
WLAN 14 4054
VLAN 15 4024
VLAN 16 foss—

p— — il

Figure 4-16 Web Interface configuration

NOTE: By default, the speed and transaction mode is auto-speed-auto-duplex and VLAN mode is Transparent.
NOTE: Ethernet VLAN is Enabled and Mgnt VID is not present in Access/Trunk table, user can’t be able to manage AP

using Ethernet interface.

Based upon the modes you select, the Access VLAN ID, Access Priority and the VLAN text fields also vary, either
enabled or disabled, or both enabled and disabled. The detail is mentioned below:

When VLAN Mode is Transparent, all the text boxes from VLAN 1 to VLAN 16, Access VLAN ID and Access VLAN
Priority are disabled.

When VLAN Mode is Trunk, text boxes from VLAN 1 to VLAN 16 are enabled and Access VLAN ID and Access
VLAN Priority are disabled.

When VLAN Mode is Access, text boxes Access VLAN ID and Access VLAN Priority are enabled and VLAN 1 to
VLAN 16 text boxes are disabled.

When VLAN Mode is Mixed, all the text boxes from VLAN 1 to VLAN 16, Access VLAN ID and Access VLAN Priority
are enabled.

Select your mode manually and configure the parameters and finally click OK.
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Command Line Interface (CLI)

See the Command Line Interface (CLI) section in Appendix A.

SNMP

VLAN can be configured through SNMP with MIB objects. Note that this requires an SNMP manager program like HP
Openview or Castlerock’'s SNMPc. The AP supports several Management Information Base (MIB) files that describe the
parameters that can be viewed and/or configured over SNMP. The MIB can be opened with any text editor, such as
Microsoft Word, Notepad, or WordPad.

MIB objects that support VLAN are mentioned in the following table.

Object Name Data Type Values/ Ranges Default Value Access
oriEthernetlfVlanMode Integer 0 — Transparent 0 RW

1 — Trunk mode

2 — Access mode

3 — Mixed mode
oriEthernetifAccessVlanld Vlanld 1-4094 1 RW
oriEthernetlfAccessVlanPriority Vlanld 0-7 0 RW
oriEthernetlfTrunkVlanld01 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanid01 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld03 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld04 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld05 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld06 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld07 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld08 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld09 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanid010 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVianid11 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanid12 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld13 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld14 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld15 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld16 Vlanld -1-4094 4094 RW

Wireless Distribution System (WDS)

A Wireless Distribution System (WDS) creates a link between two 802.11a, 802.11b, or 802.11b/g APs over their radio
interfaces. This link relays traffic from one AP that does not have Ethernet connectivity to a second AP that has Ethernet
connectivity. WDS allows you to configure up to six (6) ports per radio (up to 12 ports in all).

In the WDS example below, AP 1 and AP 2 communicate over a WDS link (represented by the blue line). This link
provides Client 2 with access to network resources even though AP 2 is not directly connected to the Ethernet network.
Packets destined for or sent by the client are relayed between the Access Points over the WDS link.
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Client 1

Client 2
Figure 4-17 WDS Example

Bridging WDS

Each WDS link is mapped to a logical WDS port on the AP. WDS ports behave like Ethernet ports rather than like
standard wireless interfaces: on a BSS port, an Access Point learns by association and from frames; on a WDS or
Ethernet port, an Access Point learns from frames only. When setting up a WDS, keep in mind the following:

WDS and Mesh functionality cannot be enabled on the same radio when the AP is configured to function as a Mesh
AP.

There are separate security settings for clients and WDS links. The same WDS link security mode must be configured
(currently we only support none or WEP) on each Access Point in the WDS and the same WEP key must be
configured.

The WDS link shares the communication bandwidth with the clients. Therefore, while the maximum data rate for the
Access Point's cell is 54 Mbits/second (802.11a, 802.11g only, or 802.b/g modes) or 11 Mbits/second (802.11b only
mode), client throughput will decrease when traffic is passing over the WDS link.

If there is no partner MAC address configured in the WDS table, the WDS port remains disabled.

A WDS port on a single AP should have a unique partner MAC address. Do not enter the same MAC address twice in
an AP’s WDS port list.

Each Access Point that is a member of the WDS must have the same Channel setting to communicate with each
other.

If your network does not support spanning tree, be careful to avoid creating network loops between APs. For example,
creating a WDS link between two Access Points connected to the same Ethernet network will create a network loop (if
spanning tree is disabled). For more information, see the Spanning Tree section.

When WDS is enabled, Spanning Tree protocol is automatically enabled. It may be manually disabled. If Spanning
Tree protocol is enabled by WDS and WDS is subsequently disabled, Spanning tree will remain enabled until it is
manually disabled. See Spanning Tree.

WDS Setup Procedure
NOTE: You must disable Auto Channel Select to create a WDS. Each Access Point that is a member of the WDS must

have the same channel setting to communicate with each other.
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NOTE: WDS and Mesh functionality cannot be enabled on the same radio when the AP is configured to function as a
Mesh AP.

To setup a wireless backbone follow the steps below for each AP that you wish to include in the Wireless Distribution
System.

—_

. Confirm that Auto Channel Select is disabled.

2. Write down the MAC Address of the radio that you wish to include in the Wireless Distribution System.
3. Click on Configure > Interfaces > Wireless A or Wireless B.

4. Scroll down to the Wireless Distribution System heading.

Wireless Distribution System (WDS)

W5 can be used to establish paint-to-point (i.e. wireless backhaul) connections with other
stoedd powits. This table is used to configure WDS partner sctesd polnts.

Edit J

Port indax Partmar MAC Address Status
1 00:00:00:00:00:00
00:00:00:00:00:00
00:00:00:00:00:00
00C00:00:00000:00
00:00:00:00:00:00
00:00:00:00:00:00

L3 k3

onoLn e

Figure 4-18 WDS Configuration

5. Click the Edit button to update the Wireless Distribution System (WDS) Table.
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Figure 4-19 Adding WDS Links

6. Select which encryption method to use (if any) from the WDS Security Mode drop-down menu.

7. If you selected a WDS Security Mode, do one of the following:
» If you selected WEP: Enter an encryption key.
« If you selected AES: Enter a shared secret.

8. Enter the MAC Address that you wrote down in Step 2 in one of the Partner MAC Address field of the Wireless

Distribution Setup window.
9. Set the Status of the device to Enable.
10.Click OK.
11.Reboot the AP.

Ethernet

Select the desired speed and transmission mode from the drop-down menu. Half-duplex means that only one side can
transmit at a time and full-duplex allows both sides to transmit. When set to auto-duplex, the AP negotiates with its switch

or hub to automatically select the highest throughput option supported by both sides.
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This tab is used to configure the Ethernet interface speed and transmission mode.

MNote 1: Changes to Only Spead and Transmission Mode parameter requires access point
reboot in order to take effect.

Note 2: If Ethernet vian is Enabled ensure Mgmt VID is present in Access/Trunk table to
manage the AP using Ethernet interface.

MAC Address 00 20-A6:68:45.F1
Speed and Transmission Mode Isuts—spEEd—autn—dupIEx ;[
VILANM MODE I Transparent ;I

Figure 4-20 Ethernet Sub-tab

For best results, Proxim recommends that you configure the Ethernet setting to match the speed and transmission mode
of the device the Access Point is connected to (such as a hub or switch). If in doubt, leave this setting at its default,
auto-speed-auto-duplex. Choose between:

* 10 Mbit/s - half duplex or full duplex

* 100 Mbit/s - half duplex or full duplex

* Auto speed - auto duplex
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Mesh

Mesh functionality can be enabled on only one of the AP’s wireless interfaces. When configured for Mesh, the AP’s
wireless interface simultaneously functions as a Mesh link and as a radio to service clients.

CAUTION: Mesh mis-configuration may cause problems in your wireless network. Before configuring an interface for

Mesh functionality, see Mesh Network Configuration.

Basic Mesh Parameters

Commands

Iondoe

Alarms 'l Bricige 1 205 RADILISPRL Profies I\ SSDNVLANSsCEy

—

.
System Metwrork | Management \ Fitering |

Figure 4-21 Basic Mesh Parameters

Configure the following basic parameters for Mesh functionality, and click OK.

NOTE: Changes to these parameters require a reboot in order to take effect.

Mesh Mode: Use this drop down menu to enable/disable Mesh functionality on a wireless interface. When Mesh
Mode is set to Disable, all other parameters on this tab will be grayed out. To enable Mesh functionality, choose one

of the following:
— Mesh Portal: Choose this option if the AP will be connected directly to the wired backbone.
— Mesh AP: Choose this option if the AP will connect to the portal and backbone wirelessly.
NOTE: Proxim recommends enabling Auto Channel Select when configuring an AP as a Mesh AP. Auto Channel

Select is configured on the Wireless A or Wireless B page. See Wireless-A (802.11a) and Wireless-B
(802.11b/g Radio) for more information.

Mesh Radio: Select the wireless interface on which to enable Mesh functionality. Select Wireless Interlace A
(802.11a radio) or Wireless Interface B (802.11b/g radio).
Mesh SSID: Enter a unique Mesh Network Name (SSID) between 1 and 16 characters.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the
name.
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» Security Mode: Select None to use Mesh networking without security, or AES to enable AES encryption between
Mesh links.

» Shared Secret: Enter a password between 6 and 32 characters. This is the password shared between a Mesh AP
and the Portal to which it is connected when AES is selected as the security mode.

» Mesh Mobility: Set this parameter to Fixed if the AP is statically placed, or to Mobile if the AP is mobile.

* QoS Policy Index: The index number of the QoS policy to be used by the Mesh radio. For more information on QoS,
see QoS.

» Disable Client Access on Mesh Radio: When this option is enabled, the AP will not accept clients on its Mesh radio.
When disabled, clients can link to the Mesh radio.

Advanced Mesh Parameters

Y Y RADTISIFRI
Alarms \ Bridge QoS RADIUSIPXU \ SSIDNLANISecurily \.
L Profiles L z
System Metwork terface \ Management \ Filtering \
Status = —————
COp Mode Wireless - A Wireless-B Ethemet A ‘\

The parameters on this page are preconfigured with default settings that optimize the type of network you identified
in the Mesh Mobility parameter on the previous page. Proxim recommends changing these values only if you have
advanced knowledge of Mesh Hetworking., See the User Guide for parameter descriptions.

Monitor
This page is used to configure Mesh advanced functionality on the access point.

Commands. ¢
Help
E:ilt _
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Hop F (Level 0 to 10
RSSI Factor (Level 0 lo 10
Medium iLevel O to

(Range
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User Defined Cost 0 (Range 0 toé
_ Default 3
Hote: Auto Switch Mode iz applicable only for a Portal. Depending on the Ethernet connection, if the
Auto Switch Mode is enabled, the Current Mesh Mode may be different from the configured mode.
Enable Auto Switch Mesh Mode |5
Current Mesh Mode Disable
Disable Client Access on No Uplink Connection [
Motify Clients On Uplink Change |
Ofs j Cancel

Figure 4-22 Advanced Mesh Parameters

Click on the Advanced button on the Interfaces > Mesh page to access advanced Mesh parameters. The parameters
on the Advanced Mesh Parameters page are preconfigured with default settings that optimize the type of network
identified in the Mesh Mobility parameter on the previous page. Proxim recommends changing these values only if you
have advanced knowledge of Mesh networking.
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Mesh Link Parameters

To reset these parameters to their default settings, click the Default button.

NOTE: Changes to these parameters require a reboot in order to take effect.

Maximum Active Mesh Links: Select a number between 1 and 32 to configure the number of Mesh links that can be
connected to a single Mesh portal or Mesh AP, as follows:

— Mesh Portal: This number represents the maximum downlinks to Mesh APs (up to 32).

— Mesh AP: This number includes one mandatory uplink to the Mesh Portal, with the remaining links (up to 6)
available for downlinks to Mesh APs. A mobile Mesh AP should be configured to 1 to allow only uplinks.

— Proxim recommends a maximum of 30-40 APs total per portal (whether connected directly to the Portal or to
another Mesh AP). See Mesh Network Configuration.

Maximum Hops to Portal: Set the maximum number of hops (1 to 4) allowed to reach the Mesh portal.

Hop Factor: This parameter specifies how much weight should be given to the number of hops (vs. RSSI and
Medium Occupancy) when determining the best path to the Mesh Portal. The range is 0 to 10. Set the value to a
higher number to give more weight to this factor; set this value to a lower number to give less weight to this factor.
Setting this value to a lower number is beneficial in applications where an AP roams because of signal strength.

RSSI Factor: This parameter specifies how much weight should be given to RSSI level (vs. number of hops and
Medium Occupancy) when determining the best path to the Mesh Portal. The range is 0 to 10. Set the value to a
higher number to give more weight to this factor; set this value to a lower number to give less weight to this factor.

Medium Occupancy Factor: This parameter specifies how much weight should be given to Medium Occupancy level
(vs. number of hops and RSSI) when determining the best path to the Mesh Portal. The Medium Occupancy level is
the amount of wireless traffic on the channel. The range is 0 to 10. Set the value to a higher number to give more
weight to this factor; set this value to a lower number to give less weight to this factor.

Receive Signal Strength Cut-Off: This parameter specifies the minimum level of received signal strength needed for
the node to be considered a Mesh link. If the Receive Signal Strength at the node is below this level, it is not
considered a link. Set this value to a number between 0 and 26 (dB).

Roaming Threshold: The Roaming Threshold is the point at which the AP roams or chooses another link. The
threshold number is the difference between two path costs; if the difference is larger than the roaming threshold, the
AP roams; if the difference is smaller than the roaming threshold, the AP maintains its connection with the current link.
The range is 1 to 100. In a static Mesh environment, set this parameter to a high value to avoid switching links too
frequently. In a mobile Mesh environment, set this parameter to a lower value (1 - 20) to allow optimal link
establishment. Note that this parameter has no effect in Mesh Portal mode.

User Defined Cost: This parameter allows the user to manually add cost to the overall path cost, in order to force
connection to one AP over another.

Auto Switch Mode Parameters

Auto Switch Mode parameters may be configured only for a Mesh Portal. Auto Switch mode allows an AP configured as
a Mesh Portal to switch its mode to be a Mesh AP if it loses its uplink (Ethernet) connection. If the uplink connection is
regained, the AP will switch back to Mesh Portal mode.

NOTE: Depending on the Ethernet connection, if Auto Switch Mode is enabled, the displayed Current Mesh Mode may

be different from the mode that was actually configured.

NOTE: Changes to these parameters require a reboot in order to take effect.

Enable Auto Switch Mesh Mode: When enabled, an AP configured as a Mesh Portal can dynamically switch to
functioning as a Mesh AP if it loses its uplink connection.

NOTE: When enabling Auto Switch Mode, Proxim recommends that you also enable Auto Channel Select. ACS is
configured on the Wireless A or Wireless B page. See Wireless-A (802.11a) and Wireless-B (802.11b/g
Radio) for more information.

Current Mesh Mode: Displays the current Mesh mode of the AP (Mesh Portal or Mesh AP).
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+ Disable Client Access on No Uplink Connection: When this option is enabled, the AP will not provide wireless
connections to clients on both radios if the unit does not have an uplink connection.

* Notify Clients on Uplink Change: When this option is enabled, the AP will send a deauthentication message to
currently connected clients when its uplink changes. This allows clients to restart a fresh connection, renewing their IP
addresses if necessary.

For more information on Mesh, see Mesh Networking.
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Management

The Management tab contains the following sub-tabs:

Passwords

IP Access Table

Services

Automatic Configuration (AutoConfig)
Hardware Configuration Reset (CHRD)

Passwords

Passwords are stored in flash memory and secured using encryption. You can configure the following passwords:

SNMP Read Community Password: The password for read access to the AP using SNMP. Enter a password
between 6 and 32 characters in both the Password field and the Confirm field. The default password is public.

SNMP Read/Write Community Password: The password for read and write access to the AP using SNMP. Enter a
password between 6 and 32 characters in both the Password field and the Confirm field. The default password is
public.

SNMPv3 Authentication Password: The password used when sending authenticated SNMPv3 messages. Enter a
password in both the Password field and the Confirm field. This password must be between 6 and 32 characters, but
a length of at least 8 characters is recommended. The default password is public. Secure Management (Services
tab) must be enabled to configure SNMPv3.

The default SNMPv3 username is administrator, with SHA authentication and DES privacy protocol.

SNMPv3 Privacy Password: The password used when sending encrypted SNMPv3 data. Enter a password in both
the Password field and the Confirm field. This password must be between 6 and 32 characters, but a length of at
least 8 characters is recommended. The default password is public. Secure Management (Services tab) must be
enabled to configure SNMPV3.

Telnet (CLI) Password: The password for the CLI interface (via serial or Telnet). Enter a password between 6 and 32
characters in both the Password field and the Confirm field. The default password is public.

HTTP (Web) Password: The password for the Web browser HTTP interface. Enter a password between 6 and 32
characters in both the Password field and the Confirm field. The default password is public.

NOTE: For security purposes Proxim recommends changing ALL PASSWORDS from the default “public” immediately,

to restrict access to your network devices to authorized personnel. If you lose or forget your password settings,
you can always perform a Soft Reset to Factory Defaults or Hard Reset to Factory Defaults.
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The Management IP Access table limits in-band management access to the IP addresses or range of IP addresses
specified in the table. This feature applies to all management services (SNMP, HTTP, and CLI) except for CLI
management over the serial port. To configure this table, click Add and set the following parameters:

» |IP Address: Enter the IP Address for the management station.
» IP Mask: Enter a mask that will act as a filter to limit access to a range of IP Addresses based on the IP Address you

already entered.

— The IP mask 255.255.255.255 would authorize the single station defined by the IP Address to configure the
Access Point. The AP would ignore commands from any other IP address. In contrast, the IP mask 255.255.255.0
would allow any device that shares the first three octets of the IP address to configure the AP. For example, if you
enter an IP address of 10.20.30.1 with a 255.255.255.0 subnet mask, any IP address between 10.20.30.1 and

10.20.30.254 will have access to the AP’s management interfaces.

+ Comment: Enter an optional comment, such as the station name.

To edit or delete an entry, click Edit. Edit the information, or select Enable, Disable, or Delete from the Status pull-down

menu.

Services

You can configure the following management services:

Secure Management

Secure Management allows the use of encrypted and authenticated communication protocols such as SNMPv3, Secure

Socket Link (SSL), and Secure Shell (SSH) to manage the Access Point.

» Secure Management Status: Enables the further configuration of HTTPS Access, SNMPv3, and Secure Shell
(SSH). After enabling Secure Management, you can choose to configure HTTPS (SSL) and Secure Shell access on
the Services tab, and to configure SNMPv3 passwords on the Passwords tab.
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SNMP Settings

SNMP Interface Bitmask: Configure the interface or interfaces (Ethernet, Wireless-Slot A, Wireless-Slot B, All
Interfaces) from which you will manage the AP via SNMP. You can also select Disabled to prevent a user from
accessing the AP via SNMP.

HTTP Access

HTTP Interface Bitmap: Configure the interface or interfaces (Ethernet, Wireless-Slot A, Wireless-Slot B, All
Interfaces) from which you will manage the AP via the Web interface. For example, to allow Web configuration via the
Ethernet network only, set HTTP Interface Bitmask to Ethernet. You can also select Disabled to prevent a user from
accessing the AP from the Web interface.

HTTP Port: Configure the HTTP port from which you will manage the AP via the Web interface. By default, the HTTP
port is 80. You must reboot the Access Point if you change the HTTP Port.

HTTP Wizard Status: The Setup Wizard appears automatically the first time you access the HTTP interface. If you
exited out of the Setup Wizard and want to relaunch it, enable this option, click OK, and then close your browser or
reboot the AP. The Setup Wizard will appear the next time you access the HTTP interface.

HTTPS Access (Secure Socket Layer)
NOTE: SSL requires Internet Explorer version 6, 128 bit encryption, Service Pack 1, and patch Q323308.

NOTE: You need to reboot the AP after enabling or disabling SSL for the changes to take effect.

HTTPS (Secure Web Status): The user can access the AP in a secure fashion using Secure Socket Layer (SSL)
over port 443. The AP comes pre-installed with all required SSL files: default certificate and private key installed. Use
the drop-down menu to enable/disable this feature.

SSL Certificate Passphrase: After enabling SSL, the only configurable parameter is the SSL passphrase. The
default SSL passphrase is proxim.

The AP supports SSLv3 with a 128-bit encryption certificate maintained by the AP for secure communications
between the AP and the HTTP client. All communications are encrypted using the server and the client-side
certificate.

If you decide to upload a new certificate and private key (using TFTP or HTTP File Transfer), you need to change the
SSL Certificate Passphrase for the new SSL files.

Accessing the AP through the HTTPS interface

The user should use a SSL intelligent browser to access the AP through the HTTPS interface. After configuring SSL,
access the AP using https:// followed by the AP’s management IP address.
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Figure 4-23 Management Services Configuration Screen

Telnet Configuration Settings

This tab is used to configure Secure Management, SHMP, Telnet (CLI), and HTTP {web) parameters.

ation protecels such
as SHMPv3, and Secure Socket Link (55L), to manage the Access Point. When Secure Management is
turned on, the scope and access for the traditional non-secure means to manage the Access Pointis

ters and
Secure Shell parameters (SSH Enable/Disable and SSH Key Status) require access point reboot in order to

Waming! Generation of 55H keys may take up to 3-4 minuies and the Access Point may not respond

55H keys can be generated by setting the $5H Host Key Status to create or by enabling 55H when no keys

I Secure Managemant is enabled when 55H is not enabled, the key generation will happen after the next

+ Telnet Interface Bitmask: Select the interface (Ethernet, Wireless-Slot A, Wireless-Slot B, All Interfaces) from
which you can manage the AP via telnet. This parameter can also be used to Disable telnet management.
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* Telnet Port Number: The default port number for Telnet applications is 23. However, you can use this field if you
want to change the Telnet port for security reasons (but your Telnet application also must support the new port
number you select). You must reboot the Access Point if you change the Telnet Port.

* Telnet Login Idle Timeout (seconds): Enter the number of seconds the system will wait for a login attempt. The AP
terminates the session when it times out. The range is 30 to 300 seconds; the default is 60 seconds.

* Telnet Session Idle Timeout (seconds): Enter the number of seconds the system will wait during a session while
there is no activity. The AP will terminate the session on timeout. The range is 60 to 36000 seconds; the default is 900
seconds.

Secure Shell (SSH) Settings

The AP supports SSH version 2, for secure remote CLI (Telnet) sessions. SSH provides strong authentication and
encryption of session data.

The SSH server (AP) has host keys - a pair of asymmetric keys - a private key that resides on the AP and a public key
that is distributed to clients that need to connect to the AP. As the client has knowledge of the server host keys, the client
can verify that it is communicating with the correct SSH server. The client authentication is performed as follows:

» Using a username/password pair if RADIUS Based Management is enabled; otherwise, using a password to
authenticate the user over a secure channel created using SSH.

SSH Session Setup
An SSH session is setup through the following process:

* The SSH server public key is transferred to the client using out-of-band or in-band mechanisms.
» The SSH client verifies the correctness of the server using the server’s public key.
» The user/client authenticates to the server.

* An encrypted data session starts. The maximum number of SSH sessions is limited to two. If there is no activity for a
specified amount of time (the Telnet Session Timeout parameter), the AP will timeout the connection.

SSH Clients

The following SSH clients have been verified to interoperate with the AP’s server. The following table lists the clients,
version number, and the website of the client.

Clients Version Website
OpenSSH V3.4-2 http://www.openssh.com
Putty Rel 0.53b http://www.chiark.greenend.org.uk
Zoc 5.00 http://www.emtec.com
Axessh V2.5 http://www.labf.com

For key generation, OpenSSH client has been verified.

Configuring SSH
Perform the following procedure to set the SSH host key and enable or disable SSH:

1. Click Configure > Management > Services
2. Select the SSH Host Key Status from the drop down menu.

NOTE: SSH Host Key Status can not be changed if SSH status or Secure Management is enabled.
3. To enable/disable SSH, select Enable/Disable from the SSH (Secure Shell) Status drop-down menu.
NOTE: When Secure Management is enabled on the AP, SSH will be enabled by default and cannot be disabled.
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Host keys must either be generated externally and uploaded to the AP (see Uploading Externally Generated Host Keys),
generated manually, or auto-generated at the time of SSH initialization if SSH is enabled and no host keys are present.
There is no key present in an AP that is in a factory default state.

To manually generate or delete host keys on the AP:
CAUTION: SSH Host key creation may take 3 to 4 minutes during which time the AP may not respond.

» Select Create to generate a new pair of host keys.

» Select Delete to remove the host keys from the AP. If no host keys are present, the AP will not allows connections
using SSH. When host keys are created or deleted, the AP updates the fingerprint information displayed on the
Management > Services page.

Uploading Externally Generated Host Keys

Perform the following procedure to upload externally generated host keys to the AP. You must upload both the SSH
public key and SSH private key for SSH to work.

1. Verify that the host keys have been externally generated. The OpenSSH client has been verified to interoperate with
AP’s SSH server.

2. Click Commands > Update AP > via HTTP (or via TFTP).
\ Rgtnieve Filg \ Reboeot 1 Resel 1 Help Lank \
da TFTP i ‘\

This page i3 uvacd 1o update soltware images and confligursbon Bes in the Access
Poant using HTTP file transfer. Click on the browse bution o search for the file or
enter the path in the text bow Select the file type and chell the Update AP bution to
slart the file tranafer,

System Infarmation

SoRw A

Bool Loader Version

Irial g
Confg

SSL Corsbcale
S5L Privateiay
UpgradeBSPBL
(CLI Batch File
SSH Pubbic Key

Figure 4-24 Uploading an Externally Generated SSH Public Key and SSH Private Key

Select SSH Public Key from the File Type drop-down menu.

Click Browse, select the SSH Public Key file on your local machine.
Click Open.

to initiate the file transfer, click the Update AP button.

Select SSH Private Key from the File Type drop-down menu.

Click Browse, select the SSH Private Key on your local machine.

9. Click Open.

10.To initiate the file transfer, click the Update AP button.

® N gk~

The fingerprint of the new SSH public key will be displayed in the Management > Services page.

87



Advanced Configuration AP-4000MR User Guide
Management

Serial Configuration Settings

The serial port interface on the AP is enabled at all times. See Setting IP Address using Serial Port for information on how
to access the CLlI interface via the serial port. You can configure and view the following parameters:

» Serial Baud Rate: Select the serial port speed (bits per second). Choose between 2400, 4800, 9600, 19200, 38400,
or 57600; the default Baud Rate is 9600.
» Serial Flow Control: Select either None (default) or Xon/Xoff (software controlled) data flow control.

NOTE: To avoid potential problems when communicating with the AP through the serial port, Proxim recommends
that you leave the Flow Control setting at None (the default value).

» Serial Data Bits: This is a read-only field and displays the number of data bits used in serial communication (8 data
bits by default).

» Serial Parity: This is a read-only field and displays the number of parity bits used in serial communication (no parity
bits by default).

» Serial Stop Bits: This is a read-only field that displays the number of stop bits used in serial communication (1 stop
bit by default).

NOTE: The serial port bit configuration is commonly referred to as 8N1.

RADIUS Based Management Access

User management of APs can be centralized by using a RADIUS server to store user credentials. The AP cross-checks
credentials using RADIUS protocol and the RADIUS server accepts or rejects the user.

HTTP/HTTPS and Telnet/SSH users can be managed with RADIUS. Serial CLI and SNMP cannot be managed by
RADIUS. Two types of users can be supported using centralized RADIUS management:

» Super User: The super user has access to all functionality of a management interface. A super user is configured in
the RADIUS server by setting the filter ID attribute (returned in the RADIUS Accept packet) for the user to a value of
“super user” (not case sensitive). A user is considered a super user if the value of the filter-id attribute returned in the
RADIUS Accept packet for the user is “super user” (not case sensitive).

» Limited User: A limited user has access to only a limited set of functionality on a management interface. All users
who are not super users are considered limited users. However, a limited user is configured in the RADIUS server by
setting the filter-id attribute (returned in the RADIUS Accept packet) to “limited user” (not case sensitive). Limited
users do not have access to the following configuration capabilities:

— Update/retrieve files to and from APs
— Reset the AP to factory defaults
— Reboot the AP

— Change management properties related to RADIUS, management modes, and management passwords.

NOTE: When a user has both “limited user” and “super user” filter-ids configured in the Radius server, the user has
limited user privileges.

When RADIUS Based Management is enabled, a local user can be configured to provide Telnet, SSH, and HTTP(S)
access to the AP when RADIUS servers fail. The local user has super user capabilities. When secure management is
enabled, the local user can only login using secure means (i.e., SSH or SSL). When the local user option is disabled the
only access to the AP when RADIUS servers are down will be through serial CLI or SNMP.

The Radius Based Management Access parameters allows you to enable HTTP or Telnet Radius Management Access,
to configure a RADIUS Profile for management access control, and to enable or disable local user access, and configure
the local user password. You can configure and view the following parameters:

 HTTP RADIUS Access Control Status: Enable RADIUS management of HTTP/HTTPS users.

* Telnet RADIUS Access Control Status: Enable RADIUS management of Telnet/SSH users.
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* RADIUS Profile for Management Access Control: Specifies the RADIUS Profile to be used for RADIUS Based
Management Access.

* Local User Status: Enables or disables the local user when RADIUS Based Management is enabled. The default
local user ID is root.

» Local User Password and Confirm Password: The default local user password is public. “Root” cannot be
configured as a valid user for Radius based management access when local user access is enabled.

Automatic Configuration (AutoConfig)

The Automatic Configuration feature which allows an AP to be automatically configured by downloading a specific
configuration file from a TFTP server during the boot up process.

Automatic Configuration is disabled by default. The configuration process for Automatic Configuration varies depending
on whether the AP is configured for dynamic or static IP.

When an AP is configured for dynamic IP, the Configuration filename and the TFTP server IP address are contained in
the DHCP response when the AP gets its IP address dynamically from the DHCP server. When configured for static IP,
these parameters are instead configured in the AP interface.

After setting up automatic configuration you must reboot the AP. When the AP reboots it receives the new configuration
information and must reboot one additional time. If Syslog is configured, a Syslog message will appear indicating the
success or failure of the Automatic Configuration.

Auto Configuration and the CLI Batch File

The Auto Configuration feature allows download of the LTV (Length, Type, Value) format configuration file or the CLI
Batch file. The LTV file contains parameters used by the AP; the CLI Batch file contains CLI executable commands used
to set AP parameters. The AP detects whether the uploaded file is LTV format or a CLI Batch file. If the AP detects an
LTV file, it stores the file in the AP’s flash memory. If the AP detects a CLI Batch file (a file with an extension of .cli), the
AP executes the commands contained in the file immediately. The AP will reboot after executing the CLI Batch file. Auto
Configuration will not result in repeated reboots if the CLI Batch file contains rebootable parameters.

For more information, see the CLI Batch File section.

Set up Automatic Configuration for Static IP

Perform the following procedure to enable and set up Automatic Configuration when you have a static IP address for the
TFTP server.

1. Click Configure > Management > AutoConfig. The Automatic Configuration Screen appears.

2. Check Enable Auto Configuration.

3. Enter the Configuration Filename. The default is config.

4. Enter the IP address of the TFTP server in the TFTP Server Address field. The default is 169.254.128.133.
NOTE: The default filename is “config”. The default TFTP IP address is 169.254.128.133.

Click OK to save the changes.

o

6. Reboot the AP. When the AP reboots it receives the new configuration information and must reboot one additional
time. If a Syslog server was configured, the following messages can be observed on the Syslog server:

* AutoConfig for Static IP
* TFTP server address and configuration filename
* AutoConfig Successful
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Figure 4-25 Automatic Configuration Screen

Set up Automatic Configuration for Dynamic IP

Perform the following procedure to enable and set up Automatic Configuration when you have a dynamic IP address for
the TFTP server via DHCP.

The Configuration filename and the TFTP server IP address are contained in the DHCP response when the AP gets its IP
address dynamically from the DHCP server. A Syslog server address is also contained in the DHCP response, allowing
the AP to send Auto Configuration success and failure messages to a Syslog server.

NOTE: The configuration filename and TFTP server IP address are configured only when the AP is configured for Static
IP. If the AP is configured for Dynamic IP these parameters are not used and obtained from DHCP.

1. Click Configure > Management > AutoConfig.
The Automatic Configuration screen appears.

2. Check Enable Auto Configuration.
When the AP is Configured with Dynamic IP, the DHCP server should be configured with the TFTP Server IP address
("Boot Server Host Name", option 66) and Configuration file ("Bootfile name", option 67) as follows (note that this
example uses a Windows 2000 server):

3. Select DHCP Server > DHCP Option > Scope.
The DHCP Options: Scope screen appears.

Scope Options

[ 064 NIS+ Domain Name The name of
[ 065 NIS+ Servers A list of IP ac

[ 067 Boatfile Mame Bootfle Namgy
[ e — e

11.007

Figure 4-26 DHCP Options: Setting the Boot Server Host Name
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4. Add the Boot Server Hostname and Boot Filename parameters to the Available Options list.

5. Set the value of the Boot Server Hostname Parameter to the hostname or IP Address of the TFTP server. For
example: 11.0.0.7.

Scope Dptions

[ 064 MIS+ Domain Mame The name o
[ 065 MIS+ Servers Alist of IP ac
[ 065 Boot Server Host Name TFTP boot 5,

[AP-Confid

Figure 4-27 DHCP Options: Setting the Bootfile Name

6. Set the value of the Bootfile Name parameter to the Configuration filename. For example: AP-Config.
7. If using Syslog, set the Log server IP address (option 7, Log Servers).

8. Reboot the AP. When the AP reboots it receives the new configuration information and must reboot one additional
time. If a Syslog server was configured, the following messages can be observed on the Syslog server:

* AutoConfig for Dynamic IP
* TFTP server address and configuration filename
* AutoConfig Successful

Hardware Configuration Reset (CHRD)
Hardware Configuration Reset Status is a parameter that defines the hardware configuration reset behavior of the AP.

If a user loses or forgets the AP’s HTTP/Telnet/SNMP password, the Reload button on the power injector provides a way
to reset the AP to default configuration values and gain access to the AP. However, in AP deployments where physical
access to the AP is not protected, an unauthorized person could reset the AP to factory defaults and thus gain control of
the AP. The user can disable the hardware configuration reset functionality to prevent unauthorized access.

The hardware configuration reset feature operates as follows:
*  When hardware configuration reset is enabled, the user can press the Reload button on the power injector for 10
seconds when the AP is in normal operational mode in order to delete the AP configuration.

»  When hardware configuration reset is disabled, pressing the Reload button when the AP is in normal operational
mode does not have any effect on the AP.

» The hardware configuration reset parameter does not have any effect on the functionality of the reload button to
delete the AP image during AP boot loader execution.

» The default hardware configuration reset status is enabled. When disabling hardware configuration reset, the user is
recommended to configure a configuration reset password. A configuration reset option appears on the serial port
during boot up, before the AP reads its configuration and initializes.

*  Whenever the AP is reset to factory default configuration, hardware configuration reset status is enabled and the
configuration reset password is set to the default, “public”.

» If secure mode is enabled in the AP, only secure (SSL, SNMPv3, SSH) users can modify the values of the Hardware
Configuration Reset Status and the configuration reset password.
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Configuration Reset via Serial Port During Bootup

If hardware configuration reset is disabled, the user gets prompted by a configuration reset option to reset the AP to
factory defaults during boot up from the serial interface. By pressing a key sequence (ctrl-R), the user gets prompted to
enter a configuration reset password before the configuration is reset.

NOTE: It is important to safely store the configuration reset password. If a user forgets the configuration reset password,
the user will be unable to reset the AP to factory default configuration if the AP becomes inaccessible and the
hardware configuration reset functionality is disable.

Configuring Hardware Configuration Reset

Perform the following procedure to configure Hardware Configuration Reset and to set the Configuration Reset
Password. See Figure 4-28.

1. Click Configure > Management > CHRD.

Status FAccess

y reset the AP to factory
e APis in

forgeis the

configuration Reset function
guration by pressing the hardware

oper wnal mode. This is uselul in gain i
Momnitor HTTPTelnet/SHMP pasaword

nfiguration Resot is disablod, the user shall be prompted for the
word during boot up fo reset the AP fo factory defaults from the
annct be restored to

Commands

J LA

Figure 4-28 Hardware Configuration Reset

N

Check (enable) or uncheck (disable) the Enable Hardware Configuration Reset checkbox.

Change the default Configuration Reset Password in the “Configuration Reset Password” and “Confirm” fields.
Click OK.

5. Reboot the AP.

NOTE: Itis important to safely store the configuration reset password. If a user forgets the configuration reset password,
the user will be unable to reset the AP to factory default configuration if the AP becomes inaccessible and the
hardware configuration reset functionality is disable.

e

Procedure to Reset Configuration via the Serial Interface
1. During boot up, observe the message output on the serial interface.
The AP prompts the user with the message: “Press ctrl-R in 3 seconds to choose configuration reset option.”

2. Enter ctrl-R within 3 seconds after being prompted.

The AP prompts the user with “Press ctrl-Z to continue with normal boot up or enter password to reset configuration.’
If the user enters ctrl-Z, the AP continues to boot with the stored configuration.

3. Enter the configuration reset password. The default configuration reset password is “public”.
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When the correct configuration reset password is entered, the AP gets reset to factory defaults and displays the
message “AP has been reset to Factory Default Settings.” The AP continues to boot up. If an incorrect configuration

reset password is entered, the AP shows an error message and reprompts the user. If the incorrect password is
entered three times in a row, the AP proceeds to boot up.
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Filtering

The Access Point’s Packet Filtering features help control the amount of traffic exchanged between the wired and wireless
networks. There are four sub-tabs under the Filtering heading:

» Ethernet Protocol

« Static MAC

* Advanced

+ TCP/UDP Port

Ethernet Protocol
The Ethernet Protocol Filter blocks or forwards packets based on the Ethernet protocols they support.
Follow these steps to configure the Ethernet Protocol Filter:

1. Select the interface or interfaces that will implement the filter from the Ethernet Protocol Filtering drop-down menu.
* Ethernet: Packets are examined at the Ethernet interface
* Wireless-Slot A or Wireless-Slot B: Packets are examined at the Wireless A or B interfaces
* All Interfaces: Packets are examined at both interfaces
» Disabled: The filter is not used
2. Select the Filter Operation Type.
» |If set to Passthru, only the enabled Ethernet Protocols listed in the Filter Table will pass through the bridge.
» If set to Block, the bridge will block enabled Ethernet Protocols listed in the Filter Table.

Al-si i = P RADIOSIFR eI ANS S LT
Alarms ]\ Bridge \ QoS \ Profiles \l SSIDNLANSacurity
System tetwork Interfaces Managemant 1
Slalus -
L stemac | Advances A TcPuDPPon |
Profocol filters can be used 1o control network traffic. Allowing or dermying canain protocols can reduce
overhead of umwanted traffic on the wireless network. The access point supports a predefined list of
Ethernet protocols, but provides the flexibiity of defining custom Ethermet protocols
Jd omikor
Efh | Fifbaging All Interfaces -E
Camimands Filte n Bz vE
K S ancal
Help el 1.
Exil Ethernet Protocol Filter Table
Reboot Add p . Edi 3
Protocol Humbes Protocol Name
49 Ancile Domain

TiEin

Figure 4-29 Ethernet Protocol Filter Configuration
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3. Configure the Ethernet Protocol Filter Table. This table is pre-populated with existing Ethernet Protocol Filters,
however, you may enter additional filters by specifying the appropriate parameters.

* To add an entry, click Add, and then specify the Protocol Number and a Protocol Name.
— Protocol Number: Enter the protocol number. See http://www.iana.org/assignments/ethernet-numbers for a
list of protocol numbers.
— Protocol Name: Enter related information, typically the protocol name.

. . . ADIISIPX

Alarms \ Bridge \ QoS \ = }_,rljrjl__ = | SSIDVLAN/Security
\ \ files

Syslem Metwork Interfaces Management t 'l_

Status

Manator

Commands.
Heilp
Exit
Reabool

Figure 4-30 Ethernet Protocol Filter Table - Add Entries

» To edit or delete an entry, click Edit and change the information, or select Enable, Disable, or Delete from the
Status drop-down menu.

NOTE: An entry’s status must be enabled in order for the protocol to be subject to the filter.

Ir"" U W ssipnvLaNSecurity

Alarms | Bridge \ QoS )
1 g ! | 1
Systemn Metwork Interfaces KManagement Filt \
Status, &

Advanced Protocol Filter Table - Edit Entries

Protocol Number [s0:18
Maonitar |Apclla Demain
Commands
50:58
Help [appla Ttk 1 ana 2
Exit
s0:.F2
Rabaot [appie Tat ARF 1 and 2
[oB:-a0
gar)q-\.'lln'es

Figure 4-31 Ethernet Protocol Filter Table - Edit Entries

Static MAC

The Static MAC Address filter optimizes the performance of a wireless (and wired) network. When this feature is properly
configured, the AP can block traffic between wired devices and wireless devices based on MAC address.

For example, you can set up a Static MAC filter to prevent wireless clients from communicating with a specific server on
the Ethernet network. You can also use this filter to block unnecessary multicast packets from being forwarded to the
wireless network.
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NOTE: The Static MAC Filter is an advanced feature. You may find it easier to control wireless traffic via other filtering
options, such as Ethernet Protocol Filtering.

) = ) : ) FRADIUSPRT W camnd anmear
Alarms 1 Bridge ||\ QoS 1 Profiles 1|_. SSIDVLANISecurity
System MNetwork Interfaces Management | |
Status —
Ethermet Protocol | 1 Advanced \ TCPUDPPot W

The static MAC filter can be used to optimize the network performance by allowing filtering based on MAC
addresses or groups of MAC addresses on wired and wireless interfaces. Groups of MAC addresses can
be specified by using a bitmask,
Manitar
For Example: if a block of MAC addresses (header consisting of 00:11:22) is to be liltered from wired to
wireless interface, then the following can bé configured:
Commands
Wired MAC Address; 00:71:22:AA:BB:CC
Wired Mask: FF:FF:FF:00:00:00 (This mask filters out all MAC addresses with a header of 00:71:22)
Healp Wirelass MAG Address: 00:00:00:00:00:00 (Enter all zercs since filtering wired MAG addresses)
Wireless Mask: 00:00:00:00:00:00 {Enter all faros for the mask since filtering wired MAC addresses)

Exit
Redoal Add Edt__J)
Wired MAC Wired Wireless MAC Wireless .
Comment Status
Address Mask Address Mask a

Figure 4-32 Static MAC Filter Configuration

Each static MAC entry contains the following fields:

* Wired MAC Address

*  Wired Mask

* Wireless MAC Address

* Wireless Mask

*  Comment: This field is optional.

Each MAC Address or Mask is comprised of 12 hexadecimal digits (0-9, A-F) that correspond to a 48-bit identifier. (Each
hexadecimal digit represents 4 bits (0 or 1).)

Taken together, a MAC Address/Mask pair specifies an address or a range of MAC addresses that the AP will look for
when examining packets. The AP uses Boolean logic to perform an “AND” operation between the MAC Address and the
Mask at the bit level. However, for most users, you do not need to think in terms of bits. It should be sufficient to create a
filter using only the hexadecimal digits 0 and F in the Mask (where 0 is any value and F is the value specified in the MAC
address). A Mask of 00:00:00:00:00:00 corresponds to all MAC addresses, and a Mask of FF:FF:FF:FF:FF:FF applies
only to the specified MAC Address.

For example, if the MAC Address is 00:20:A6:12:54:C3 and the Mask is FF:FF:FF:00:00:00, the AP will examine the
source and destination addresses of each packet looking for any MAC address starting with 00:20:A6. If the Mask is
FF:FF:FF:FF:FF:FF, the AP will only look for the specific MAC address (in this case, 00:20:A6:12:54:C3).

When creating a filter, you can configure the Wired parameters only, the Wireless parameters only, or both sets of
parameters. Which parameters to configure depends upon the traffic that you want block:

» To prevent all traffic from a specific wired MAC address from being forwarded to the wireless network, configure only
the Wired MAC Address and Wired Mask (leave the Wireless MAC Address and Wireless Mask set to all zeros).

« To prevent all traffic from a specific wireless MAC address from being forwarded to the wired network, configure only
the Wireless MAC address and Wireless Mask (leave the Wired MAC Address and Wired Mask set to all zeros).

» To block traffic between a specific wired MAC address and a specific wireless MAC address, configure all four
parameters.
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A maximum of 200 entries can be created in the Static MAC filter table. To create an entry, click Add and enter the
appropriate MAC addresses and Masks to setup a filter. The entry is enabled automatically when saved.

RADIUSFXU

LS sinn
Profiles

Alarms i Bridge | QoS \ | SSIDNVLANISecurity

System Netwark nterfaces Management
Status
Static MAC Address Filter Table - Add Entries
Manitor

Commands

Help Cancel

Exit

Reboot

Figure 4-33 Static MAC Filter Table - Add Entries

To edit an entry, click Edit. To disable or remove an entry, click Edit and change the Status field from Enable to Disable
or Delete.

Static MAC Filter Examples
Consider a network that contains a wired server and three wireless clients. The MAC address for each unit is as follows:

»  Wired Server: 00:40:F4:1C:DB:6A

*  Wireless Client 1: 00:02:2D:51:94:E4
»  Wireless Client 2: 00:02:2D:51:32:12
»  Wireless Client 3: 00:20:A6:12:4E:38

Prevent Two Specific Devices from Communicating
Configure the following settings to prevent the Wired Server and Wireless Client 1 from communicating:

* Wired MAC Address: 00:40:F4:1C:DB:6A

*  Wired Mask: FF:FF:FF:FF:FF:FF

* Wireless MAC Address: 00:02:2D:51:94:E4
* Wireless Mask: FF.FF:FF:FF.:FF:FF

Result: Traffic between the Wired Server and Wireless Client 1 is blocked. Wireless Clients 2 and 3 can still communicate
with the Wired Server.

Prevent Multiple Wireless Devices from Communicating with a Single Wired Device
Configure the following settings to prevent Wireless Clients 1 and 2 from communicating with the Wired Server:

*  Wired MAC Address: 00:40:F4:1C:DB:6A

* Wired Mask: FF:FF:FF:FF:FF:FF

* Wireless MAC Address: 00:02:2D:51:94:E4

*  Wireless Mask: FF:FF:FF:00:00:00

Result: When a logical “AND” is performed on the Wireless MAC Address and Wireless Mask, the result corresponds to
any MAC address beginning with the 00:20:2D prefix. Since Wireless Client 1 and Wireless Client 2 share the same

prefix (00:02:2D), traffic between the Wired Server and Wireless Clients 1 and 2 is blocked. Wireless Client 3 can still
communicate with the Wired Server since it has a different prefix (00:20:A6).
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Prevent All Wireless Devices from Communicating with a Single Wired Device
Configure the following settings to prevent all three Wireless Clients from communicating with Wired Server 1:

* Wired MAC Address: 00:40:F4:1C:DB:6A
*  Wired Mask: FF:FF:FF:FF:FF:FF

* Wireless MAC Address: 00:00:00:00:00:00
* Wireless Mask: 00:00:00:00:00:00

Result: The Access Point blocks all traffic between Wired Server 1 and all wireless clients.

Prevent a Wireless Device from Communicating with the Wired Network
Configure the following settings to prevent Wireless Client 3 from communicating with any device on the Ethernet:

*  Wired MAC Address: 00:00:00:00:00:00

*  Wired Mask: 00:00:00:00:00:00

* Wireless MAC Address: 00:20:A6:12:4E:38
* Wireless Mask: FF.FF.:FF:FF.:FF:FF

Result: The Access Point blocks all traffic between Wireless Client 3 and the Ethernet network.

Prevent Messages Destined for a Specific Multicast Group from Being Forwarded to the Wireless LAN

If there are devices on your Ethernet network that use multicast packets to communicate and these packets are not
required by your wireless clients, you can set up a Static MAC filter to preserve wireless bandwidth. For example, if
routers on your network use a specific multicast address (such as 01:00:5E:00:32:4B) to exchange information, you can
set up a filter to prevent these multicast packets from being forwarded to the wireless network:

*  Wired MAC Address: 01:00:5E:00:32:4B

»  Wired Mask: FF:FF:FF:FF:FF:FF

*  Wireless MAC Address: 00:00:00:00:00:00

*  Wireless Mask: 00:00:00:00:00:00

Result: The Access Point does not forward any packets that have a destination address of 01:00:5E:00:32:4B to the
wireless network.

Advanced
You can configure the following advanced filtering options:

* Enable Proxy ARP: Place a check mark in the box provided to allow the Access Point to respond to Address
Resolution Protocol (ARP) requests for wireless clients. When enabled, the AP answers ARP requests for wireless
stations without actually forwarding them to the wireless network. If disabled, the Access Point will bridge ARP
requests for wireless clients to the wireless LAN.

* Enable IP/ARP Filtering: Place a check mark in the box provided to allow IP/ARP filtering based on the IP/ARP
Filtering Address and IP Mask. Leave the box unchecked to prevent filtering. If enabled, you should also configure the
IP/ARP Filtering Address and IP/ARP IP Mask.

— IP/ARP Filtering Address: Enter the Network filtering IP Address.
— IP/ARP IP Mask: Enter the Network Mask IP Address.
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Figure 4-34 Advanced Filter Configuration

The following protocols are listed in the Advanced Filter Table:

* Deny IPXRIP

* Deny IPX SAP

* Deny IPXLSP

* Deny IP Broadcasts
* Deny IP Multicasts

The AP can filter these protocols in the wireless-to-Ethernet direction, the Ethernet-to-wireless direction, or in both

directions. Click Edit and use the Status field to Enable or Disable the filter.
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Figure 4-35 Static MAC Filter Table - Edit Entries

TCP/UDP Port

Port-based filtering enables you to control wireless user access to network services by selectively blocking TCP/UDP
protocols through the AP. A user specifies a Protocol Name, Port Number, Port Type (TCP, UDP, or TCP/UDP), and
filtering interfaces (Wireless radio A or B only, Ethernet only, a combination of Wireless radio A or B and Ethernet, or all
interfaces) in order to block access to services, such as Telnet and FTP, and traffic, such as NETBIOS and HTTP.

For example, an AP with the following configuration would discard frames received on its Ethernet interface with a UDP
destination port number of 137, effectively blocking NETBIOS Name Service packets.

Protocol Type Destination Port Protocol Name Interface Status (Enable/Disable)
(TCP/UDP) Number
UDP 137 NETBIOS Name Ethernet Enable
Service

Adding TCP/UDP Port Filters
1. Place a check mark in the box labeled Enable TCP/UDP Port Filtering.
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Enable TCP/UDP Port Filtering |
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Protocol Hame Port Humber Port Type Interface Status
TCPMUDP All Interfaces Disable
138 TCPAUDP All Interfaces Disable
139 TCPUDP All Interfaces Disable
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IPSECASAKMP SO0 All Interfaces
L2TP 1701 All Interfaces
PETP 1723 TCPUIDP All Interfaces

Figure 4-36 TCP/UDP Port Filter Configuration

2. Click Add under the TCP/UDP Port Filter Table heading.
3. Inthe TCP/UDP Port Filter Table, enter the Protocol Names to filter.

4. Set the destination Port Number (a value between 1 and 65535) to filter. See the IANA Web site at
http://www.iana.org/assignments/port-numbers for a list of assigned port numbers and their descriptions.

5. Set the Port Type for the protocol: TCP, UDP, or both (TCP/UDP).
6. Set the Interface to filter:

* Ethernet

*  Wireless Slot A

» Ethernet and Wireless Slot A

*  Wireless Slot B

» Ethernet and Wireless Slot B

*  Wireless Slot Aand B

* Allinterfaces
7. Click OK.
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Figure 4-37 TCP/UDP Port Filter Table - Add Entries

Editing TCP/UDP Port Filters

1. Click Edit under the TCP/UDP Port Filter Table heading.
2. Make any changes to the Protocol Name or Port Number for a specific entry, if necessary.

4. Select OK.
Alarms \ Bridge \ QoS
System Mehtwork Interfaces
Status
TCP/UDP Port Filter Table - Edit Entries
Protocol Name
Moatior Port Number
Pont Type
Commands Interface
Siatus
Help
Protocal Name
Exit Port Number
' Port Type
Interface
Reboot 3
Status

Figure 4-38 TCP/UDP Port Filter Table - Edit Entries
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In the row that defines the port, set the Status to Enable, Disable, or Delete, as appropriate.
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The Alarms tab has the following sub-tabs:

*  Groups

* Alarm Host Table
* Syslog

* Rogue Scan

Groups

Alarm groups can be enabled or disabled via the Web interface. Place a check mark in the box provided to enable a
specific group. Remove the check mark from the box to disable the alarms. Alarm severity levels are as follows:

« Critical alarms will often result in severe disruption in network activity or an automatic reboot of the AP.

* Major alarms are usually activated due to a breach in the security of the system. Clients cannot be authenticated
because an attempt at unauthorized access into the AP has been detected.

* Informational alarms provide the network administrator with some general information about the activities the AP is

performing.

Configuration Trap Group

Trap Name Description Severity Level
oriTrapDNSIPNotConfigured DNS IP address not configured Major
oriTrapRADIUSAuthenticationNotConfigured RADIUS Authentication not configured Maijor
oriTrapRADIUSAccountingNotConfigured RADIUS Accounting not configured Major
oriTrapDuplicatelPAddressEncountered Another network device with the same IP address | Major

exists
oriTrapDHCPRelayServerTableNotConfigured | The DHCP relay agent server table is empty or Major
not configured
oriTrapVLANIDInvalidConfiguration A VLAN ID configuration is invalid Maijor
oriTrapAutoConfigFailure Auto configuration failed Minor
oriTrapBatchExecFailure The CLI Batch execution fails for the following Minor
reasons:
+ lllegal Command is parsed in the CLI Batch
file
« Execution error is encountered while
executing CLI Batch file
» Bigger file size than 100 Kbytes
oriTrapBatchFileExecStart The CLI Batch execution begins after file is Minor
uploaded
oriTrapBatchFileExecEnd The execution of CLI Batch file ends. Minor

Security Trap Group

Trap Name

Description

Severity Level

oriTraplnvalidEncryptionKey

Invalid encryption key has been detected.

Critical
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Trap Name

Description

Severity Level

oriTrapAuthenticationFailure

Client authentication failure has occurred.
Authentication failures can range from:

« MAC Access Control table
* RADIUS MAC authentication

« 802.1x authentication specifying the
EAP-Type
+  WORP mutual authentication

« SSID authorization failure specifying the
SSID

* VLAN ID authorization failure specifying the
VLAN ID

Major

oriTrapUnauthorizedManagerDetected

Unauthorized manager has attempted to view
and/or modify parameters

Major

oriTrapRADScanComplete

RAD scan is successfully completed

Informational

oriTrapRADScanResults

Provides information on the RAD Scan results

Informational

oriTrapRogueScanStationDetected

Rogue station detected

Informational

oriTrapRogueScanCycleComplete

Rogue scan successfully completed

Informational

Wireless Interface/Card Trap Group

Trap Name Description Severity Level
oriTrapWLCFailure General failure wireless interface/card failure. Critical
oriTrapWLCRadarInterferenceDetected Radar interference detected on the channel being | Major

used by the wireless interface
MIC Attack Detected Supported in Web interface only Maijor
MIC Attack Report Detected Supported in Web interface only Major

Operational Trap Group

Trap Name Description Severity Level
oriTrapUnrecoverableSoftwareErrorDetected Unrecoverable software error detected. Causes | Critical
software watch dog timer to expire, which in turn
causes the device to reboot.
oriTrapRADIUSServerNotResponding RADIUS server not responding to authentication | Major
requests sent from the RADIUS client in the
device
oriTrapModuleNotlInitialized Module (hardware or software) not initialized Maijor
oriTrapDeviceRebooting Device rebooting Informational
oriTrapTaskSuspended Task suspended Critical
oriTrapBootPFailed Response to the BootP request not received; Major

device not dynamically assigned an IP address
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Trap Name

Description

Severity Level

oriTrapDHCPFailed

Response to the DHCP client request not
received; device not dynamically assigned an IP
address

Major

oriTrapDNSClientLookupFailure

DNS client attempts to resolve a specified
hostname (DNS lookup) and a failure occurs
because either the DNS server is unreachable or
there is an error for the hostname lookup. Trap
specifies the hostname that was being resolved.

Major

oriTrapSSLlInitializationFailure

SSL initialization failure

Major

oriTrapWirelessServiceShutdown

Wireless interface has shutdown services for
wireless clients

Informational

oriTrapWirelessServiceResumed

Wireless interface has resumed service and is
ready for wireless client connections

Informational

oriTrapSSHInitializationStatus

SSH initialization status

Major

oriTrapVLANIDUserAssignment

User is assigned a VLAN ID from the RADIUS
server

Informational

oriTrapDHCPLeaseRenewal

AP requests DHCP renewal and receives new
information from the DHCP server. Information
includes the DHCP server IP address that replied
to the DHCP client request, and the IP address,
subnet mask, and gateway IP address returned
from the DHCP server.

Informational

oriTrapTemperatureAlert

Temperature is above or below acceptable
operating margin.

Temperature is within 5°C of upper or lower limit.

Critical

Major

Flash Memory Trap Group

dConfiguration

be corrupted, and the device loads the last known
good configuration file

Trap Name Description Severity Level
oriTrapFlashMemoryEmpty No data present in flash memory Informational
Flash Memory Corrupted Flash memory corrupted Critical
oriTrapFlashMemoryRestoringLastknownGoo | Current/original configuration data file is found to | Informational

TFTP Trap Group

Trap Name Description Severity Level
oriTrapTFTPFailedOperation TFTP operation failed Major
oriTrapTFTPOperationlnitiated TFTP operation Initiated Informational
oriTrapTFTPOperationCompleted TFTP operation completed Informational

Image Trap Group

Trap Name

Description

Severity Level

oriTrapZeroSizelmage

Zero size image loaded onto device

Major
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device

Trap Name Description Severity Level
oriTraplnvalidimage Invalid image loaded onto device Major
oriTraplmageToolLarge Image loaded on the device exceeds the size Major

limitation of flash
oriTraplncompatiblelmage Incompatible image loaded onto device Major
oriTraplnvalidimageDigitalSignature Image with invalid digital signature is loaded onto | Major

SNTP Trap Group
Trap Name Description Severity Level
oriTrapSNTPFailure SNTP time retrieval failure Minor
oriTrapSNTPFailure SNTP sync-up failure Minor

Generic Trap Group

Trap Name

Description

Severity Level

oriTrapGenericNotification (see following table)

Generic SNMP Trap

Variable

A generic SNMP trap may be sent for any of the following reasons:

Trap Name Description Severity Level

Mesh Connection Failure Connection failure reason Major

Link Integrity Failure Target IP address of down link Major
Topology Change Ethernet MAC address of Mesh AP causing Informational

change; Mesh SSID

PXU Discovery Failure PXU IP Address Major

PXU Security Level Negotiation Failure PXU IP Address Maijor

PXU Security Level Negotiation Shared Secret | PXU IP Address Major
Failure

PXU Key Negotiation Failure PXU IP Address Major

PXU Registration Successful PXU IP Address Informational
PXU Registration Failure PXU IP Address Maijor

PXU Keep-alive Failure PXU IP Address Major

System Feature/License Group

Trap Name Description Severity Level
oriTraplncompatibleLicenseFile Incompatible license file Maijor
oriTraplnvalidLicenseFile Invalid license file Major

In addition, the AP supports these standard traps, which are always enabled:
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RFC 1215-Trap

Trap Name Description Severity Level
coldStart AP is on or rebooted Informational
linkUp AP's Ethernet interface link is up (working) Informational
linkDown AP's Ethernet interface link is down (not working) | Informational

Bridge MIB (RFC 1493) Alarms

same transition

Trap Name Description Severity Level
New Root AP has become the new root in the Spanning Informational
Tree network
topologyChange Trap is not sent if a newRoot trap is sent for the | Informational

All these alarm groups correspond to System Alarms that are displayed in the System Status Screen, including the traps
that are sent by the AP to the SNMP managers specified in the Alarm Host Table.

Alarm Host Table

To add an entry and enable the AP to send SNMP trap messages to a Trap Host, click Add, and then specify the IP

Address and Password for the Trap Host.

NOTE: Up to 10 entries are possible in the Alarm Host table.

* |IP Address: Enter the Trap Host IP Address.

» Password: Enter the password in the Password field and the Confirm field.
+ Comment: Enter an optional comment, such as the alarm (trap) host station name.

To edit or delete an entry, click Edit. Edit the information, or select Enable, Disable, or Delete from the Status

drop-down menu.

107




Advanced Configuration AP-4000MR User Guide
Alarms

Syslog

The Syslog messaging system enables the AP to transmit event messages to a central server for monitoring and
troubleshooting. The access point logs “Session Start (Log-in)” and “Session Stop (Log-out)” events for each wireless
client as an alternative to RADIUS accounting.

See RFC 3164 at http://www.rfc-editor.org for more information on the Syslog standard.

System 1 Mebarork | nterfaces \ Management | Fillering
\ Bridge 1 QoS \ \ ssiovLanSecurity )
Statu
Groups alanm Host Table | Rogue Scan i
rh:E tab is used to configure hosts or servers on the network that will receive syslog messages from

the access point

Konitor

Commands

Help

[

xit
Rebool
IP Adkdress Comment Status
254 128134 Enabla
Figure 4-39 Syslog Configuration Screen

Setting Syslog Event Notifications

Syslog Events are logged according to the level of detail specified by the administrator. Logging only urgent system
messages will create a far smaller, more easily read log than a log of every event the system encounters. Determine
which events to log by selecting a priority defined by the following scale:

Event Priority Description
LOG_EMERG |0 System is unusable
LOG_ALERT 1 Action must be taken immediately
LOG_CRIT 2 Critical conditions
LOG_ERR 3 Error conditions
LOG_WARNING |4 Warning conditions
LOG _NOTICE |5 Normal but significant condition
LOG_INFO 6 Informational
LOG DEBUG |7 Debug-level messages

Configuring Syslog Event Notifications
You can configure the following Syslog settings from the HTTP interface:

» Enable Syslog: Place a check mark in the box provided to enable system logging.
« Syslog Port Number: This field is read-only and displays the port number (514) assigned for system logging.
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» Syslog Lowest Priority Logged: The AP will send event messages to the Syslog server that correspond to the
selected priority number and any priority numbers below it. For example, if set to 6, the AP will transmit event
messages labeled priority 1 to 6 to the Syslog server. This parameter supports a range between 1 and 7; 6 is the
default.

» Syslog Heartbeat Status: When Heartbeat is enabled, the AP periodically sends a message to the Syslog server to
indicate that it is active.

» Syslog Heartbeat Interval: If Syslog Heartbeat Status is enabled this field provides the interval for the heartbeat in
seconds (between 1 and 604800). The default is 900 seconds.

» Syslog Host Table: This table specifies the IP addresses of a network servers that the AP will send Syslog
messages to. Click Add to create a new entry. Click Edit to change an existing entry. Each entry contains the
following field:

— IP Address: Enter the IP Address for the management host.
— Comment: Enter an optional comment such as the host name.

— Status: The entry is enabled automatically when saved (so the Status field is only visible when editing an entry).
You can also disable or delete entries by changing this field’s value.

Syslog Messages

The following messages are supported in the AP:

Syslog Message Name Priority Severity Description

Auto Configuration using DHCP |6 Informational | Configuration filename and TFTP server address
are obtained from DHCP when dynamic IP is
configured on the device.

Auto Configuration using Static IP | 6 Informational | Configured TFTP server address and configuration
filename is used when Static IP is configured on
the device.

TFTP Server IP and configuration | 4 Minor Configuration filename and/or TFTP server

filename not present in DHCP address is not present in the DHCP response when

response using DHCP.

TFTP Server IP Address used in | 6 Informational | TFTP server IP address used for AutoConfig.

AutoConfig feature

TFTP Server filename used in 6 Informational | TFTP filename used for AutoConfig.

AutoConfig feature

Auto Configuration TFTP 4 Minor TFTP download of a configuration file for

Download Failure AutoConfig fails for the following reasons:

* Incorrect or non-reachable TFTP server
address

» Incorrect or unavailable configuration
filename

e TFTP transfer timeout.

Image Compatibility Check, 2 Maijor One of the following failures occurs:
Invalid Image « Invalid Signature

» Zero File Size

» Large File

*  Non VxWork Image
* Incompatible Image

AP Heartbeat Status 5 Informational | AP syslog keep alive message.
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Syslog Message Name Priority Severity Description
Client Login Authentication 6 Informational | Client logs in/authenticates. Message includes:
Status « Client MAC Address
» Authentication Type = None, ACL, RADIUS
MAC, 802.1X
» Cipher Type = None, WEP, TKIP, AES
» Status = Allow, Deny
» SSID to which client is connecting
Sample Message:
<client mac address> | Status = <value> | SSID =
<value> | Auth Type = <value> | Cipher Type =
<value>
Client De-Authentication Status | 6 Informational | Client de-authenticates. Message includes:
+ Client MAC Address
» Cipher Type = None, WEP, TKIP, AES
» Status = De-authentication reason, which
can be any of the following:
— Unknown reason
— Stale authentication information
— Authenticated STA leaving BSS
— Inactivity
— Association error
— Class 2 frame received from
non-authenticated STA
— Class 3 frame received from
non-associated STA
— Associated STA leaving BSS
— STA requesting information, but not yet
authenticated
— Enhanced security (RSN) required
— Enhanced security (RSN) used
inconsistently
— Invalid Information Element
— MIC Failure
—  WPA module de-auth
» SSID to which client was connected
Sample Message:
<client mac address> | Status = <value> | SSID =
<value> | Cipher Type = <value>
RADIUS Accounting Start and 6 Informational | Start and Stop accounting messages for wireless
Stop Messages clients.
CLI Configuration File Start 6 Informational | CLI configuration file execution starts.
Execution
CLI Configuration File End 6 Informational | CLI configuration file execution ends.
Execution
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Syslog Message Name Priority Severity Description

CLI Configuration File Execution |4 Minor There is an error in execution of the CLI

Errors configuration file. The message specifies the
filename, line number, and error reason.

SSH Initialization Failure 3 Major One of the following failures occurs:

Keys not present
Keys cannot be generated
Internal error (no available resources)

SSH Key Generation Successful |6 Informational | SSH Key generation is successful.

Wireless Service Shutdown 6 Informational | Wireless service is shutdown.

Wireless Service Resume 6 Informational | Wireless service resumes.

MIC Attack Occurred 4 Minor MIC attack occurred; wireless interface is shut
down for 60 seconds

MIC Attack from Wireless Station | 4 Minor A MIC attack is detected from a wireless station.

SNTP Time Retrieval Failure 4 Minor SNTP Client in the AP fails to retrieve time
information from the configured SNTP servers.
Also included in message: IP Address of SNTP
server.

SNTP Time Sync-Up Failure 4 Minor SNTP Client in the AP fails to synchronize the time
with the SNTP server it was communicating with.
Also included in message: IP Address of SNTP
server.

Incompatible license file 3 Major Incompatible license file is stored in flash memory
during initialization or license file download. Also
included in message: incompatibility reason.

Invalid license file 3 Maijor Invalid license file is stored in flash memory during
initialization or license file download. The license
file is found to be invalid if the signed checksum
verification fails.

Mesh Connection Failure 3 Major AP fails to connect with an uplink Mesh AP or
Mesh portal. Also included in message: uplink
Mesh portal/AP MAC address, Mesh SSID, and
reason for connection failure.

Link Integrity Failure 3 Maijor Link integrity feature determines that link integrity
target is down. Also included in message: Link
Integrity target IP address.

Topology Change 6 Informational | Mesh AP changes its uplink Mesh connection. Also
included in message: uplink Mesh AP/portal MAC
address and Mesh SSID.

PXU Discovery Failure 3 Maijor Unable to discover PXU at the specified IP address

PXU Security Level Negotiation |3 Major Response to the discovery request from PXU is not

Failure received. Message also includes PXU IP address.

PXU Security Level Negotiation |3 Major Security level negotiation response from PXU

Shared Secret Failure indicates failure. Message also includes PXU IP
address.

PXU Key Negotiation Failure 3 Major Key negotiation with PXU failed. Message also

includes PXU IP address.
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Syslog Message Name Priority Severity Description

PXU Registration Successful 6 Informational | AP successfully registers with the PXU. Message
also includes PXU IP address.

PXU Registration Failure 3 Major AP fails to register with the PXU. Message also
includes PXU IP address.

PXU Keep-alive Failure 3 Major AP does not receive a Keep-alive response from
the PXU. Message also includes PXU IP address.

PXU Profile Disabled 6 Informational | CMOB is enabled, PXU Profile is disabled

Rogue Scan

The Rogue Scan feature provides an additional security level for wireless LAN deployments. Rogue Scan uses the
selected wireless interface(s) for scanning its coverage area for Access Points and clients.

A centralized Network Manager receives MAC address information from the AP on all wireless clients detected by the
AP. The Network Manager then queries all wired switches to find out the inbound switch/port of these wireless clients. If
the switch/port does not have a valid Access Point connected to it as per a pre-configured database, the Network
Manager proceeds to block that switch/port and prevent the Rogue AP from connecting to the wired network.

e &
Trusted AP Rogue AP
1] 7
L L] [
R = £
Client 1 Client 2

Figure 4-40 Preventing Rogue AP Attacks

The figure above shows Client 1 connected to a Trusted AP and Client 2 connected to a Rogue AP. The Trusted AP
scans the networks, detects Client 2, and notifies the Network Manager. The Network Manager uses SNMP/CLI to query
the wired switch to find the inbound switch port of Client 2’s packets. The Network Manager verifies that this switch/router
and port does not have a valid Access Point as per the administrator’s database. Thus it labels Client 2's AP as a Rogue
AP and proceeds to prevent the Rogue AP attack by blocking this switch’s port.

APs can be detected either by active scanning using 802.11 probe request frames or passively by detecting periodic
beacons, or both. Wireless clients are detected by monitoring 802.11 connection establishment messages such as
association/authentication messages or data traffic to or from the wireless clients.

There are two scanning modes available per wireless interface: continuous scanning mode and background scanning
mode.

Continuous Scanning Mode

The continuous scanning mode is a dedicated scanning mode where the wireless interface performs scanning alone and
does not perform the normal AP operation of servicing client traffic.

In continuous scanning mode the AP scans each channel for a channel scan time of one second and then moves to the
next channel in the scan channel list. With a channel scan time of one second, the scan cycle time will take less than a
minute (one second per channel). Once the entire scan channel list has been scanned the AP restarts scanning from the
beginning of the scan channel list.
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Background Scanning Mode

In background scanning mode the AP performs background scanning while performing normal AP operations on the
wireless interface.

You can configure the scan cycle time between 1-1440 minutes (24 hours). The scan cycle time indicates how
frequently a channel is sampled and defines the minimum attack period that can go unnoticed.

In background scanning mode the AP will scan one channel then wait for a time known as channel scan time. The
channel scan time affects the amount of data collected during scanning and defines the maximum number of samples
(possible detections) in one scan. This is increased to improve scanning efficiency; the tradeoff is that it decreases
throughput. The optimum value for this parameter during background scanning mode is 20ms.The channel scan time is
calculated from the scan cycle time parameter and the number of channels in the scan channel list as follows:

intra-channel scan time = (scan cycle time - (channel scan time * number of channels in the scan list))/number of
channels in the scan list.

NOTE: If the AP is configured as a Mesh AP, the background scanning interval will be the same as the Mesh scanning
interval (20 ms if there is no uplink, or 180 ms if there is an uplink).

NOTE: In Background Scanning mode, the Mesh AP may not immediately detect all APs entering the network. To
ensure immediate detection of all APs entering the network, select Continuous Scanning mode.

Rogue Scan Data Collection

The AP stores information gathered about detected stations during scanning in a Rogue Scan result table. The Rogue
Scan result table can store a maximum of 2000 entries. When the table fills, the oldest entry gets overwritten. The Rogue
Scan result table lists the following information about each detected station:
« Station Type: indicates one of the following types of station:
Unknown station
AP station
Infrastructure Client Station
IBSS Client Station
*  MAC Address of the detected station
* Channel: the working channel of the detected station
* SNR: the SNR value of the last frame from the station as received by the AP
» BSSID: the BSSID field stores the:
— MAC address of the associated Access Point in the case of a client.
— Zero MAC address or MAC address of the partner Access Point if the AP is a partner of a WDS link

The AP ages out older entries in the Rogue Scan result table if a detected station is inactive for more than the Scan
Result Table Ageing Time.

Rogue Scan

Perform this procedure to enable Rogue Scan on a particular interface or interfaces and define the Scan Interval and
Scan Interface. See Figure 4-41.

The Rogue Scan screen also displays the number of new access points and clients detected in the last scan on each
wireless interface.

1. Enable the Security Alarm Group. Select the Security Alarm Group link from the Rogue Scan screen. Configure a
Trap Host to receive the list of access points (and clients) detected during the scan.

2. Click Configure > Alarms > Rogue Scan.

3. Enable Rogue Scan on the wireless interface by checking Enable Rogue Scan.
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NOTE: Rogue Scan cannot be enabled on a wireless interface when the Wireless Service Status on that interface is
shutdown. First, resume service on the wireless interface.

NOTE: Enabling Rogue Scan simultaneously with Broadcast Unique Beacon will cause a drift in the beacon interval
and the occasional missing of beacons.

4. Enter the Scan Mode. Select Background Scanning or Continuous Scanning. In Continuous Scanning mode the AP
stops normal operation and scans continuously on that interface. In Background Scanning mode, the AP performs
background scanning while doing normal AP operation on that interface.

5. If the Scan Mode is Background Scanning, then enter the Scan Interval.

* The Scan Interval specifies the time period in minutes between scans in Background Scanning mode and can be
set to any value between 1 and 1440 minutes.

6. Configure the Scan Result Table Ageing Time. The AP ages out older entries in the Rogue Scan result table if a
detected station is inactive for more than this time. The valid range is from 60-7200 minutes, the default is 60 minutes.

7. Configure the Scan Results Trap Notification Mode to control the notification behavior when APs or stations are
detected in a scan:

* No Notification

* Notify AP

* Notify Client

* Notify All (Notify both AP and Client detection)

8. Configure the Scan Results Trap Report Style to control the way detected stations are reported in the notification:

* Report all detected stations since last scan (default)
* Report all detected stations since start of scan
9. Configure the second wireless interface, if required.
10.Click OK.

The results of the Rogue Scan can be viewed in the Status page in the HTTP interface.
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Profiles. FAONAEIAUN

Groups | MamHostTable | Syslog [ RogueScan I

Rogue Scan uses the selected wireless interface for scanning its coverage area for
Access Points and Clients. To dedicate the AP's wireless interface to scanning set the
scan mode to continuous scan. Note that while the wireless interface is in continuous
scan mode it does not perform normal AP operations. To enable the AP's wireiess
interface to scan in the background vwhile still performing normal AP operations, set the
scan cycle time in minutes and set the scan mode 1o background scanning mode. Note
that AP throughput decreases with an increase in scanning efficiency.

Note!: Whaen Rogue Scan is enabled, the Security Alarm Group must also be enabled snd 8
Trap Host configured to recelve the list of access points and cifents detected during the

Note2: The scan parameter scan interval time can only be modified for background
scanning mode.
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Figure 4-41 Rogue Scan Screen
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Bridge
The AP is a bridge between your wired and wireless networking devices. As a bridge, the functions performed by the AP
include:
* MAC address learning
» Forward and filtering decision making
» Spanning Tree protocol used for loop avoidance
Once the AP is connected to your network, it learns which devices are connected to it and records their MAC addresses

in the Learn Table. The table can hold up to 10,000 entries. To view the Learn Table, click on the Monitor button in the
web interface and select the Learn Table tab.

The Bridge tab has four sub-tabs:
e Spanning Tree

* Intra BSS

* Packet Forwarding

Spanning Tree

A Spanning Tree is used to avoid redundant communication loops in networks with multiple bridging devices. Bridges do
not have any inherent mechanism to avoid loops, because having redundant systems is a necessity in certain networks.
However, redundant systems can cause Broadcast Storms, multiple frame copies, and MAC address table instability
problems.

Complex network structures can create multiple loops within a network. The Spanning Tree configuration blocks certain
ports on AP devices to control the path of communication within the network, avoiding loops and following a spanning
tree structure.

For more information on Spanning Tree protocol, please see Section 8.0 of the IEEE 802.1d standard. The Spanning
Tree configuration options are advanced settings. Proxim recommends that you leave these parameters at their default
values unless you are familiar with the Spanning Tree protocol.

NOTE: Spanning Tree protocol does not run on Mesh ports.

NOTE: Spanning Tree protocol is disabled by default. When WDS is enabled, Spanning Tree protocol is automatically
enabled. It may be manually disabled. If Spanning Tree protocol is enabled by WDS and WDS is subsequently
disabled, Spanning tree will remain enabled until it is manually disabled.
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Figure 4-42 Spanning Tree Sub-Tab

Storm Threshold
Storm Threshold is an advanced Bridge setup option that you can use to protect the network against data overload by:

« Specifying a maximum number of frames per second as received from a single network device (identified by its MAC
address).
» Specifying an absolute maximum number of messages per interface.

The Storm Threshold parameters allow you to specify a set of thresholds for each interface of the AP, identifying
separate values for the number of broadcast messages/second and Multicast messages/second.

When the number of frames for an interface or from a single network device exceeds the maximum value per second, the
AP will ignore all subsequent messages in that second received on that interface or from that network device.

* Address Threshold: Enter the maximum allowed number of packets per second.

* Ethernet Threshold: Enter the maximum allowed number of packets per second.

* Wireless Threshold: Enter the maximum allowed number of packets per second.
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Intra BSS

The wireless clients (or subscribers) that associate with a certain AP form the Basic Service Set (BSS) of a network
infrastructure. By default, wireless subscribers in the same BSS can communicate with each other. However, some
administrators (such as wireless public spaces) may wish to block traffic between wireless subscribers that are
associated with the same AP to prevent unauthorized communication and to conserve bandwidth. This feature enables
you to prevent wireless subscribers within a BSS from exchanging traffic.

Although this feature is generally enabled in public access environments, Enterprise LAN administrators use it to
conserve wireless bandwidth by limiting communication between wireless clients. For example, this feature prevents
peer-to-peer file sharing or gaming over the wireless network.

To block Intra BSS traffic, set Intra BSS Traffic Operation to Block.
To allow Intra BSS traffic, set Intra BSS Traffic Operation to Passthru.

Packet Forwarding

The Packet Forwarding feature enables you to redirect traffic generated by wireless clients that are all associated to the
same AP to a single MAC address. This filters wireless traffic without burdening the AP and provides additional security
by limiting potential destinations or by routing the traffic directly to a firewall. You can redirect to a specific port (Ethernet
or WDS) or allow the bridge’s learning process (and the forwarding table entry for the selected MAC address) to
determine the optimal port.

NOTE: The gateway to which traffic will be redirected should be node on the Ethernet network. It should not be a
wireless client.

Configuring Interfaces for Packet Forwarding

Configure your AP to forward packets by specifying port(s) to which packets are redirected and a destination MAC
address.
1. Within the Packet Forwarding Configuration screen, check the box labeled Enable Packet Forwarding.

2. Specify a destination Packet Forwarding MAC Address. The AP will redirect all unicast, multicast, and broadcast
packets received from wireless clients to the address you specify.

3. Select a Packet Forwarding Interface Port from the drop-down menu. You can redirect traffic to:
— Ethernet
— A WDS connection (see Wireless Distribution System (WDS) for details)
— Any (traffic is redirected to a port based on the bridge learning process)

4. Click OK to save your changes.
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QoS

Wi-Fi Multimedia (WMM)/Quality of Service (QoS) Introduction

The AP supports Wi-Fi Multimedia (WMM), which is a solution for QoS functionality based on the IEEE 802.11e
specification. WMM defines enhancements to the MAC for wireless LAN applications with Quality of Service
requirements, which include transport of voice traffic over IEEE 802.11 wireless LANs.

The enhancement are in the form of changes in protocol frame formats (addition of new fields and information elements),

addition of new messages, definition of new protocol actions, channel access mechanisms (differentiated control of
access to medium) and network elements (QoS/WME aware APs, STAs), and configuration management.

WME supports Enhanced Distributed Channel Access (EDCA) for prioritized QoS services. The WME/QoS feature can
be enabled or disabled per wireless interface. For more information on QoS, see “Technical Bulletin 69504 Revision 2” at
<http://keygen.proxim.com/support/orinoco/tb/tb69504 3wmm.pdf>.

Policy

Perform the following procedure to enable QoS and add QoS policies:

1. Click Configure > QoS > Policy.

Status

Monitor

Commands.

Help

Exit

Reboot
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This page is used to enable or disable the Quality of Service (QoS5) feature and to configure QoS
policies for each wireless interface. There are 5 possible Qo3 policy types to configure - inbound
Layer 2, outbound Layer 2, inbound Layer J, outbound Layer 3, and Spectralink. When a QoS policy
is added, an entry for each QoS policy type is created with default values. You can then modify the
default values for each QoS Policy type, if desired, and enable the QoS policy type. Depending on the
policy type, a policy mapping index should be specified. For Layer 2 policies, an index from the
&02.1p to 802,10 mapping table should be specified. For Layer I policies, an index from the 802.1p to
IP DSCP mapping table should be specified. No mapping index is required for SpectraLink policy
types. QoS marking are also supported and can be configured per policy type; QoS marking can be
enabled or disabled.

The 551D table is used to apply Qo5 Policies configured in the Policy Table. Go to the
SSIDVLAN Security page and there you can specify the QoS Policy to be applied per 5510 based on
the pol iy index number

Note: Like with adding a QoS Policy, when a QoS policy is deleted, all § QoS policy types are
defefed. If you do not wish to have all § policy types per policy do not delete them, simply disable the
ones that are not desired.

Note: Changes fo these paramelers require access point reboot in order o take effect.

Wireless A

Enable Quality of Senvice r

dum Thrashold (50-90 50

QoS Maximum M

Wireless B

Enable Quality of Service r

um Threshold (50-20 50

(8] 3 Cancel 3
QoS Policies Table
Add '] Edt J
Inchene Podicy Name Policy Type Priority Qos Row

Mapping Marking Status

11 1 = Enable
12 1 | Enable
13 Dedault 1 =3 Enable
14 Defaull 1 = Enabie
15 Default spediralink = Enable

Figure 4-43 QoS Policy Sub-Tab
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2. To enable QoS, check the Enable Quality of Service checkbox.

3. Configure the QoS Maximum Medium Threshold for all Admission Controls. Admission will be granted if the new
requested traffic stream and already admitted time is less than the medium maximum threshold.

4. To add a QoS Policy, click the Add button in the “QoS Policies Table” box. The Add Entries box appears.

System \ Network \ Interfaces \ Management \ Filtering
: - 7 RADIOSFRU TS
Alarms Bridge \\ Profiles \ SSIDNLAN/Security \
Status LS

QoS Policies Table - Add Entries

Thiz page is used to create QoS Policies. By default when adding a QoS policy, all 5 QoS policy types
Klamitor are added. For Layer 2 policies, a priority mapping index from the 802.1p to 80210 mapping table
should be specified. For Layer 3 policies, a priority mapping index from the 802.1p to IP DSCP
mapping table should be specified. No priority mapping index is needed for Spectralink Qo5 policy
types. You can also enabie or disable QoS marking on each policy type and enable or disable the

Lommands different types
Help Note: Changes to these parameters require access point reboot in order 1o take effect.
- Palicy Name
xit 2
E RDOURALayers
Rabool 2
nboundlayers
3
OLRDOLMTL 3 :
K
whoundlayeyr
r

) 3 Cangel §
Figure 4-44 Add QoS Policy

5. Enter the Policy Name.

6. Select the Policy Type:
» inlayer2: inbound traffic direction, Layer 2 traffic type
* inlayer3: inbound traffic direction, Layer 3 traffic type
» outlayer2: outbound traffic direction, Layer 2 traffic type
» outlayer3: inbound traffic direction, Layer 3 traffic type
* spectralink: SpectraLink traffic

7. Enter the Priority Mapping Index.

For layer 2 policies, an index from the 802.1p to 802.1d mapping table should be specified. For layer 3 policies, an
index from the 802.1p to IP DSCP mapping table should be specified. No mapping index is required for SpectraLink.

8. Select whether to Enable QoS Marking.
9. Click OK.
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Priority Mapping

Use this page to configure QoS 802.1p to 802.1d priority mappings (for layer 2 policies) and IP DSCP to 802.1d priority
mappings (for layer 3 policies). The first entry in each table contains the recommended priority mappings. Custom entries
can be added to each table with different priority mappings.

1. Click Configure > QoS > Priority Mapping.

Mmm\ﬂmA !Hmawmm]

Policy [ Pricrity Mapping \ EDCA L

This page is used to configure GoS 802.10 1o 802.1p priority mappings and 802.10 To IP DSCP priority
mappings. The first entry in each table the r priority mappings and cannot
be deleted, Custom entries can be added to each table with different priority mappings.

802.1D to 802.1p Priority Mapping Table

Index B02.1D Priority 802.1p Priority Status
1 1] 1] Enabla
1 1 1 Enable
1 2 2 Enable
1 3 3 Enable
k) 4 4 Enable
1 5 5 Enabie
1 - g Enable
1 7 7 Enable

802.10 to IP DSCP Priority Mapping Table

B —

Index 802.10 Prionty IP DSCP Range Status
1 o 0.7 Enable
1 1 B8.15 Enable
3 2 16.23 Enable
1 3 24 .1 Enable
g 4 3239 Enable
1 5 4047 Enable
4 g 4855 Enable
k| 7 56.63 Enable

Figure 4-45 Priority Mapping
2. Click Add in the 802.1p and 802.1d priority mapping table.
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801 1p pric so il requires all priorities 1o be specified. Please enter the desired values

for BD2.1p priorities and press the Ok button.

Commeands 802.10 Priority 802.1p Prionity

Reboat

Il

4 ¥

Figure 4-46 Add Priority Mapping Entry

Select the 802.1p Priority (from 0-7) for 802.1d Priorities 0-7.

Click OK.

Click Add in the IP Precedence/DSCP ranges and 802.1d Priority table.
Select the IP DSCP Range for each 802.1d Priority.

7. Click OK.

L

NOTE: Changes to Priority Mapping require a reboot of the AP to take effect.

Enhanced Distributed Channel Access (EDCA)

WME uses Enhanced Distributed Channel Access, a prioritized CSMA/CA access mechanism used by WME-enabled
clients/AP in a WME enabled BSS to realize different classes of differentiated Channel Access.

A wireless Entity is defined as all wireless clients and APs in the wireless medium contending for the common wireless
medium. EDCA uses a separate channel access function for each of the Access Categories (Index) within a wireless
entity. Each channel access function in a wireless entity that contends for the wireless medium as if it were a separate
client contending for the wireless medium. Different channel access functions in a given Wireless Entity contend among
themselves for access to the wireless medium in addition to contending with other clients.

STA EDCA Table and AP EDCA Table

This page is used to configure the client (STA) and AP Enhanced Distributed Channel Access (EDCA) parameters. You
can modify the EDCA values for both Wireless A and Wireless B.

The EDCA parameter set provides information needed by the client stations for proper QoS operation during the wireless
contention period. These parameters are used by the QoS enabled AP to establish policy, to change policies when
accepting new stations or new traffic, or to adapt to changes in the offered load. The EDCA parameters assign priorities
to traffic types where higher priority packets gain access to the wireless medium more frequently than lower priority
packets.

NOTE: Default recommended values for EDCA parameters have been defined; Proxim recommends not modifying
EDCA parameters unless strictly necessary.

Perform the following procedure to configure the Station and AP EDCA tables.
1. Click Configure > QoS > EDCA.
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Ir Policy ]( Prionty Mapping | EDCA A N

parameters. You can modify the EDCA values for both Wirel A aned Wired B {when applicab

This page is used to configure the client (STA) and AP Enhanced Distritaned Channel Atceas (EDCA)

The EDCA parameter set provides information needed by the client stations for proper GoS

changes in the offered load. The EDCA parameters assign priorities to traffic fypes where higher

maoditying EDCA parameters unless sirictly necesaary.

STA EDCA Table
Mccess Admission Control
c CWimin CiWmax AIFEH Tx OF Limit Mandatory
Wireless A
BestEMont 15 1023 3 [] falge
Background 15 1023 7 1] false
ideo 7 15 2 3008 false
Woice 3 T 2 1504 falze
Wireless B
BastEffont 15 1023 3 0 falza
Background 15 1023 7 o false
Video 7 15 2 3008 false
Voice 3 T 2 1504 falza

AP EDCA Table
ACCRES Admission Control

CWmin CWmax AIFSH Tx OP Limit 1ory

Wireless A
BestEflon 15 i3] 3 1] Talse
Background 15 1023 7 ] false
Video T 15 1 3008 falze
Voice a T 1 1504 falza
Wireless B
BastEfflon 15 63 3 1] falsa
Background 15 1023 7 L] false
Video T 15 1 2008 falze
Voice 3 T k| 1504 lalsa

Figure 4-47 EDCA Tables

2. Click Edit and configure the following parameters in each table:

NOTE: Changes to EDCA parameters require a reboot of the AP to take effect.

* Index: read-only. Indicates the index of the Access Category (1-4) being defined:

— 1 =Best Effort
— 2= Background
— 3 =Video

operation during the wireless contention pericd, These parameters are used by the OoS enabled
AP 10 establish policy, to change podicies when ] M oF new tratfic, or to adapt 1o
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— 4 =Voice
* CWMin: minimum Contention Window. Configurable range is 0 to 255.
*  CWMax: maximum Contention Window. Configurable range is 0 to 65535.
» AIFSN: Arbitration IFS per access category. Configurable range is 2 to 15.

* Tx OP Limit: The Transmission Opportunity Limit. The Tx OP is an interval of time during which a particular QoS
enhanced client has the right to initiate a frame exchange sequence onto the wireless medium. The Tx OP Limit
defines the upper limit placed on the value of Tx OP a wireless entity can obtain for a particular access category.
Configurable range is 0 to 65535.

+ MSDU Lifetime: specifies the maximum elapsed time between a MSDU transfer request and delivery to the
destination, beyond which delivery becomes unnecessary. Configurable range is 0 to 500 seconds.

* Admission Control Mandatory: Possible values are True or False. Admission control defines if an Access Point
accepts or rejects a requested traffic stream with certain QoS specifications, based on available channel capacity
and link conditions. Admission control can be configured for each Access Category (Index).

On the Policy sub-tab, the user can also configure a medium maximum threshold for all Admission Controls.
Admission will be granted if the new requested traffic stream and already admitted time is less than the medium
maximum threshold.
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Radius Profiles

Configuring Radius Profiles on the AP allows the administrator to define a profile for RADIUS Servers used by the system
or by a VLAN. The network administrator can define RADIUS Servers per Authentication Mode and per VLAN.

The AP communicates with the RADIUS server defined in a profile to provide the following features:

¢« MAC Access Control Via RADIUS Authentication
+ 802.1x Authentication using RADIUS
* RADIUS Accounting

Also, RADIUS Based Management Access allows centralized user management.

The network administrator can configure default RADIUS authentication servers to be used on a system-wide basis, or in
networks with VLANs enabled the administrator can also configure separate authentication servers to be used for MAC
authentication, EAP authentication, or Accounting in each VLAN. You can configure the AP to communicate with up to six
different RADIUS servers per VLAN/SSID:

* Primary Authentication Server (MAC-based authentication)

» Back-up Authentication Server (MAC-based authentication)

* Primary Authentication Server (EAP/802.1x authentication)

» Back-up Authentication Server (EAP/802.1x authentication)

* Primary Accounting Server

» Back-up Accounting Server

The back-up servers are optional, but when configured, the AP will communicate with the back-up server if the primary
server is off-line. After the AP has switched to the backup server, it will periodically check the status of the primary
RADIUS server every five (5) minutes. Once the primary RADIUS server is again online, the AP automatically reverts

from the backup RADIUS server back to the primary RADIUS server. All subsequent requests are then sent to the
primary RADIUS server.

You can view monitoring statistics for each of the configured RADIUS servers.

RADIUS Servers per Authentication Mode and per VLAN

The user can configure separate RADIUS authentication servers for each authentication mode and for each SSID
(VLAN). For example:
« The user can configure separate RADIUS servers for RADIUS MAC authentication and 802.1x authentication

» The user can configure separate RADIUS servers for each VLAN: VLAN1 could support only WEP clients, whereas
VLAN2 could support 802.1x and WEP clients.

VLAN 1 Authentication

WLAN 1
Authentication

RADIUS
A Poin
ccess Point Switch Serer

n

ﬂ VLAN 2 Authentication

VLAN 2

Authentication RADILS

Server

Figure 4-48 RADIUS Servers per VLAN
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This figure shows a network with separate authentication servers for each authentication type and for each VLAN. The
clients in VLAN 1 are authenticated using the authentication servers configured for VLAN 1. The type of authentication
server used depends on whether the authentication is done for an 802.1x client or a non-802.1x client. The clients in

VLAN 2 are authenticated using a different set of authentication servers configured for authenticating users in VLAN 2.

Authentication servers for each VLAN are configured as part of the configuration options for that VLAN. RADIUS profiles
are independent of VLANs. The user can define any profile to be the default and associate all VLANSs to that profile. Four
profiles are created by default, “MAC Authentication”, “EAP Authentication”, Accounting”, and “Management”.

RADIUS Servers Enforcing VLAN Access Control

A RADIUS server can be used to enforce VLAN access control in two ways:

» Authorize the SSID the client uses to connect to the AP. The SSID determines the VLAN that the client gets assigned

to.

» Assigning the user to a VLAN by specifying the VLAN membership information of the user.

Configuring Radius Profiles

A RADIUS server Profile consists of a Primary and a Secondary RADIUS server that get assigned to act as either MAC
Authentication servers, 802.1x/EAP Authentication servers, or Accounting Servers in the VLAN Configuration. See

Configuring Security Profiles.

The RADIUS Profiles tab allows you to add new RADIUS profiles or modify or delete existing profiles.

System L Network \1‘
Alarms Bridge
RADIUS Frofile. % PXUProfiles i

Interfaces

QoS

\

Management \ Filtering

This page is used to configure the RADIUS Server Profiles. A RADIUS server Profile consists

of a Primary and a Secondary RADIUS server.

The RADIUS server profiles created on this page will be assigned to act as MAC
authentication / EAP authentication ! Accounting server in the 55ID configuration

Click on "ADD" to create a new profile. To Modify an exisiting profile, select the profile and
click "Edit". To Delete an existing profile select the profile and click "Delete".

Note: Changes to the RADIUS Server Profiles will not require & reboot of the device.

Add Edi

Delete

Index ProfileName
MAC Authentication

EAP Authentication
Accounting

Xy DG
FS TR (S Y

Management Access

Figure 4-49 RADIUS Server Profiles

Primary Status

Adding or Modifying a RADIUS Server Profile

Perform the following procedure to add a RADIUS server profile and to configure its parameters.

F

Secondary Status

AN ssIDvLANISecurity )

1. Click Add to create a new profile. To Modify an existing profile, select the profile and click Edit. To delete an existing
profile, select the profile and click Delete. You cannot delete a RADIUS server profile if it is applied to an SSID.

2. Configure the following parameters for the RADIUS Server profile (see Figure 4-50):
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NOTE: This page configures only the Primary RADIUS Server associated with the profile. After configuring these
parameters, save them by clicking OK. Then, to configure the Secondary RADIUS Server, edit the profile from

the main page.

Figure 4-50 Add RADIUS Server Profile

Sysle 1 Jebw ‘|\ lerfaces 1 Management 1. Filtering \'Ik
Alarms Bridge QoS "I._ SAIDNLANSacunt H\

This page is used to edit the selacted RADUS Sarver Profile. A RADIUE server Profile consists of a
Primary and a Secondary RADIUS server
Note: Chamges fo e RADIUS Server Profiles will mof reguire & reboot of the device.
DNS iz . For configuring server nimes in the RAINUS profife, emable first.
VLAN iz . For configuring VLAN [0 in the RADIUS profile, enmbie first.

Server Profile Mame MAC Autrantaatian

pa DushDalem e 55 -]

Server Parameter Primary Backup

Sener Addressing Formal | Acaress ":J | P Agcerss ,:J

Server NamelF Address 2.0.000 0.00.0

Destination Port i F B2

=1 LaM 1D

Shared Secret sasaus sEamme

C rm Shared Sacet eeeess 0 sseses

= Tirme 1 £} 3

dlzmimum Retransmissions 3 3

Senser Stal Disable ;j |:"st|:t ;J

(u]" =1

» Server Profile Name: the profile name. This is the name used to associated a VLAN to the profile. See
Configuring Security Profiles. The Server Profile Name is also used in the Configure > Management > Services
page to specify the RADIUS profile to be used for RADIUS Based Management Access.

« MAC Address Format Type: This parameter should correspond to the format in which the clients’ 12-digit MAC
addresses are listed within the RADIUS server and the way passwords are sent to the RADIUS server. Available

options are:

Dash delimited/SS: MAC addresses are formatted with a dash between each pair of digits (xx-yy-zz-aa-bb),

and the password sent to the RADIUS server is the shared secret (configured below).

Colon delimited/SS: MAC addresses are formatted with a colon between each pair of digits (xx:yy:zz:aa:bb:cc)

and the password sent to the RADIUS server is the shared secret (configured below).

Single dash delimited/SS: MAC addresses are formatted with a dash between the sixth and seventh digits

(xxyyzz-aabbcc) and the password sent to the RADIUS server is the shared secret (configured below).

No delimiters/SS: MAC addresses are formatted with no characters or spaces between pairs of hexadecimal

digits (xxyyzzaabbcc) and the password sent to the RADIUS server is the shared secret (configured below).

Dash delimited/MAC: MAC addresses are formatted with a dash between each pair of digits (xx-yy-zz-aa-bb),

and the password sent to the RADIUS server is the MAC address of the client.

Colon delimited/MAC: MAC addresses are formatted with a colon between each pair of digits

(xx:yy:zz:aa:bb:cc) and the password sent to the RADIUS server is the MAC address of the client.
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— Single dash delimited/MAC: MAC addresses are formatted with a dash between the sixth and seventh digits
(xxyyzz-aabbcc) and the password sent to the RADIUS server is the MAC address of the client.

— No delimiters/MAC: MAC addresses are formatted with no characters or spaces between pairs of hexadecimal
digits (xxyyzzaabbcc) and the password sent to the RADIUS server is the MAC address of the client.

» Accounting update interval: Enter the time interval (in minutes) for sending Accounting Update messages to the
RADIUS server. A value of 0 (default) means that the AP will not send Accounting Update messages.

« Accounting inactivity timer: Enter the accounting inactivity timer. This parameter supports a value from 1-60
minutes. The default is 5 minutes.

* Authorization lifetime: Enter the time, in seconds, each client session may be active before being automatically
re-authenticated. This parameter supports a value between 900 and 43200 seconds. The default is 0 (disabled).

» Server Addressing Format: select IP Address or Name. If you want to identify RADIUS servers by name, you
must configure the AP as a DNS Client. See DNS Client for details.

« Server Name/IP Address: Enter the server’s name or IP address.

» Destination Port: Enter the port number which the AP and the server will use to communicate. By default,
RADIUS servers communicate on port 1812.

+ Server VLAN ID: Indicates the VLAN that uses this RADIUS server profile. If VLAN is disabled, this field will be
grayed out.

» Shared Secret and Confirm Shared Secret: Enter the password shared by the RADIUS server and the AP. The
same password must also be configured on the RADIUS server. The default password is “public.”

* Response Time (seconds): Enter the maximum time, in seconds, that the AP should wait for the RADIUS server
to respond to a request. The range is 1-10 seconds; the default is 3 seconds.

* Maximum Retransmissions (0-4): Enter the maximum number of times an authentication request may be
transmitted. The range is 0 to 4, the default is 3.

» Server Status: Select Enable from the drop-down box to enable the RADIUS Server Profile.
3. Click OK.
4. Select the Profile and click Edit to configure the Secondary RADIUS Server, if required.

MAC Access Control Via RADIUS Authentication

If you want to control wireless access to the network and if your network includes a RADIUS Server, you can store the list
of MAC addresses on the RADIUS server rather than configure each AP individually. You can define a RADIUS Profile
that specifies the IP Address of the server that contains a central list of MAC Address values identifying the authorized
stations that may access the wireless network. You must specify information for at least the primary RADIUS server. The
back-up RADIUS server is optional.

NOTE: Each VLAN can be configured to use a separate RADIUS server (and backup server) for MAC authentication.
MAC access control can be separately enabled for each VLAN.

NOTE: Contact your RADIUS server manufacturer if you have problems configuring the server or have problems using
RADIUS authentication.

802.1x Authentication using RADIUS

You must configure a primary EAP/802.1x Authentication server to use 802.1x security. A back-up server is optional.

NOTE: Each VLAN can be configured to use a separate RADIUS server (and backup server) for 802.1x authentication.
802.1x authentication (“EAP authentication”) can be separately enabled for each VLAN.
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RADIUS Accounting

Using an external RADIUS server, the AP can track and record the length of client sessions on the access point by
sending RADIUS accounting messages per RFC2866. When a wireless client is successfully authenticated, RADIUS
accounting is initiated by sending an “Accounting Start” request to the RADIUS server. When the wireless client session
ends, an “Accounting Stop” request is sent to the RADIUS server.

NOTE: Each VLAN can be configured to use a separate RADIUS accounting server (and backup accounting server).

Session Length
Accounting sessions continue when a client reauthenticates to the same AP. Sessions are terminated when:

* A client disassociates.

» A client does not transmit any data to the AP for a fixed amount of time.

» Aclient is detected on a different interface.

» |dle-Timeout or Session-Timeout attributes are configured in the Radius server.

If the client roams from one AP to another, one session is terminated and a new session is begun.

NOTE: This feature requires RADIUS authentication using MAC Access Control or 802.1x. Wireless clients configured in
the Access Point’s static MAC Access Control list are not tracked.

Authentication and Accounting Attributes

Additionally, the AP supports a number of Authentication and Accounting Attributes defined in RFC2865, RFC2866,
RFC2869, and RFC3580.

Authentication Attributes

+ State: Received in Access-Accept Packet by the AP during Authentication and sent back as-is during
Re-Authentication.

» Class: Received in Access-Accept Packet by the AP during Authentication and back as in Accounting Packets.

» Session-Timeout

— If the RADIUS server does not send a Session-Timeout, the AP will set the subscriber expiration time to 0, which
means indefinite access.

— The Termination Action attribute defines how the Session-Timeout attribute will be interpreted. If the Termination
Action is DEFAULT, then the session is terminated on expiration of the Session-Timeout time interval. If
Termination Action is RADIUS-Request, then re-authentication is done on expiration on the session.

— If the RADIUS server sends a Session-Timeout, the value specified by the Session-Timeout attribute will take
precedence over the configured Authorization Lifetime value.

¢ Termination-Action

— Valid values are: Default (0), RADIUS-Request (1). When the value is “default,” the Termination-Action attribute
sends an accounting stop message and then reauthenticates. If the value is “RADIUS-Request,” the
Termination-Action attribute reauthenticates without sending an accounting stop.

¢ |dle Timeout

— The AP internally maintains the Idle-Timeout attribute obtained for each of the users during their authentication
process, and uses this time interval in place of accounting inactivity time for timing out clients.

» Calling Station Id
— MAC address of the client being authenticated.
» Called Station Id

— The AP sends the MAC address of its own wireless interface with which the client getting authenticated is getting
associated, appended with the SSID. If VLAN is enabled, the SSID and corresponding VLAN ID get appended.

¢ Acct-Interim-Interval
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— Obtained during the Authentication process and used for determining the time interval for sending Accounting
Update messages.

— This attribute value takes precedence over the value of the Accounting Update Interval.

Accounting Attributes

Acct-Delay-Time

— Indicates how many seconds the AP has been trying to send a particular packet related to a particular user. This
time can be used at the server to determine the approximate time of the event generating this accounting request.

Acct-Session-Id

— Unique accounting ID that aids in tracking client accounting records. This attribute is sent in Start and Stop
RADIUS accounting messages, and contains the client MAC address appended with the unique session ID.

Acct-Session-Time

— Acct-Session-Time is calculated the following way (for each transmitted/retransmitted Acct-Stop):
Acct-Session-Time = time of last sent packet - subscriber login time.

Acct-Input-Octets

— Number of octets (bytes) received by subscriber.
Acct-Output-Octets

— Number of octets (bytes) sent by subscriber.
Acct-Input-Packets

— Number of packets received by subscriber.
Acct-Output-Packets

— Number of packets sent by subscriber.
Acct-Terminate Cause

— Indicates how the session was terminated.
Vendor Specific Attributes
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PXU (ProximUnify) Profile and VLAN Roaming

ProximUnify architecture enables VLAN roaming for both data and voice clients. VLAN roaming support is required when
a client device roams between APs connected to switches with different VLANs configured. IP Tunnels are used to
forward the STAs traffic to and from the Home of the STA. STAs are assigned Homes at certain APs. If the STA moves to
another AP where its VLAN is unavailable, ProximUnify facilitates a seamless roaming.

Wireless Domain Configuration

In order for the AP and ProximUnify to work together to support VLAN roaming, the administrator must first configure a
ProximUnify Profile and configure VLAN parameters on the AP. For more information on ProximUnify configuration and
management, refer to the ProximUnify User Guide.

» Wireless Domain: Wireless Domain constitutes the host of ProximUnify devices servicing wireless APs which in turn
service wireless clients. These Wireless APs should be registered with ProximUnify and must be sending and
receiving information.

* Converged Mobility (CMOB): AP feature that enables VLAN roaming for both data and voice (VolP) clients.

Each AP registers with a ProximUnify Module. In order to provide redundancy, a Primary and a Secondary ProximUnify
Module may be configured for an AP to register with. If redundancy is not of so importance, only one of the two Modules
can be configured. Note that the redundancy is just for registration purposes and Tunnel information is not carried
forward or transferred between Primary and Secondary PXU Modules. Communication between ProximUnify Modules
and registered Access Points is secured using Diffie-Hellman for authentication and RC4 for encryption. The “Shared
Secret” is required to fulfil these requirements.

NOTE: A PXU AP will not allow wireless client association to an SSID having CMOB status enabled until it registers to
either Primary or Secondary PXU module.

During a PXU failover, the AP association with CMOB STA is delayed for sometime. There is no end-to-end connectivity
during this period. For more information, refer to the “ProximUnify User Guide”.

Configuring the ProximUnify Profile

The PXU Profile tab allows you to configure the IP address and select the server status to enable or disable the profile.

The PXU Profile consists of two Modules, a Primary and a Secondary. Configuring the PXU Profiles on the AP allows the
administrator to define a profile for PXU Modules used by the system. For more information on configuration and
management, refer to the “ProximUnify User Guide”.
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System ']I MNetwork \ Interfaces 1 Management L|I Filtering
Alarms Bridge Qo3 i \ SSIDVLANISecurity |
Status

RADIUS Profile ||

This page is used to configure the PXU Module Profiles. A PXU Module Profile consists of a
Primary and a Secondary PXU Module.

Idonitor Nate: Changes to the PXU Module Profiles require access point reboot in order to take
effect.
Commands
Halp Module Parameter Primary Secondary
P31 P Address 0.0.0.0 0.0.00
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Eol Y | | sSharedSecret 0909090 [emesse 0 [eaeess
............
Retoot ds 3 3
3 3
Disable =] |visazie =
Cancal
F | Al F

Figure 4-51 PXU Profile Interface

To configure the PXU Profile, click Configure>Radius/PXU Profiles>PXU Profile. The PXU Profile page appears.
Following are the configurable fields to set up the PXU Profile to function.

1. PXU IP Address: Enter the IP address. The default is 0.0.0.0.
2. Domain Name: Enter the name of the Wireless Domain.

3. Shared Secret/ Confirm Shared Secret: Enter the password shared by the PXU Modules and the AP. The same
password must also be configured on the PXU Modules. The default password is “public.” Shared Secret accepts
the alphanumeric characters, except special characters, to configure the password. The length ranges from 6 to
32 characters.

4. Response Time: The maximum timeout value that the AP should wait before the PXU Modules respond to a
request. The range is 1-10 seconds; the default is 3 seconds.

5. Retransmission: Enter the maximum number of times an authentication request may be transmitted. The range
is 0 to 4, the default is 3.

6. Module Status: Select Enable from the drop-down box to enable the PXU Profile.
To reset your configuration, click Cancel.
After configuring the PXU Profile parameters, Click OK.

NOTE: Changes to the PXU Profile require access point reboot in order to take effect.
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SSID/VLAN/Security

The AP provides several security features to protect your network from unauthorized access. This section gives an
overview of VLANs and then discusses the SSID/VLAN/Security configuration options in the AP:

* VLAN Overview

* Management VLAN

» Security Profile

* MAC Access

*  Wireless-A or Wireless-B

The AP also provides Broadcast Unique Beacon/Closed System and Rogue Scan to protect your network from
unauthorized access. See the Wireless-A or Wireless-B and Rogue Scan sections from more information.

VLAN Overview

Virtual Local Area Networks (VLANS) are logical groupings of network hosts. Defined by software settings, other VLAN
members or resources appear (to clients) to be on the same physical segment, no matter where they are attached on the
logical LAN or WAN segment. They simplify traffic flow between clients and their frequently-used or restricted resources.

VLANSs now extend as far as the reach of the access point signal. Clients can be segmented into wireless sub-networks
via SSID and VLAN assignment. A Client can access the network by connecting to an AP configured to support its
assigned SSID/VLAN.

AP devices are fully VLAN-ready; however, by default VLAN support is disabled. Before enabling VLAN support, certain
network settings should be configured, and network resources such as a VLAN-aware switch, a RADIUS server, and
possibly a DHCP server should be available.

Once enabled, VLANSs are used to conveniently, efficiently, and easily manage your network in the following ways:

* Manage adds, moves, and changes from a single point of contact
» Define and monitor groups
* Reduce broadcast and multicast traffic to unnecessary destinations

— Improve network performance and reduce latency
* Increase security

— Secure network restricts members to resources on their own VLAN

— Clients roam without compromising security
VLAN tagged data is collected and distributed through an AP's wireless interface(s) based on Network Name (SSID). An
Ethernet port on the access point connects a wireless cell or network to a wired backbone. The access points
communicate across a VLAN-capable switch that analyzes VLAN-tagged packet headers and directs traffic to the
appropriate ports. On the wired network, a RADIUS server authenticates traffic and a DHCP server manages IP

addresses for the VLAN(s). Resources like servers and printers may be present, and a hub may include multiple APs,
extending the network over a larger area.
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Figure 4-52 Components of a Typical VLAN

VLAN Workgroups and Traffic Management

Access Points that are not VLAN-capable typically transmit broadcast and multicast traffic to all wireless Network
Interface Cards (NICs). This process wastes wireless bandwidth and degrades throughput performance. In comparison,
a VLAN-capable AP is designed to efficiently manage delivery of broadcast, multicast, and unicast traffic to wireless
clients.

The AP assigns clients to a VLAN based on a Network Name (SSID). The AP can support up to 16 SSIDs per radio, with
a unique VLAN configurable per SSID.

The AP matches packets transmitted or received to a network name with the associated VLAN. Traffic received by a
VLAN is only sent on the wireless interface associated with that same VLAN. This eliminates unnecessary traffic on the
wireless LAN, conserving bandwidth and maximizing throughput.

In addition to enhancing wireless traffic management, the VLAN-capable AP supports easy assignment of wireless users
to workgroups. In a typical scenario, each user VLAN represents a workgroup; for example, one VLAN could be used for
an EMPLOYEE workgroup and the other for a GUEST workgroup.

In this scenario, the AP would assign every packet it accepted to a VLAN. Each packet would then be identified as
EMPLOYEE or GUEST, depending on which wireless NIC received it. The AP would insert VLAN headers or “tags” with
identifiers into the packets transmitted on the wired backbone to a network switch.

Finally, the switch would be configured to route packets from the EMPLOYEE workgroup to the appropriate corporate
resources such as printers and servers. Packets from the GUEST workgroup could be restricted to a gateway that
allowed access to only the Internet. A member of the GUEST workgroup could send and receive e-mail and access the
Internet, but would be prevented from accessing servers or hosts on the local corporate network.

Typical User VLAN Configurations

VLANs segment network traffic into workgroups, which enable you to limit broadcast and multicast traffic. Workgroups
enable clients from different VLANSs to access different resources using the same network infrastructure. Clients using
the same physical network are limited to those resources available to their workgroup.

The AP can segment users into a maximum of 16 different workgroups per radio, based on an SSID/VLAN grouping (also
referred as a VLAN Workgroup or a Sub-network).

NOTE: VLAN must be enabled to configure security per SSID.
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Figure 4-53 Mgmt VLAN

VLAN Tagging Management

Control Access to the AP

Management access to the AP can easily be secured by making management stations or hosts and the AP itself
members of a common VLAN. Simply configure a non-zero management VLAN ID and enable VLAN to restrict
management of the AP to members of the same VLAN.

CAUTION: If a non-zero management VLAN ID is configured then management access to the AP is restricted to wired
or wireless hosts that are members of the same VLAN. Ensure your management platform or host is a
member of the same VLAN before attempting to manage the AP.

NOTE: When VLAN is enabled, ensure that all devices in the network share the same VLAN ID.

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.
2. Set the VLAN Management ID to a value of between 1 and 4094. (A value of -1 disables VLAN Tagging).
3. Place a check mark in the Enable VLAN Tagging box.

Provide Access to a Wireless Host in the Same Workgroup

The VLAN feature can allow wireless clients to manage the AP. If the VLAN Management ID matches a VLAN User ID,
then those wireless clients who are members of that VLAN will have AP management access.

CAUTION: Once a VLAN Management ID is configured and is equivalent to one of the VLAN User IDs on the AP, all
members of that User VLAN will have management access to the AP. Be careful to restrict VLAN
membership to those with legitimate access to the AP.

NOTE: When VLAN is enabled, ensure that all devices in the network share the same VLAN ID.

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.
2. Set the VLAN Management ID to use the same VLAN ID as one of the configured SSIDs.
3. Place a check mark in the Enable VLAN Tagging box.
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Disable VLAN Tagging

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.

2. Remove the check mark from the Enable VLAN Tagging box (to disable all VLAN functionality) or set the VLAN
Management ID to -1 (to disable VLAN Tagging only).

NOTE: If you disable VLAN Tagging, you will be unable to configure security per SSID.

Uplink VLAN ID Table

The AP has a table for configuring the VLAN IDs that are manually/statically inserted by the user. The list contains the
VLANSs that are known to exist on the Ethernet interface of the AP.

This list is used by the ProximUnify System to ascertain whether VLAN mobility needs to be provided to a certain CMOB
Enabled STA after it roams to another AP.

It is always recommended that:

» All the VLANs which are known to exist on the uplink are configured in the Uplink Table; OR
» Of all the VLANSs available on the Uplink, at least configure the VLANS (in the Uplink Table) which are
used/configured on any of the CMOB-enabled SSIDs in the whole Wireless Domain.
To Add Uplink VLAN Configuration

1. Click the ADD button. A new interface is displayed.
2. Enter the values in the Start VLAN ID and End VLAN ID fields.
3. Click OK.

Add uplink wlan cofiguration.

Figure 4-54 To add uplink VLAN configuration interface

To Edit Uplink VLAN Configuration

1. Click the EDIT button. The following interface is displayed.

2. Reset the values in the Start VLAN ID and End VLAN ID fields.
3. To enable status server, select Enable from the dropdown list.
4. Click OK.

The updated values are reflected in the Uplink VLAN table.
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Figure 4-55 Edit Uplink VLAN Configuration interface

To Delete Uplink VLAN Configuration

1. Select the Index number of the uplink table by clicking the radio button.
2. Click the DELETE button.

Security Profile
See the following sections:

» Security Features

» Authentication Protocol Hierarchy
* VLANSs and Security Profiles

» Configuring Security Profiles

Security Features
The AP supports the following security features:

* WEP Encryption: The original encryption technique specified by the IEEE 802.11 standard.
» 802.1x Authentication: An IEEE standard for client authentication.
» Wi-Fi Protected Access (WPA/802.11i [WPAZ2]): A new standard that provides improved encryption security over WEP.

NOTE: The AP does not support shared key 802.11 MAC level authentication. Clients with this MAC level feature must
disable it.

WEP Encryption

The IEEE 802.11 standards specify an optional encryption feature, known as Wired Equivalent Privacy or WEP, that is
designed to provide a wireless LAN with a security level equal to what is found on a wired Ethernet network. WEP
encrypts the data portion of each packet exchanged on an 802.11 network using an Encryption Key (also known as a
WEP Key).

When Encryption is enabled, two 802.11 devices must have the same Encryption Keys and both devices must be
configured to use Encryption in order to communicate. If one device is configured to use Encryption but a second device
is not, then the two devices will not communicate, even if both devices have the same Encryption Keys.

802.1x Authentication

IEEE 802.1x is a standard that provides a means to authenticate and authorize network devices attached to a LAN port.
A port in the context of IEEE 802.1x is a point of attachment to the LAN, either a physical Ethernet connection or a
wireless link to an Access Point. 802.1x requires a RADIUS server and uses the Extensible Authentication Protocol
(EAP) as a standards-based authentication framework, and supports automatic key distribution for enhanced security.
The EAP-based authentication framework can easily be upgraded to keep pace with future EAP types.
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Popular EAP types include:
» EAP-Message Digest 5 (MD5): Username/Password-based authentication; does not support automatic key
distribution

» EAP-Transport Layer Security (TLS): Certificate-based authentication (a certificate is required on the server and each
client); supports automatic key distribution

» EAP-Tunneled Transport Layer Security (TTLS): Certificate-based authentication (a certificate is required on the
server; a client’'s username/password is tunneled to the server over a secure connection); supports automatic key
distribution

* PEAP - Protected EAP with MS-CHAP: Secure username/password-based authentication; supports automatic key
distribution

Different servers support different EAP types and each EAP type provides different features. See the documentation that
came with your RADIUS server to determine which EAP types it supports.

NOTE: The AP supports the following EAP types when Security Mode is set to 802.1x, WPA, or 802.11i (WPA2):
EAP-TLS, PEAP, EAP-TTLS, EAP-MD5, and EAP-SIM.

Authentication Process

There are three main components in the authentication process. The standard refers to them as:

1. Supplicant (client PC)
2. Authenticator (Access Point)
3. Authentication server (RADIUS server)

When the Security Mode is set to 802.1x Station, WPA Station, or 802.11i Station you need to configure your RADIUS
server for authentication purposes.

Prior to successful authentication, an unauthenticated client PC cannot send any data traffic through the AP device to
other systems on the LAN. The AP inhibits all data traffic from a particular client PC until the client PC is authenticated.
Regardless of its authentication status, a client PC can always exchange 802.1x messages in the clear with the AP (the
client begins encrypting data after it has been authenticated).

<
‘@‘L’ )

Figure 4-56 RADIUS Authentication lllustrated

The AP acts as a pass-through device to facilitate communications between the client PC and the RADIUS server. The
AP (2) and the client (1) exchange 802.1x messages using an EAPOL (EAP Over LAN) protocol (A). Messages sent from
the client station are encapsulated by the AP and transmitted to the RADIUS (3) server using EAP extensions (B).

Upon receiving a reply EAP packet from the RADIUS, the message is typically forwarded to the client, after translating it
back to the EAPOL format. Negotiations take place between the client and the RADIUS server. After the client has been
successfully authenticated, the client receives an Encryption Key from the AP (if the EAP type supports automatic key
distribution). The client uses this key to encrypt data after it has been authenticated.

For 802.11a and 802.11b/g clients that communicate with an AP, each client receives its own unique encryption key; this
is known as Per User Per Session Encryption Keys.
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Wi-Fi Protected Access (WPA/802.11i [WPA2])

Wi-Fi Protected Access (WPA) is a security standard designed by the Wi-Fi Alliance in conjunction with the Institute of
Electrical and Electronics Engineers (IEEE). The AP supports 802.11i (WPA2), based on the IEEE 802.11i security
standard.

WPA is a replacement for Wired Equivalent Privacy (WEP), the encryption technique specified by the original 802.11
standard. WEP has several vulnerabilities that have been widely publicized. WPA addresses these weaknesses and
provides a stronger security system to protect wireless networks.

WPA provides the following new security measures not available with WEP:
» Improved packet encryption using the Temporal Key Integrity Protocol (TKIP) and the Michael Message Integrity
Check (MIC).
* Per-user, per-session dynamic encryption keys:
— Each client uses a different key to encrypt and decrypt unicast packets exchanged with the AP
— Adclient's key is different for every session; it changes each time the client associates with an AP
— The AP uses a single global key to encrypt broadcast packets that are sent to all clients simultaneously
— Encryption keys change periodically based on the Re-keying Interval parameter
— WHPA uses 128-bit encryption keys
* Dynamic Key distribution
— The AP generates and maintains the keys for its clients
— The AP securely delivers the appropriate keys to its clients
» Client/server mutual authentication
- 802.1x
— Pre-shared key (for networks that do not have an 802.1x solution implemented)

The AP supports the following WPA security modes:

*  WPA: The AP uses 802.1x to authenticate clients and TKIP for encryption. You should only use an EAP that supports
mutual authentication and session key generation, such as EAP-TLS, EAP-TTLS, and PEAP. See 802.1x
Authentication for details.

*  WPA-PSK (Pre-Shared Key): For networks that do not have 802.1x implemented, you can configure the AP to
authenticate clients based on a Pre-Shared Key. This is a shared secret that is manually configured on the AP and
each of its clients. The Pre-Shared Key must be 256 bits long, which is either 64 hexadecimal digits or 32
alphanumeric characters. The AP also supports a PSK Pass Phrase option to facilitate the creation of the TKIP
Pre-Shared Key (so a user can enter an easy-to-remember phrase rather than a string of characters).

» 802.11i (also known as WPA2): The AP provides security to clients according to the 802.11i draft standard, using
802.1x authentication, a CCMP cipher based on AES, and re-keying.

» 802.11i-PSK (also known as WPA2 PSK): The AP uses a CCMP cipher based on AES, and encrypts frames to clients
based on a Pre-Shared Key. The Pre-Shared Key must be 256 bits long, which is either 64 hexadecimal digits or 32
alphanumeric characters. The AP also supports a PSK Pass Phrase option to facilitate the creation of the Pre-Shared
Key (so a user can enter an easy-to-remember phrase rather than a string of characters).

NOTE: For more information on WPA, see the Wi-Fi Alliance Web site at http://lwww.wi-fi.org.

Authentication Protocol Hierarchy
There is a hierarchy of authentication protocols defined for the AP. The hierarchy is as follows, from highest to lowest:
» 802.1x authentication (including 802.1x, WPA, WPA-PSK, 802.11i, 802.11i-PSK)

*  MAC Access Control via RADIUS Authentication
*  MAC Access Control through individual APs' MAC Access Control Lists
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If you have both 802.1x and MAC Access Control authentication enabled, the 802.1x authentication takes precedence
because it is higher in the authentication protocol hierarchy. This is required in order to propagate the WEP/TKIP/AES
keys to the clients in such cases. If you disable 802.1x on the AP, you will see the effects of MAC authentication.

In addition, setting MAC Access Control status to Strict will cause both MAC ACL settings and 802.1x settings to be
applied.

For example, assume that the MAC Access Control List contains MAC addresses to block, and that WPA-PSK is
configured to allow access to clients with the appropriate PSK Passphrase.

» If the MAC ACL status is set to Enable, WPA-PSK will take precedence, and clients in the MAC ACL with the correct
PSK passphrase will be allowed. Only the WPA-PSK setting is taken into consideration.

» If the MAC ACL status is set to Strict, then clients in the MAC ACL will be blocked even if they have the correct PSK
passphrase. Clients will only be allowed if they have the correct passphrase and are NOT listed in the MAC ACL. In
this way, both MAC and WPA-PSK settings are taken into consideration.

VLANSs and Security Profiles

The AP allows you to segment wireless networks into multiple sub-networks based on Network Name (SSID) and VLAN
membership. A Network Name (SSID) identifies a wireless network. Clients associate with Access Points that share an
SSID. During installation, the Setup Wizard prompts you to configure a Primary Network Name for each wireless
interface.

After initial setup and once VLAN is enabled, the AP can be configured to support up to 16 SSIDs per wireless interface
to segment wireless networks based on VLAN membership.

Each VLAN can associated to a Security Profile and RADIUS Server Profiles. A Security Profile defines the allowed
wireless clients, and authentication and encryption types. See the following sections for configuration details.

Configuring Security Profiles

Security policies can be configured and applied on the AP as a whole, or on a per VLAN basis. When VLAN is disabled
on the AP, the user can configure a security profile for each interface of the AP. When VLANSs are enabled and Security
per SSID is enabled, the user can configure a security profile for each VLAN.

The user defines a security policy by specifying one or more values for the following parameters:

*  Wireless STA types (WPA station, 802.11i (WPA2) station, 802.1x station, WEP station, WPA-PSK, and 802.11i-PSK)
that can associate to the AP.

» Authentication mechanisms (802.1x, RADIUS MAC authentication) that are used to authenticate clients for each type
of station.

» Cipher Suites (CCMP, TKIP, WEP, None) used for encapsulating the wireless data for each type of station.
Up to 16 security profiles can be configured per wireless interface.

NOTE: Mesh security is configured on the Mesh tab.

1. Click Configure > SSID/VLAN/Security > Security Profile.
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Figure 4-57 Security Profile Configuration

2. Click Add in the Security Profile Table to create a new entry. To modify an existing profile, select the profile and click
Edit. To delete an existing profile, select the profile and click Delete. You cannot delete a Security Profile used in an
SSID. Also, the first Security Profile cannot be deleted.

3. Configure one or more types of wireless stations (security modes) that are allowed access to the AP under the
security profile. The WEP/PSK parameters are separately configurable for each security mode. To enable a security
mode in the profile (Non Secure Station, WEP Station, 802.1x Station, WPA Station, WPA-PSK Station, 802.11i
(WPA2) Station, 802.11i-PSK Station), check the box next to the mode. See Figure 4-58.

If the security mode selected in a profile is WEP, WPA-PSK, or 802.11i-PSK, then you must configure the WEP or
Pre-Shared Keys.

NOTE: If an 802.1x client that has already been authenticated attempts to switch to WEP, or if a WEP client that has
already been connected attempts to switch to 802.1x, the AP will not allow the client to switch immediately. If
this happens, either reboot the AP or disable the client/roam to a new AP for five minutes, and then attempt to
reconnect to the AP. If the client is still unable to connect after waiting five minutes, reboot the AP.

4. Configure the parameters as follows for each enabled security mode. See Figure 4-58.
* Non Secure Station:
+ Authentication Mode: None. The AP allows access to Stations without authentication.
— Non secure station should be used only with WEP or 802.1x security mode.
» Cipher: None
*  WEP Station:
* Authentication Mode: None
* Cipher: WEP
* Encryption Key 0, Encryption Key 1, Encryption Key 2, Encryption Key 3

NOTE: When VLAN tagging is enabled, only Key 0 can be configured.

* Encryption Key Length: 64, 128, or 152 Bits.

— For 64-bit encryption, an encryption key is 10 hexadecimal characters (0-9 and A-F) or 5 ASCII characters
(see ASCII Character Chart).

— For 128-bit encryption, an encryption key is 26 hexadecimal characters or 13 ASCII characters.
— For 152-bit encryption, an encryption key is 32 hexadecimal characters or 16 ASCII characters.
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* Encryption Transmit Key: select Key 0, Key 1, Key 2, or Key 3
NOTE: When VLAN tagging is enabled, only Key 0 can be configured.

802.1x Station:

* Authentication Mode: 802.1x

+ Cipher: WEP

« Encryption Key Length: 64 or 128 Bits.

— If 802.1x is enabled simultaneously with WEP, the 802.1x Station’s encryption key length is determined by
the WEP encryption key.

WPA Station:

* Authentication Mode: 802.1x
» Cipher: TKIP

WPA-PSK Station:

* Authentication Mode: PSK

+ Cipher: TKIP

» PSK Passphrase: an 8-63 character user-defined phrase. It is recommended a passphrase of at least 13
characters, including both letters and numbers, and upper and lower case characters, be used to ensure that
the generated key cannot be easily deciphered by network infiltrators.

802.11i Station:

* Authentication Mode: 802.1x
+ Cipher: CCMP based on AES
802.11i-PSK Station:

* Authentication Mode: PSK

* Cipher: CCMP based on AES

+ PSK Passphrase: an 8-63 character user-defined phrase. It is recommended a passphrase of at least 13
characters, including both letters and numbers, and upper and lower case characters, to ensure that the
generated key cannot be easily deciphered by network infiltrators.

5. When finished configuring all parameters, click OK.

6.

If you selected a Security Mode of 802.1x Station, WPA Station, or 802.11i Station, you must configure a RADIUS
802.1x/EAP server. See the Configuring Radius Profiles section.

Security Profile 1 will be used by default for all wireless interfaces.

7. Reboot the AP.
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Figure 4-58 Security Profile Table - Add Entries

MAC Access

The MAC Access sub-tab allows you to build a list of stations, identified by their MAC addresses, authorized to access
the network through the AP. The list is stored inside each AP within your network. Up to 1000 entries can be made in the

table.
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To configure MAC Access Status for an SSID, click Configure>SSID/VLAN/Security>Wireless A or B. The MAC ACL
Status parameter configuration is available per SSID if Security Per SSID feature is enabled. The parameter gets
applied for all SSIDs when Security per SSID is disabled. Configuration of MAC ACL status is rebootable.

NOTE: When MAC ACL table is in Strict mode, any change done in the MAC ACL web page takes effect dynamically.
When not set to Strict, all the changes in the MAC ACL web page requires a reboot.

The following list details the configurable MAC Access parameters.

» Operation Type: Choose between Passthru and Block. This determines how the stations identified in the MAC
Access Control Table are filtered.
— If set to Passthru, only the addresses listed in the Control Table will pass through the bridge.
— If set to Block, the bridge will block traffic to or from the addresses listed in the Control Table.

* MAC Access Control Table: Click Add to create a new entry. Click Edit to change an existing entry. Each entry
contains the following field:

— MAC Address: Enter the wireless client's MAC address.

— Comment: Enter an optional comment such as the client's name.

— Status: The entry is enabled automatically when saved (so the Status field is only visible when editing an entry).
You can also disable or delete entries by changing this field’s value.

NOTE: For larger networks that include multiple Access Points, you may prefer to maintain this list on a centralized
location using the MAC Access Control Via RADIUS Authentication.
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Figure 4-59 MAC Access Configuration Screen

Wireless-A or Wireless-B

Each SSID can have its own Security Profile that defines its security mode, authentication mechanism, and encryption,
so that customers can have multiple types of clients (non-WEP, WEP, 802.1x, WPA, WPA-PSK, 802.11i, 802.11i-PSK)
on the same system separated per VLAN. See the Security Profile section for more information. Each SSID can support
a unique VLAN. In order for the AP to support multiple SSID/VLANs, VLAN Tagging must be enabled. These parameters
are configurable on the Wireless-A and Wireless-B screens.
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Configuring an SSID/VLAN with VLAN Tagging Disabled

With VLAN tagging disabled (from the SSID/VLAN/Security > Mgmt VLAN tab), only one SSID can be configured per
interface. All parameters set on the Wireless-A or Wireless-B tab will be applied to that SSID.

1. Click SSID/VLAN/Security > Wireless-A or Wireless-B.
The SSID, VLAN, and Security Configuration page is displayed.

i
mn
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d to configure multiple $5i0s (Wireless Network Names), VLAMN IDs and the associated

’ WUS server profiles. In order for the Security per VLAN and $5ID feature to function
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The user must Specity unique SSIDS and VLAN IDs values (only a single untagged VLAN 1D can be
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Exit aceounting 1% enabled in th ecuTity profile then the respective fiips should e
configured and assigned to
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n the 550 Table

RMobility, click on the Add or Edit buttons ir
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S5ID and VLAN Data Table

Index  MHetwork Name (S5ID) VLAN 1D QoS Profile Status CMob Status
1 Ly Wireless Notwork A untasoed 1 Enable abie

Figure 4-60 SSID, VLAN, and Security Configuration (VLAN Tagging Disabled)

2. Enable or disable RADIUS accounting on the VLAN/SSID by selecting Enable or Disable from the Accounting

Status drop-down menu.

3. Control the functionality of RADIUS MAC Authentication on the VLAN/SSID by selecting one of the following from the
the RADIUS Authentication Status drop-down menu.

* Enable: MAC addresses in the MAC Access Control List stored on the RADIUS server are blocked or allowed,
based on the MAC ACL settings. If a higher priority authentication protocol is also enabled, the higher-priority
settings will override the MAC ACL settings. See Authentication Protocol Hierarchy.

» Disable: RADIUS MAC ACL settings are disabled.

» Strict: RADIUS MAC ACL settings are enabled. If a higher-priority authentication protocol is also enabled,
RADIUS MAC ACL settings will be applied in addition to the higher priority authentication protocol settings. See
Authentication Protocol Hierarchy.
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4.

Control the functionality of the MAC Access Control List on the VLAN/SSID by selecting one of the following from the
MAC ACL Status drop-down menu:

Enable: MAC addresses in the MAC Access Control List are blocked or allowed, based on the MAC ACL settings.
If a higher priority authentication protocol is also enabled, the higher-priority settings will override the MAC ACL
settings. See Authentication Protocol Hierarchy.

Disable: MAC ACL settings are disabled.

Strict: MAC ACL settings are enabled. If a higher-priority authentication protocol is also enabled, MAC ACL
settings will be applied in addition to the higher priority authentication protocol settings. See Authentication
Protocol Hierarchy. When MAC ACL Status is set to Strict, changes to the MAC ACL table (configured on the
MAC Access page) will take effect without a device reboot.

Enter Rekeying Interval in seconds (between 300 and 65525). When set to 0, this parameter is disabled. The default
is 900 seconds.

Enter the Security Profile used by the VLAN in the Security Profile field. See the Security Profile section for more
information.

Define the RADIUS Server Profile Configuration for the VLAN/SSID:

RADIUS MAC Authentication Profile

RADIUS EAP Authentication Profile

RADIUS Accounting Profile

If 802.1x, WPA, or 802.11i security mode is used, the RADIUS EAP Authentication Profile must have a value.

A RADIUS Server Profile for authentication for each VLAN shall be configured as part of the configuration options
for that VLAN. RADIUS profiles are independent of VLANs. The user can define any profile to be the default and
associate all VLANSs to that profile. Four profiles are created by default, “MAC Authentication”, “EAP
Authentication”, Accounting”, and “Management”

If desired, scroll down to the scroll down to the SSID and VLAN Table and click Edit to modify the Network Name,
VLAN ID, or QoS profile of the SSID/VLAN.

NOTE: Because VLAN tagging is disabled, attempting to add a new SSID/VLAN will produce an error message.

The Edit Entries screen will be displayed. See Figure 4-61.
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4-61 SSID/VLAN Edit Entries Screen (VLAN Tagging Disabled)

9. Enter a unique Network Name (SSID) between 1 and 32 characters. This parameter is mandatory.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the

name.

10.Select Enable or Disable from the dropdown list to enable/disable CMOB. The default is Disable.
11.Enter a unique VLAN ID. This parameter is mandatory.

A VLAN ID is a number from -1 to 4094. A value of -1 means that an entry is “untagged.”

You can set the VLAN ID to “-1” or “untagged” if you do not want clients that are using a specific SSID to be
members of a VLAN workgroup.

The VLAN ID must match an ID used by your network; contact your network administrator if you need assistance
defining the VLAN IDs.

12.Specify a QoS profile. See the Policy section for more information.
13.Specify a 802.1p Priority.

14.Set
15.Set

the Maximum TX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.
the Maximum RX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.

16.Select the status of Closed System to control whether the SSID is advertised in the beacon and manage the way
probe requests are handled, as follows:

Enable: The SSID is not advertised in the beacon, and the AP will respond to probe requests with an SSID only if
the client has specified the SSID in the probe request. If the client sends a probe request with a null or “ANY”
SSID, the AP will not respond.

Partial: The SSID is advertised in the beacon, and the AP will not respond to "ANY" SSID requests. The Partial
setting reduces network traffic by eliminating the repeated broadcast of SSIDs in probe responses.

Disable: The SSID is advertised in the beacon, and the AP will respond with each configured SSID, whether or
not an SSID has been specified in the probe request.
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17.Enable Broadcast Unique Beacon using the drop-down menu. When enabled, Broadcast Unique Beacon allows the
broadcast of a up to four unique beacons when the AP is configured for multiple SSIDs. If Closed System (above) is
set to Partial or Disable, each beacon (up to four) will be broadcast a single SSID. If more than four SSIDs are
configured, then three SSIDs will be broadcast in individual beacons; the fourth and subsequent SSIDs will be
combined in one beacon and will not be broadcast. If Closed System is set to Enable, the SSID will not be broadcast
in the beacon. If Broadcast Unique Beacon is disabled, a combined beacon will be broadcast.

NOTE: Enabling Broadcast Unique Beacon will lower the total throughput of the AP by 2-4%. Enabling Broadcast
Unique Beacon simultaneously with Rogue Scan will cause a drift in the beacon interval and the occasional
missing of beacons.

18.Set the 802.1p Priority given to packets tagged with this VLAN ID. Enter a number between 0-7.

19.1f editing an entry, enable or disable the parameters on this page by electing Enable or Disable from the Status
drop-down menu. If adding a new entry, this drop-down menu will not appear.

20.Click OK to return to Wireless-A or Wireless-B Security Configuration Screen.
21.Reboot the AP.

Configuring SSID/VLANs with VLAN Tagging Enabled

With VLAN Tagging enabled (from the SSID/VLAN/Security > Mgmt VLAN tab), multiple SSID/VLANs are supported.
Parameters set on the Wireless-A or Wireless-B tab can be enabled per SSID by choosing the Enable Security per
SSID option.

1. Click SSID/VLAN/Security > Wireless-A or Wireless-B.
2. Select the Enable Security Per SSID option. The screen will update to the following:
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This page is used to configure multipie 551D (Wireless Network Hames), VLAN IDs and the associated
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Commiands VLAN Status must be enabled [Mamt Y
OITHTIEL
The user must specify unique S5IDs and VLAN IDs values {only a single untagged VLAM ID can be
Help configured).

rity ¢35 are used to configure the allowed security modes. H RHFIJ"\- H-a’. BO2.9x, WPA or RADIUS
Eail accounting is enabled in the 5510°'s security profile then the respective S BErvE i should be
configured and assigned to this 551D,

Rebool The Converged Mobility feature 15 supporied per Wirgless Iinterface S50, In order to configure Converged
Mobility, click on the Add or Edit buttons in the 55I0 Table.

Note: Changes to these parameters require access point reboot in order to take effect
Enable Security Per 3310 F

S5ID, VLAN, and Secunty Data Table
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Figure 4-62 SSID/VLAN Configuration (VLAN Tagging Enabled)

NOTE: If you disable (uncheck) the Enable Security per SSID option, you will be able to add multiple SSID/VLANSs,
but the same configuration parameters (described below) will applied to all of them.
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3. Click Add to configure additional SSIDs, VLANSs, and their associated security profiles and RADIUS server profiles, or
click Edit to modify existing SSIDs.

The Add Entries or Edit Entries screen appears. See Figure 4-63.
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Figure 4-63 SSID/VLAN Edit Entries Screen (VLAN Tagging Enabled)

4. Enter a unique Network Name (SSID) between 1 and 32 characters. This parameter is mandatory.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the
name.
5. Enter a unique VLAN ID. This parameter is mandatory.
* AVLAN ID is a number from -1 to 4094. A value of -1 means that an entry is “untagged.”

* You can set the VLAN ID to “-1” or “untagged” if you do not want clients that are using a specific SSID to be
members of a VLAN workgroup. Only one “untagged” VLAN ID is allowed per interface.

* The VLAN ID must match an ID used by your network; contact your network administrator if you need assistance
defining the VLAN IDs.
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*  When VLAN is "untagged" and CMOB Status is enabled, the Converged Mobility (CMOB) functionality does not
work.

6. Select the status of Closed System to control whether the SSID is advertised in the beacon and manage the way
probe requests are handled, as follows:

* Enable: The SSID is not advertised in the beacon, and the AP will respond to probe requests with an SSID only if
the client has specified the SSID in the probe request. If the client sends a probe request with a null or “ANY”
SSID, the AP will not respond.

« Partial: The SSID is advertised in the beacon, and the AP will not respond to "ANY" SSID requests. The Partial
setting reduces network traffic by eliminating the repeated broadcast of SSIDs in probe responses.

» Disable: The SSID is advertised in the beacon, and the AP will respond with each configured SSID, whether or
not an SSID has been specified in the probe request.

7. Enable Broadcast Unique Beacon using the drop-down menu. When enabled, Broadcast Unique Beacon allows the
broadcast of a up to four unique beacons when the AP is configured for multiple SSIDs. If Closed System (above) is
set to Partial or Disable, each beacon (up to four) will be broadcast a single SSID. If more than four SSIDs are
configured, then three SSIDs will be broadcast in individual beacons; the fourth and subsequent SSIDs will be
combined in one beacon and will not be broadcast. If Closed System is set to Enable, the SSID will not be broadcast
in the beacon. If Broadcast Unique Beacon is disabled, a combined beacon will be broadcast.

NOTE: Enabling Broadcast Unique Beacon will lower the throughput of the AP by 2-4%. Enabling Broadcast Unique
Beacon simultaneously with Rogue Scan will cause a drift in the beacon interval and the occasional missing of
beacons.

8. Enable or disable the SSID Authorization status from the drop-down menu. SSID Authorization is the RADIUS-based
authorization of the SSID for a particular client. The authorized SSIDs are sent as the tunnel attributes.
9. Enable or disable RADIUS accounting on the VLAN/SSID under the Accounting Status drop-down menu.

10.Enable or disable RADIUS MAC authentication status on the VLAN/SSID under the RADIUS Authentication Status
drop-down menu.

11.Enable or disable MAC Access Control List status on the VLAN/SSID under the MAC ACL Status drop-down menu.

12.Enter the Rekeying Interval in seconds (between 300 and 65525). When set to 0, this parameter is disabled. The
default is 900 seconds.

13.Enter the Security Profile used by the VLAN in the Security Profile field.
NOTE: If you have two or more SSIDs per interface using a Security Profile with a security mode of Non Secure, be
awatre that security being applied in the VLAN is not being applied in the wireless network.
14.Define the RADIUS Server Profile Configuration for the VLAN/SSID:
* RADIUS MAC Authentication Profile
* RADIUS EAP Authentication Profile
* RADIUS Accounting Profile
If 802.1x, WPA, or 802.11i security mode is used, the RADIUS EAP Authentication Profile must have a value.

A RADIUS Server Profile for authentication for each VLAN shall be configured as part of the configuration options for
that VLAN. RADIUS profiles are independent of VLANs. The user can define any profile to be the default and
associate all VLANs to that profile. Four profiles are created by default, “MAC Authentication”, “EAP Authentication”,
Accounting”, and “Management”.

15.Specify a QoS Profile. See the Policy section for more information.

16.Set the 802.1p Priority given to packets tagged with this VLAN ID. Enter a number between 0-7.
17.Set the Maximum TX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.
18.Set the Maximum RX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.

19.If editing an entry, enable or disable the parameters on this page using Status drop-down menu. If adding a new entry,
this drop-down menu will not appear.

20.Reboot the AP.
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This chapter discusses the following monitoring options:

» Version: Provides version information for the Access Point’'s system components.

» ICMP: Displays statistics for Internet Control Message Protocol packets sent and received by the AP.

* IP/ARP Table: Displays the AP’s IP Address Resolution table.

» Learn Table: Displays the list of nodes that the AP has learned are on the network.

* |APP: Provides statistics for the Inter-Access Point Protocol messages sent and received by the AP.

» RADIUS: Provides statistics for the configured RADIUS server(s).

» Interfaces: Displays the Access Point’s interface statistics (Wireless and Ethernet).
» Station Statistics: Displays statistics for stations and Wireless Distribution System links.

* Mesh Statistics: Displays statistics for the Mesh portal, including the network topology and the Neighbor Table.

To monitor the AP using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for

instructions.

You may also monitor the AP using the command line interface. See Command Line Interface (CLI) for more information

To monitor the AP via HTTP/HTTPS:

1. Click the Monitor button located on the left-hand side of the screen. The main Monitor screen will be displayed.

RADIUS |  interfaces | Staon Statistics Mesh A
version 4 ICHP L PARPTable % LeamTable IAPP
Status Menitor
Configure There are nine main categories that provide monitoring and diagnostics information on the access point.
provides information on the version of the access point and its system components.
Commands displays statistics on Internet Control Message Protocol messages received and transmitted by the
access point.
Help provides information on the IP Address Resolution table.
Exit displays entries that have been learned by the access point bridge.
provides statistics on the Inter-Access Point Protocol messages received and transmitted by the
Reboat access point.

provides statistics on the primary and backup RADIUS server(s) configured to communicate with
the access point.

displays access point interface statistics - Ethernet and Wireless.

is used to Monitor Statistics of Wireless Stations and WDS links.

is used to Monitor Mesh neighbor and topology statistics.

Figure 5-1 Monitor Main Screen

2. Click the tab that corresponds to the statistics you want to review. For example, click Learn Table to see the list of

nodes that the AP has discovered on the network.
3. If necessary, click the Refresh () button to update the statistics.

Each Monitor tab is described in the remainder of this chapter.
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Version

From the HTTP interface, click the Monitor button and select the Version tab. The list displayed provides you with
information that may be pertinent when calling Technical Support. With this information, your Technical Support
representative can verify compatibility issues and make sure the latest software are loaded. This screen displays the

following information for each Access Point component:

Serial Number: The component’s serial number, if applicable.

Name/ID: The AP identifies a system component based on its name or ID. Each component has a unique identifier.
Variant: Several variants may exist of the same component (for example, a hardware component may have two

variants, one with more memory than the other).

Version: Specifies the component’s version or build number. The Software Image version is the most useful
information on this screen for the typical end user.

RADIUS

\

Interfaces

1 Station Statistics \ Mesh Statistics

AN

ICHP -\ IF ARP Table \

Leamn Table ‘\

IAPP

This tab displays version information of the access point system components. This information can be
used by Technical Support to dizgnose incompatibility issues and to determine if updated software or
drivers are required and available.
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Figure 5-2 Version Monitoring Tab
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ICMP

This tab provides statistical information for both received and transmitted messages directed to the AP. Not all ICMP
traffic on the network is counted in the ICMP (Internet Control Message Protocol) statistics.

RADILS \ Interfaces 1 smunnsmsucs\ Kesh Statistics \
Version ICHP \ IP ARP Table \ Leam Table \ IAPP \

Thi= taby provides etatstics on the Internet Contral Message Profocod (ICMP) packets transmitted and
received by the sccess point.
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Figure 5-3 ICMP Monitoring Tab
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IP/ARP Table

This tab provides information based on the Address Resolution Protocol (ARP), which relates MAC Address and IP

Addresses.

RADIS \ Intarfzcas -\ Station Stalistics \ Mash Statistics \

Version ICKP IF ARF Table \_ Leam Tabls “\_ I5FP

This tob provides detalls on the [P Address Resclution Protocol (ARP] tablo. This inble displays 1@ to MAC
adroa s regclution.

MAC Address 1P Address Redia Type
02004655 F3.51 160 254.50.3 Static
0 AF D ARED 16025 145 230 Dyrrarnic

2

Figure 5-4 IP/ARP Table Monitoring Tab
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Learn Table

This tab displays information relating to network bridging. It reports the MAC address for each node that the device has
learned is on the network and the interface on which the node was detected. There can be up 10,000 entries in the Learn
Table.

RADIUS \ Interfaces \ Stalion Stalictics \ Mesh Sialistics -\
-

Version IGHP IP ARP Table Learn Table \ LAFP \

This tzb displays the bridge learn lable, that containg MAC addresses and part numbers on which wired
hosts and wircless clients reside.

9)

MAC Adilrass Por
pOo=1ED1 AQSD ]

Figure 5-5 Learn Table Monitoring Tab
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IAPP

This tab displays statistics relating to client handovers and communications between Access Points.

RADIUS \ Interfaces \ Station Stalistics \ Mesh Stalistics \

Wersion ICMF IF AR Table Learn Table AFF 1_

This tab digplays Inter Access Podnt Protocol (LAPP) siatistics. Siatatics include IAPP packets recenved and
transmited by the stcess point 48 well as the number of roamdng wirelés s chents,

)
Handover Response Received i Announce Regquesi Sent 2
Annpunce Request Recenead i Announce Response Sent 1682
Announce Respanse Received 0 Handover Reguest Sent )
Handower Request Recened 0 Handowver Response Sent o
Handover Requést Retransmission o Dmopped FDUs o
Number of Roaming Clients o

Figure 5-6 IAPP Monitoring Tab
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RADIUS

This tab provides RADIUS authentication, EAP/802.1x authentication, and accounting information for both the Primary
and Backup RADIUS servers for each RADIUS Server Profile.

NOTE: Separate RADIUS servers can be configured for each RADIUS Server Profile.

Select the RADIUS Server Profile to view statistics on from the Select Server Profile drop-down menu.

Version -\ ICHIP

'\ IP ARP Table '\ Leaim Table

Select Server Profile

IsFP RADILS
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Primary Server Authentication
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&ccess Challenges
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Backup Server Authentication
Statistics
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Access Rejecls
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This tab provides siatietcs on the primary and backup RADUS [Authentication and Actounting) server{g)
with which the access point is configured 1o COmMMUNCate.

()

Figure 5-7 RADIUS Monitoring Tab
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Interfaces

This tab displays statistics for the Ethernet and wireless interfaces.

version \ ICMP \ IP ARP Tabis \ Leam Table 1

laPP RADIUS

This tab provides information and statistics on the acoess point Ethermet interface.
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Figure 5-8 Interface Monitoring Tab (Ethernet)

Description of Interface Statistics

The following statistics are displayed for the Ethernet interface only, either of the wireless interfaces only, or for all

interfaces:

» Admin Status (Ethernet/Wireless-Slot A/B): The desired state of the interface: Up (ready to pass packets), Down (not

ready to pass packets, or Testing (testing and unable to pass packets).

Alignment Error (Ethernet): The number of frames received that are not an integral number of octets in length and do
not pass the Frame Check Sequence check.

Carrier Sense Errors (Ethernet): The number of times that the carrier sense condition was lost or never asserted
when attempting to transmit a frame. The count increments at most once per transmission attempt.

Deferred Transmission (Ethernet): The number of frames for which the first transmission attempt is delayed because
the medium is busy.This number does not include frames involved in collisions.

Description (Ethernet/Wireless-Slot A/B): Information about the interface (e.g., the name of the manufacturer, the
product name and the version of the hardware interface).

Duplicate Frame Count (Wireless-Slot A/B): The number of duplicate frames received.
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Ethernet Chipset (Ethernet): Identifies the chipset used to realize the interface.
Excessive Collisions (Ethernet): The number of frames for which transmission fails due to excessive collisions.

Failed ACK Count (Wireless-Slot A/B): The number of times an acknowledgment (or ACK) is not received when
expected.

Failed Count (Wireless-Slot A/B): The number of packets not transmitted successfully due to too many transmit
attempts.

Failed RTS Count (Wireless-Slot A/B): The number of times a Clear to Send (CTS) is not received in response to a
Request to Send (RTS).

FCS Error (Wireless-Slot A/B): The number of Frame Check Sequence errors detected in received MAC Protocol
Data Units (MPDUs).

FCS Errors (Ethernet): The number of frames received that are an integral number of octets in length but do not pass
the Frame Check Sequence check.

Frames Too Long (Ethernet): The number of frames received that exceed the maximum permitted frame size.

In Discards (Ethernet/Wireless-Slot A/B): The number of error-free inbound packets that were chosen to be
discarded to prevent their being deliverable to a higher-layer protocol. One possible reason for discarding such a
packet could be to free up buffer space.

In Errors (Ethernet/Wireless-Slot A/B): The number of inbound packets that contained errors preventing them from
being deliverable to a higher-layer protocol.

In Non-unicast Packets (Ethernet/Wireless-Slot A/B): The number of non-unicast (i.e., subnetwork-broadcast or
subnetwork-multicast) packets delivered to a higher-layer protocol.

In Octets (bytes) (Ethernet/Wireless-Slot A/B): The total number of octets received on the interface, including framing
characters.

In Unicast Packets (Ethernet/Wireless-Slot A/B): The number of subnetwork unicast packets delivered to a
higher-layer protocol.

Internal MAC Receive Errors (Ethernet). The number of frames for which reception fails due to an internal MAC
sublayer transmit error. A frame is only counted if it is not counted by the Frames Too Long, Alignment Error, or FCS
Error counters.

Internal MAC Transmit Errors (Ethernet): The number of frames for which transmission fails due to an internal MAC
sublayer transmit error. A frame is only counted if it is not counted by Late Collision, Excession Collision, or Carrier
Sense Error counters.

Last Change (Ethernet/Wireless-Slot A/B): The value of the sysUpTime object at the time the interface entered its
current operational state.

Late Collisions (Ethernet): The number of times that a collision is detected on a particular interface later than 512
bit-times into the transmission of a packet

MAC Address (Wireless-Slot A/B): The station's assigned, unique MAC address,

Maximum Packet Size (Ethernet/Wireless-Slot A/B): The size (in octets) of the largest datagram which can be
sent/received

MIB Specific Definition (Ethernet/Wireless-Slot A/B): A reference to MIB definitions specific to the particular media
being used to realize the interface. For example, if the interface is an Ethernet interface, then this field refers to a
document defining objects specific to ethernet.

Multicast Received Frame Count (Wireless-Slot A/B): The number of multicast packets received.
Multicast Transmitted Frame Count (Wireless-Slot A/B): The number of multicast packets transmitted.

Multiple Collision Frames (Ethernet): The number of successfully transmitted frames for which transmission is
inhibited by more than one collision.

Multiple Retry Count (Wireless-Slot A/B): The number of packets successfully transmitted after more than one
retransmission.

Operational Status (Ethernet/Wireless-Slot A/B): The current state of the interface: Up (ready to pass packets),
Down (not ready to pass packets, or Testing (testing and unable to pass packets).
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Out Discards (Ethernet/Wireless-Slot A/B): The number of error-free outbound packets chosen to be discarded to
prevent their being transmitted. One possible reason for discarding such a packet could be to free up buffer space.

Out Errors (Ethernet/Wireless-Slot A/B): The number of outbound packets that could not be transmitted because of
errors.

Out Non-unicast Packets (Ethernet/Wireless-Slot A/B): The total number of packets that higher-level protocols
requested be transmitted to a non-unicast (i.e., a subnetwork-broadcast orsubnetwork-multicast) address, including
those that were discarded or not sent.

Out Octets (bytes) (Ethernet/Wireless-Slot A/B): The total number of octets transmitted out of the interface, including
framing characters.

Out Unicast Packets (Ethernet/Wireless-Slot A/B): The total number of packets that higher-level protocols requested
be transmitted to a subnetwork-unicast address, including those that were discarded or not sent.

Output Queue Length (Ethernet/Wireless-Slot A/B): The length of the output packet queue (in packets).

Physical Address (Ethernet): The interface's address at the protocol layer immediately below the network layer in the
protocol stack.

Received Fragment Count (Wireless-Slot A/B): The number of successfully received Data or Management MAC
Protocol Data Units (MPDUs).

Retry Count (Wireless-Slot A/B): The number of packets successfully transmitted after one or more retransmissions.

Single Collision Frames (Ethernet): The number of successfully transmitted frames for which transmission is
inhibited by exactly one collision

Speed (Ethernet/Wireless-Slot A/B): An estimate of the interface's current bandwidth in bits per second.

SQE Test Errors (Ethernet): The number of times that the Signal Quality Error (SQE) Test Error message is
generated by the physical layer signalling (PLS) sublayer.

Successful RTS Count (Wireless-Slot A/B): The number of times a Clear to Send (CTS) is received in response to
an Request to Send (RTS).

Transmitted Fragment Count (Wireless-Slot A/B): The number of transmitted fragmented packets.
Transmitted Frame Count (Wireless-Slot A/B): This number of successfully transmitted packets.

Type (Ethernet/Wireless-Slot A/B): The type of interface, distinguished according to the physical/link protocol(s)
immediately below the network layer in the protocol stack.

Unknown Protocols (Ethernet/Wireless-Slot A/B). The number of packets received that were discarded because of
an unknown or unsupported protocol.

WEP Undecryptable Count (Wireless-Slot A/B): The number of undecryptable WEP frames received.
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Station Statistics
This tab displays information on wireless clients attached to the AP and on Wireless Distribution System.

Enable the Monitoring Station Statistics feature (Station Statistics are disabled by default) by checking Enable
Monitoring Station Statistics and click OK.

You do not need to reboot the AP for the changes to take effect. If clients are connected to the device or WDS links are
configured for the device, the statistics will now be shown on the screen. Click Select to view the more detailed statistics
for a client.

Click on the Refresh button in the browser window to view the latest statistics. If any new clients associate to the AP, you
can see the statistics of the new clients after you click the refresh button.

Version \ ICMP \ IP ARP Table \ Learn Table \

IAPP RADIUS Interfaces Station Statistics \ Mesh \

This screen displays the statistics related to associated stations and WDS links.

The foll

wing information is displayed:

: MAC address of associated station or partner MAC address of WDS link.

: IP Address of associated station/Mesh Unit or 0.0.0.0 for WDS links.

Interface on which the station is associated or the WDS link is configured.

: 5TA (5tation) or WDS

col : 802.11a, 802.11b or 802.11g

5 Signal to Noise Ratio.

TSLF : Time since last frame was received from the associated station or WDS link partner.

ess

A station will no lor e client

WDS links are show

Enable Monitoring Station Statistics 72
OK ; Cancel
MAC Address IP Address Interface Protocol SNR  TSLF
Select J

Number of stations and WDS links : 0

Figure 5-9 Station Statistics Monitoring Tab

Description of Station Statistics
The following stations statistics are displayed:
 MAC Address: The MAC address of the wireless client for which the statistics are gathered. For WDS links, this is the
partner MAC address of the link.

» |IP Address: The IP address of the associated wireless station for which the Statistics are gathered. (0.0.0.0 for WDS
links)

« Interface to which the Station is connected: The interface number on which the client is connected with the AP. For
WDS links this is the interface on which the link is configured.

» Type: The type of wireless client (STA or WDS).

* MAC Protocol: The MAC protocol for this wireless client (or WDS link partner). The possible values are 802.11a,
802.11b, 802.11g.

« Signal / Noise: The Signal /Noise Level measured at the AP when frames are received from the associated wireless
station (or WDS link partner).
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» Time since Last Frame Received: The time elapsed since the last frame from the associated wireless station (or
WDS link partner) was received.

*  Number of Stations and WDS Links: The number of stations and WDS links monitored.

The following stations statistics are available through SNMP:

* Octets Received: The number of octets received from the associated wireless station (or WDS link partner) by the
AP.

* Unicast Frames Received: The number of Unicast frames received from the associated wireless station (or WDS link
partner) by the AP.

* Non-Unicast Frames Received: The number of Non-Unicast frames received (i.e. broadcast or multicast) from the
associated wireless station (or WDS link partner) by the AP.

* Octets Transmitted: The number of octets sent to the associated wireless station (or WDS link partner) from the AP.

* Unicast Frames Transmitted: The number of Unicast frames transmitted to the associated wireless station (or WDS
link partner) from the AP.
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Mesh Statistics

This Mesh tab and its related sub-tabs display statistics relating to Mesh functionality. See the following sections:

« Topology

* Neighbors

» Link Statistics
* Link Test

Topology
The Topology sub-tab displays the network topology of the Mesh network.

Version \ ICHP \ IP ARP Table \ LeamTable |

I14PP RADIUS Interfaces Station Statistics Mesh \
Topology &  MNeighbors %  LinkStatistcs %  LinkTest 4
This tab displays the topology of the Mesh network. c )

Total Number of Mesh Access Points : 1

(&) ORINOCO-AP-4000M-5e-65-b0 (00:20:A5:5E:65:80) Mesh Partal

Figure 5-10 Mesh Statistics Topology Sub-Tab

Neighbors

The Neighbors sub-tab displays the system name, IP address, channel, path cost, number of hops to portal, Mesh type,
and status of all Mesh APs within range of the AP.

Version \ ICIIP \ IP ARP Table \ LeamTable |
I14PP RADIUS Interfaces Station Statistics Mesh \
Topology Meighbors \ Link Statistics \ Link Test \
This tab provides a list of Mesh neighbors. c}
System Name IP Address Ch Cost Hops Type Status

Figure 5-11 Mesh Statistics Neighbors Sub-Tab

Link Statistics

The Link Statistics sub-tab displays the MAC address, IP address, receive rate, transmit rate, receive errors, transmit
errors, and SNR for each Mesh link.
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Version \ ICHP \ IP ARP Table \ LeamTable |

I14PP RADIUS Interfaces Station Statistics Mesh \
Topology Meighbors Link Statistics \ Link Test \
This tab provides information and statistics on mesh links. c)
Enable Maonitoring Mesh Link Statistics I
014 Cancel

Mesh Link Statistics

MAC Address IP Address Rx Rate TxRate RxErrors TxErrors SHNR

Select
Mumber of Mesh Access Points : 0

Figure 5-12 Mesh Statistics Link Statistics Sub-Tab

Link Test
The Link Test tab allows you to run two types of Mesh link tests: Tree Type or Neighbor Type.

The Tree Type link test is initiated from the Portal to any point on the Mesh tree. The Mesh units involved in the test must
be in the "Active" state

The Neighbor Type link test is initiated from any Mesh unit and to any other Mesh unit in its neighbor list the is in the
"Connected"/"Active" state. The Mesh units involved in the test must be on the same channel.
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Wersion \ ICMP \ IP ARP Table \ Learn Table \

I4PP RADIUS Interfaces Station Statistics Mesh

Topology Meighbors Link Statistics Link Test \

This tab enables Mesh link tests and displays test results.

Mesh Link Test Trigger

Test Type Trze Type ;I

Destination System Name ;I

Test Traffic Rate 10 (1to 100 Frames per sec)
Frame Size |E-DD (400 to 1024 Bytes)

Test Duration |1n (1to 300 Secs)

Link Test ’

Currently Running Mesh Link Test(s)

TestID Test Type Destination Traffic Rate Frame Size Test Duration Time to Finish
System Name (frames/sec) (bytes) (secs) (secs)

Mesh Link Test Result(s)

TestlD TestType Frames Frames Average Round Destination
Sent Rec'd Trip {microsec) System Name

($)

Figure 5-13 Mesh Statistics Link Test Sub-Tab

To execute a Link Test, set the following parameters:

» Test Type: Tree Type or Neighbor Type

» Destination System Name: The destination Mesh unit.

» Test Traffic Rate: The number of frames per second to test.
* Frame Size: The size of each frame in test.

» Test Duration: The duration for the entire whole test

When a test is running, it will appear in the “Currently RUnning Mesh Link Test” section of the page. The “Time to Finish

field updates on each page refresh.

Upon completion of a test, the test will appear under the “Mesh Link Test Results” section of the page. To view full results,
select radio button of the desired test; results will be displayed in a new window., new window will open.

NOTES:

*  No more 10 tests can be running and complete simultaneously. (For instance, if there are 5 tests running and 5 tests

finished, when a sixth test begins to run, the oldest result will be deleted.)
« Any topology change will delete all Tree Type tests (running or complete).
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This chapter contains information on the following Command functions:

* Introduction to File Transfer via TFTP or HTTP: Describes the available file transfer methods.
* Update AP: Download files via TFTP or HTTP to the AP.

» Retrieve File: Upload configuration files from the AP to a TFTP server.

* Reboot: Reboot the AP in the specified number of seconds.

* Reset: Reset all of the Access Point’s configuration settings to factory defaults.

» Help Link: Configure the location where the AP Help files can be found.

To perform commands using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for
instructions.

You may also perform commands using the command line interface. See Command Line Interface (CLI) for more
information.

To perform commands via HTTP/HTTPS:

1. Click the Commands button located on the left-hand side of the screen.

Update AP | RefieveFile % Reboot L Reset 1 Help Link \
Status Commands
= T i int.
Configure here are five commands that can be executed on the access point.
Manitor
is used to upload files via TFTP/HTTP to the access point. This feature can be used to upgrade
the access point and upload configuration files.
is used to retrieve configuration file from the access point via TFTP/HTTP. This feature can be
used to backup the access point configuration file,
Help
allows you to reboot the access point in the specified number of seconds.
Exit set .qurati . . : ault v
will reset all the configuration settings of the access point to the factory default values.
Reboot is used to configure where the access point help information can be retrieved.

Figure 6-1 Commands Main Screen

2. Click the tab that corresponds to the command you want to issue. For example, click Reboot to restart the unit.

Following a brief introduction to TFTP and HTTP file transfer, each Commands tab is described in the remainder of this
chapter.
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Introduction to File Transfer via TFTP or HTTP
There are two methods of transferring files to or from the AP: TFTP or HTTP (or HTTPS if enabled):

» Downloading files (Configuration, AP Image, Bootloader, License, Private Key, Certificate, CLI Batch File) to the AP
using one of these two methods is called “Updating the AP.”

* Uploading files (Configuration, CLI Batch File, etc) from the AP is called “Retrieving Files.”

TFTP File Transfer Guidelines

A TFTP server must be running and configured to point to the directory containing the file.

If you do not have a TFTP server installed on your system, install the TFTP server from the installation CD.

HTTP File Transfer Guidelines

HTTP file transfer can be performed either with or without SSL enabled.

HTTP file transfers with SSL require enabling Secure Management and Secure Socket Layer. HTTP transfers that use
SSL may take additional time.

NOTE: SSL requires Internet Explorer version 6, 128 bit encryption, Service Pack 1, and patch Q323308.

Image Error Checking During File Transfer

The Access Point performs checks to verify that an image downloaded through HTTP or TFTP is valid. The following
checks are performed on the downloaded image:

» Zero Image size

* Large image size

* Non VxWorks image

* AP image

» Digital signature verification

If any of the above checks fail on the downloaded image, the Access Point deletes the downloaded image and retains the
old image. Otherwise, if all checks pass successfully, the AP deletes the old image and retains the downloaded image.

These checks are to ensure that the AP does not enter an invalid image state. The storage of the two images is only
temporary to ensure the proper verification; the two images will not be stored in the AP permanently.

Image error checking functions automatically in the background. No user configuration is required.
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Update AP

Update AP via TFTP

Use the Update AP via TFTP tab to download Configuration, AP Image, License file, Bootloader files, Certificate and
Private Key files, and CLI Batch File to the AP. A TFTP server must be running and configured to point to the directory
containing the file.

sale AP \h\ RetieveFile 1§ Reboot Y Rusel N Hepunk )
WaTFTP \ wia HTTP -\

This page is used to update software images, license file and configuration file in
the Access Point using TFTP.

Hote: On updating configuration file the Access Point will reboot by itsalf.

System Infermation

oftware Version a.4.0
o0t Laader Yersion 310

(=

TFTP Information

Server IF Address [0z
File Hame [2F sai
Fila Type II‘Hat .I
Fila Oparation [vedsta ar =]
Lipdata AP 3 Cantel 8

Figure 6-2 Update AP via TFTP Command Screen

If you do not have a TFTP server installed on your system, install the TFTP server from the installation CD. You can either
install the TFTP server from the CD Wizard or run OEM-TFTP-Server.exe found in the CD’s Xtras/SolarWinds
sub-directory.

The Update AP via TFTP tab shows version information and allows you to enter TFTP information as described below.

+ Server IP Address: Enter the TFTP server IP Address.
— Double-click the TFTP server icon on your desktop and locate the IP address assigned to the TFTP server.

NOTE: This is the IP address that will be used to point the Access Point to the AP Image file.

* File Name: Enter the name of the file to be downloaded (including the file extension).
— Copy the file to the TFTP server’s root folder.
» File Type: Select the proper file type. Choices include:
— Config: configuration information, such as System Name, Contact Name, and so on.

NOTE: The AP will reboot automatically when downloading a Config file.

— Image: AP Image (executable program).

— Upgrade BspBIl: Bootloader software.

— SSL Certificate: the digital certificate for authentication in SSL communications.

— SSL Private Key: the private key for encryption in SSL communications.

— SSH Public Key: the public key in SSH communications. See Secure Shell (SSH) Settings for more information.
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— SSH Private Key: the private key in SSH communications. See Secure Shell (SSH) Settings for more information.

— CLI Batch File: a CLI Batch file that contains CLI commands to configure the AP. This file will be executed by the
AP immediately after being uploaded. See CLI Batch File for more information.

— License File
» File Operation: Select either Update AP or Update AP & Reboot. You should reboot the AP after downloading files.

Update AP via HTTP

Use the Update AP via HTTP tab to download Configuration, AP Image, Bootloader files, and Certificate and Private Key
files to the AP.

Once on the Update AP screen, click on the via HTTP tab.
"\ Rerievarie | Reboot | Reset | Heplink |
via TFTP 3 HTTF \k

This page is used to update software images, license file and configuration files in
the Access Point uging HTTP file transfer. Click on the browse button to search Tor
the file or enter the path in the téxt box Select the file type and click the Update AP
bution to start the file transfer,

Rote: On updating configuration file the Acceas Poinl will reboot by itgel

System Infarmation

Saftware Version XXX
Boat Loader Version XXX

File Type Ilmage 'FI
File Name  [AP.sei Browse... |

Update AF | Can:el|

Figure 6-3 Update AP via HTTP Command Screen

The Update AP via HTTP tab shows version information and allows you to enter HTTP information as described below.

1. Select the File Type that needs to be updated from the drop-down box. Choices include:
— Image for the AP Image (executable program).
— Config for configuration information, such as System Name, Contact Name, and so on.

NOTE: The AP will reboot automatically when downloading a Config file.

— SSL Certificate: the digital certificate for authentication in SSL communications.
— SSL Private Key: the private key for encryption in SSL communications.
— Upgrade BSPBL.: the Bootloader software.

— CLI Batch File: a CLI Batch file that contains CLI commands to configure the AP. This file will be executed by the
AP immediately after being uploaded. See CLI Batch File for more information.

— SSH Public Key: the public key in SSH communications. See Secure Shell (SSH) Settings for more information.
— SSH Private Key: the private key in SSH communications. See Secure Shell (SSH) Settings for more information.
— License File

2. Use the Browse button or manually type in the name of the file to be downloaded (including the file extension) in the
File Name field. If typing the file name, you must include the full path and the file extension in the file name text box.

3. Toinitiate the HTTP Update operation, click the Update AP button.
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A warning message gets displayed that advises the user that a reboot of the device will be required for changes to

take effect.
x|
‘y ou are updatng Image file to the AP, You wil nead to reboat the device fior changes to take effect. Do you want to procesd 7

o | ceee |

Figure 6-4 Warning Message

4. Click OK to continue with the operation or Cancel to abort the operation.
NOTE: An HTTP file transfer using SSL may take extra time.

If the operation completes successfully the following screen appears.

HTTF Update was Successful.

Figure 6-5 Update AP Successful

If the operation did not complete successfully the following screen appears, and the reason for the failure is displayed.

HTTF Update of AP was not successful,
File was Zero Bytes.

Figure 6-6 Update AP Unsuccessful
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Retrieve File

Retrieve File via TFTP

Use the Retrieve File via TFTP tab to upload files from the AP to the TFTP server. The TFTP server must be running
and configured to point to the directory to which you want to copy the uploaded file. We suggest you assign the file a
meaningful name, which may include version or location information.

If you don’t have a TFTP server installed on your system, install the TFTP server from the installation CD. You can either
install the TFTP server from the CD Wizard or run OEM-TFTP-Server.exe found in the CD’s Xtras/SolarWinds
sub-directory.

The Retrieve AP via TFTP tab shows version information and allows you to enter TFTP information as described below.

» Server IP Address: Enter the TFTP server IP Address.

— Double-click the TFTP server icon on your desktop and locate the IP address assigned to the TFTP server.
» File Name: Enter the name of the file to be uploaded.
» File Type: Select the type of file to be uploaded: Config file, CLI Batch File, or CLI Batch (Error) Log.

Use the following procedure to retrieve a file from an AP to a TFTP server:

1. If retrieving a Config file, configure all the required parameters in their respective tabs. Reboot the device.

2. Retrieve and store the file. Click the Retrieve File button to initiate the upload of the file from the AP to the TFTP
server.

3. If you retrieved a Configuration file, update the file as necessary.

4. If you retrieved a CLI Batch File or CLI Batch Log, you can examine the file using a standard text editor. For more
information on CLI Batch Files, see CLI Batch File.

Update AP Refrieva File \ Reboot \_ Reset \'.‘_ Help Link \
via TFTF \ vig HTTP \

This page i% used 1o retrieve configuration file, latest CLI bateh rile, and CLI bateh e
expecution log from the Access Point using TFTP

System Infermation

Softerare Version J.4.0
Boot Loader Version 310

TFTP Infermation

Sarer P Address [180.254 122 122
File Mame [FILENAME
File Type | config =]

CLI Bateh File .
CLI Batch Lag Cancel 3

Figure 6-7 Retrieve File via TFTP Command Screen
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Retrieve File via HTTP

Use the Retrieve File via HTTP tab to retrieve configuration files, CLI Batch Files, or CLI Batch Logs from the AP. For

more information on CLI Batch Files and CLI Batch Logs see CLI Batch File.

1. Select the type of file (Config, CLI Batch File, CLI Batch Log) from the File Type drop-down menu.

2. Click on the Retrieve File button to initiate the operation.

Lipdate 4P Refrieve Flle \ Reboot \ Resel \
via TFTP via HTTF \

This page is used to retrieve configuration file, latest CLI batch file, and CLI batch file
execution log Trom the Access Point uging HTTP file transfer. Click the Retrieve File
button 1o start the file transfer.

System Information

Softwrare Version J.4.0
Boot Loader Version 3.1.0
File Type [Cantig =]

CLI Bateh Fila -
LI Bateh Log Cancel 4

Help Link

\

Figure 6-8 Retrieve File via HTTP Command Screen

A confirmation message is displayed, asking if the user wants to proceed with retrieving the file.

Microsoft Internet Explorer x|

i\?‘) ou are retrieving Config fle From the AP, Do wow want to procesd 7

[ ox | comel |

Figure 6-9 Retrieve File Confirmation Dialog

3. Click OK to continue with the operation or Cancel to abort the operation. On clicking OK, the File Download window

appears.
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File Download

Saome fles can harm your computer. IF the file nfarmation balow
looks suspecious, o pou da nok fully trust the sowmce, do not open o
save thiz file,

File name:  AP-Config
File type:
From: 169.254.50.3

‘w'oudd wou like to open the file or save it bo your computer?

Open || Save I Cancel More Info

|

¥ Alwaps ask before opening this bpe of fle

Figure 6-

10 File Download Dialog Box

4. On clicking the Save button the Save As window displays. Select an appropriate filename and location and click OK.
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Reboot

Use the Reboot tab to save configuration changes (if any) and reset the AP. Enter a value between 0 and 65535
seconds; entering a value of 0 (zero) seconds causes an immediate reboot. Note that Reset, described below, does not
save configuration changes.

CAUTION: Rebooting the AP will cause all users who are currently connected to lose their connection to the network
until the AP has completed the restart process and resumed operation.

Updale AP Retrieve File Rebool & Reset % Heplink %

Thie tab i used to reboot the access point by epecifying the number of seconds
before the next reboot. The access point reboots immediately by entering a value of
ZEero.

Warmning: Rebooting the access point will cause aff users wito are corrently connected
to lose their connection to the wetwork uatif the pnit has completed the rostart
process and resurred operation.

Please enter the time o reboot (seconds) Io

Raboa '

Figure 6-11 Reboot Command Screen
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Reset

Use the Reset tab to restore the AP to factory default conditions. Since this will reset the AP’s current IP address, a new
IP address must be assigned. See Logging In for more information.

CAUTION: Resetting the AP to its factory default configuration will permanently overwrite all changes that have made to
the unit. The AP will reboot automatically after this command has been issued.

Update AP Ratrieve File Reboot Reset \ Help Link 1

This taby is used to reset the access point configuration to factorny defaull values.

Waraing: Resedting the gccess point to iz factory defaunt confiquration will canse alf changoes that have
Bep mrade to the gl to e perimarertly fost, The dccess podut will reboot orce this functioR @5 execaied.

Reszat to Factory Default d

Figure 6-12 Reset to Factory Defaults Command Screen
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Help Link
Use the Help tab to configure the location of the AP Help files.

During initialization, the AP on-line help files are downloaded to the default location:

C:/Program Files/ORiINOCO/AP-4000MR/HTML/index.htm.

To enable the Help button on each page of the Web interface to access the help files, however, copy the entire Help

folder to a web server, then specify the new HTTP path in the Help Link box.

NOTE: The configured Help Link must point to an HTTP address in order to enable the Help button on each page of the

Web interface.

NOTE: Use the forward slash character ("/") rather than the backslash character ("\") when configuring the Help Link

location.

NOTE: Add the AP’s management IP address into the Internet Explorer list of Trusted Sites.

Update AP Retriave File Reboot Reset Help Link

This tab is used to configure the location of access point help information. Please enter a localion where
woir brdvaeser can fimd the Help Infarmation
For example:

* A Pathto a Local Directory (i.e. file:i0C:Program Fileshelpaccesspointindex. htm),
# A Path to a Mapped Drive (Le. filewiGrsharedhelpiaccesspointindee.htmp, or
# An HTTPURL Address (e hiflpuiswwwaccesspoint.oomobelpindeshtm)

Mote: Dwe to securily changes in wiernet Explorar, @ fink to @ focal or mapped drive may mot work vufess
the IP address of the Access Polut iz added to the Trasted Sites of kternet Explorer (Security fab undoer
Inferaet Qptions), There is po Erows method for epabliing finks to focal oF mapped drives with Melscape,
The wser may instafi the kelp fites on an fnternal or exteranal web site and point the link to it

Halp Link 'Tlle:.'.ﬁti:.l’rugram Fileshelp/accesspointindex.html

(0] 4 i Cancel 'i

X

Figure 6-13 Help Link Configuration Screen
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This chapter provides information on the following:

Troubleshooting Concepts
Symptoms and Solutions
Recovery Procedures
Related Applications

NOTE: This section helps you locate problems related to the AP device setup. For details about RADIUS, TFTP, serial

communication programs (such as HyperTerminal), Telnet applications, or web browsers, please see the
documentation that came with the respective application for assistance.

Troubleshooting Concepts

The following list identifies important troubleshooting concepts and topics. The most common initialization and
installation problems relate to IP addressing. For example, you must have valid IP addresses for both the AP and the
management computer to access the unit’'s HTTP interface.

IP Address management is fundamental.

Factory default units are set for “Dynamic” (DHCP) IP Address assignment. The default IP address for the AP is
169.254.128.132 if your network does not have a DHCP server. If you connect the AP to a network with an active
DHCP server, then use ScanTool to locate the IP address of your unit. If a DHCP server is not active on your subnet,
then use ScanTool to assign a static IP address to the unit.

The Trivial File Transfer Protocol (TFTP) provides a means to download and upload files. These files include
the AP Image (executable program) and configuration files.

If the AP password is lost or forgotten, you will need to reset to default values. The Soft Reset to Factory
Defaults or Hard Reset to Factory Defaults procedures reset the configuration, but do not change the current AP
Image.

The AP Supports a Command Line Interface (CLI). If you are having trouble locating your AP on the network,
connect to the unit directly using the serial interface and see Command Line Interface (CLI) for CLI command syntax
and parameter names.

ScanTool does not work over routers. You must be connected to the same subnet/physical LAN segment to use
ScanTool. Note that ScanTool also works over the wireless interface; you can run it on a wireless client connected to
the target AP or an AP connected to the same LAN segment/subnet.

If all else fails... Use the Forced Reload procedure to erase the current AP Image and configuration file and then
download a new image.
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Symptoms and Solutions

Connectivity Issues

Connectivity issues include any problem that prevents you from powering up or connecting to the AP.

AP Unit Will Not Boot - No LED Activity
1. Make sure your power source is operating.
2. Make sure all cables are connected to the AP correctly.
3. If you are using PoE, make sure you are using a Category 5, foiled, twisted pair cable to power the AP.

Serial Link Does Not Work
1. Make sure you are using a standard, straight-through, 9-pin serial cable.
2. Double-check the physical network connections.
3. Make sure your PC terminal program (such as HyperTerminal) is active and configured to the following values:
— Com Port: (COM1, COM2, etc. depending on your computer);
— Baud rate: 9600; Data bits: 8; Stop bits: 1; Flow Control: None; Parity: None;

— Line Feeds with Carriage Returns
(In HyperTerminal select: File > Properties > Settings > ASCII Setup > Send Line Ends with Line Feeds)

Ethernet Link Does Not Work

1. Double-check the physical network connections. Use a known-good unit to make sure the network connection is
present. Once you have the AP IP address, you can use the “Ping” command over Ethernet to test the IP Address. If
the AP responds to the Ping, then the Ethernet Interface is working properly.

2. By default, the Access Point will attempt to automatically detect the Ethernet settings. However, if you are having
problems with the Ethernet link, manually configure the Access Point’s Ethernet settings. For example, if your switch
operates at 100 Mbits/sec/Full Duplex, manually configure the Access Point to use these settings (see Ethernet). If
you cannot access the unit over Ethernet, then use the CLI interface over the serial port to configure the Ethernet port
(see Command Line Interface (CLI) and Set Ethernet Speed and Transmission Mode).

3. Perform network infrastructure troubleshooting (check switches, routers, etc.).

Basic Software Setup and Configuration Problems

Lost AP, Telnet, or SNMP Password

1. Perform the Soft Reset to Factory Defaults in this guide. This procedure resets system and network parameters, but
does not affect the AP Image. The default AP HTTP, Telnet, and SNMP passwords are all public.

Client Computer Cannot Connect
1. Client computers should have the same Network Name and security settings as the AP.
2. Network Names should be allocated and maintained by the Network Administrator.
3. See the documentation that came with your client card for additional troubleshooting suggestions.

AP Has Incorrect IP Address

1. Default IP Address Assignment mode is dynamic (DHCP). If you do not have a DHCP server on your network, the
default IP Address is 169.254.128.132. If you have more than one unintialized AP connected to the network, they will
all have the same default IP address and you will not be able to communicate with them (due to an IP address
conflict). In this case, assign each AP a static IP address via the serial cable or turn off all units but one and change
the IP address using ScanTool one at a time.
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2. The AP only contacts a DHCP server during boot-up. If your network’s DHCP server is not available while the AP is
booting, the device will use the default IP address (169.254.128.132). Reboot the AP once your DHCP server is
on-line again or use the ScanTool to find the Access Point’s current IP address.

3. To find the unit’s current IP address if using DHCP, open the IP Client Table in the DHCP Server and match the
Access Point’s IP address to its MAC address (found on the product label). Alternatively, use ScanTool to identify an
Access Point’s current IP address.

4. Once you have the current IP address, use the HTTP or CLI Interface to change the unit’s IP settings, if necessary.

5. If you use static IP Address assignments, and cannot access the unit over Ethernet, use the Initializing the IP Address
using CLI procedure. Once the IP Address is set, you can use the Ethernet Interface to complete configuration.

6. Perform the Soft Reset to Factory Defaults in this guide. This will reset the unit to “DHCP” mode. If there is a DHCP
Server on the network, the DHCP Server will assign an IP Address to the AP.

HTTP Interface or Telnet Interface Does Not Work
1. Make sure you are using a compatible browser:
— Microsoft Internet Explorer 6 with Service Pack 1 or later
— Netscape 7.1 or later

2. Make sure you have the proper IP address. Enter your Access Point’s IP Address in the browser address bar, similar
to this example:
http://192.168.1.100
When the Enter Network Password window appears, leave the User Name field empty and enter the HTTP
password in the Password field. The default HTTP password is public.

3. Use the CLI over the serial port to check the IP Access Table, which can be restricting access to Telnet and HTTP.

HTML Help Files Do Not Appear

1. Verify that the HTML Help files are installed in the default directory:
C:/Program Files/ORiINOCO/AP-4000MR/HTML.

If the Help files are not located in this folder, contact your network administrator to find out where the Help files are
located on your server.

2. Copy the entire folder to your Web server.
3. Perform the following steps to specify the path for the Help files:
a. Click the Commands button in the HTTP interface.
b. Select the Help tab located at the top of the screen.
c. Enter the pathname where the Help files are located in the Help Link box. This must be an HTTP address.
d. Click OK.

Telnet CLI Does Not Work

1. Make sure you have the proper IP Address. Enter your AP IP address in the Telnet connection dialog, from a DOS
prompt, type:
C:\> telnet <AP IP Address>

2. Use the CLI over the serial port to check the IP Access Table, which can be restricting access to Telnet and HTTP.

TFTP Server Does Not Work
1. Make sure the TFTP Server has been started.
2. Verify the IP address of the TFTP Server. The server may be local or remote, so long as it has a valid IP address.

3. Configure the TFTP Server to “point” to the folder containing the file to be downloaded (or to the folder in which the file
is to be uploaded).

4. Verify that you have entered the proper AP Image file name (including the file extension) and directory path (if
needed).
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5. If you have a problem uploading a file, verify that the TFTP server is configured to allow uploads (typically the default
setting is to allow only downloads).

Client Connection Problems

Client Software Finds No Connection

Make sure you have configured your client software with the proper Network Name and Security settings. Network
Names and WEP Keys are typically allocated and maintained by your network administrator.

Client PC Card Does Not Work
1. Make sure you are using the latest PC Card driver software.
2. Download and install the latest ORINOCO client software from http://support.proxim.com.

Intermittent Loss of Connection
1. Make sure you are within range of an active AP.
2. You can check the signal strength using the signal strength gauge on your client software.

Client Does Not Receive an IP Address - Cannot Connect to Internet

1. If the AP is configured as a DHCP server, open the Web-browser Interface and select the Configure button and then
the Network tab to make sure the proper DHCP settings are being used.

2. If you are not using the DHCP server feature on the AP, then make sure that your local DHCP server is accessible
from the Access Point’s subnet.

3. If using PoE, make sure you are not using a crossover Ethernet cable between the AP and the hub.

VLAN Operation Issues

Verifying Proper Operation of the VLAN Feature

The correct VLAN configuration can be verified by “pinging” both wired and wireless hosts from both sides of the AP
device and the network switch. Traffic can be “sniffed” on both the wired (Ethernet) and wireless (WDS) backbones (if
configured). Bridge frames generated by wireless clients and viewed on one of the backbones should contain IEEE
802.1Q compliant VLAN headers or tags. The VLAN ID in the headers should correspond to one of the VLAN User IDs
configured for the AP.

NOTE: The AP-4000MR supports 16 VLAN/SSID pairs per wireless interface, each with a configured security profile.

VLAN Workgroups

The correct VLAN assignment can be verified by pinging the AP to ensure connectivity, by pinging the switch to ensure
VLAN properties, and by pinging hosts past the switch to confirm the switch is functional. Ultimately, traffic can be
“sniffed” on the Ethernet or WDS interfaces (if configured) using third-party packages. Most problems can be avoided by
ensuring that 802.1Q compliant VLAN tags containing the proper VLAN ID have been inserted in the bridged frames. The
VLAN ID in the header should correspond to the user’s assigned network name.

What if network traffic is being directed to a nonexistent host?

» All sessions are disconnected, traffic is lost, and a Forced Reload is necessary.
*  Workaround: you can configure the switch to mimic the nonexistent host.

I have just configured the Management ID and now | can't manage the AP?

» Check to ensure your password is correct. If your password is incorrect or all inbound packets do NOT have the
correct tag, then a Forced Reload is necessary.
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CAUTION: The Forced Reload procedure disconnects all users and resets all values to factory defaults.

CMOB Operation Issues

*  Client Computer can not connect to a CMOB-enabled SSID
— The PXU profile should have at least one PXU Module (Primary/Secondary) enabled
— The AP should be registered with the PXU Module
— The PXU Module (that the AP is registered with) should be registered with the Current Master PXU Module.

Refer to the ProximUnify User Guide for more details.

* AP does not register with the PXU

— The AP's "Domain Name" and "Shared Secret" should match the "Domain Name" and "Domain Password"
configured on the PXU Module.

— The PXU profile should have at least one PXU Module (Primary/Secondary) enabled.

— Management VLAN ID of the PXU module and the AP must be the same.

— VLAN status of the PXU module and AP must be enabled.

— AP must have a CMOB enabled SSID tagged to the proper VLAN ID configured in the uplink table.

* AP gets de-registered from the PXU and re-registers for no apparent reason, OR it ping-pongs between Primary
and Secondary PXU Modules.

— If MESH backhaul is being used, RF Interference may cause packet loss or connectivity loss resulting in this
scenario.

— If there is traffic congestion in the network segments connecting the AP with the PXU, refer to the PXU User
Guide for making configuration changes to mitigate this scenario.

» Client Computer associates and connects but can not ping some other computer, refer to the PXU User Guide for
more details.

Power-Over-Ethernet (PoE)

The AP Does Not Work

1.
2.

5.
6.

Verify that you are using a standard UTP Category 5 cable.

Try a different port on the same PoE hub (remember to move the input port accordingly) — if it works, there is probably
a faulty port or bad RJ-45 port connection.

If possible, try to connect the AP to a different POE hub.

Try using a different Ethernet cable — if it works, there is probably a faulty connection over the long cable, or a bad
RJ-45 connection.

Check power plug and hub.
If the Ethernet link goes down, check the cable, cable type, switch, and hub.

There Is No Data Link

1.
2.
3.

Verify that the indicator for the port is “on.”
Verify that the PoE hub is connected to the Ethernet network with a good connection.

Verify that the Ethernet cable is Category 5 or better and is less than 100 meters (approximately 325 feet) in length
from the Ethernet source to the AP.

Try to connect a different device to the same port on the PoE hub — if it works and a link is established, there is
probably a faulty data link in the AP.

Try to re-connect the AP to a different output port (remember to move the input port accordingly) — if it works, there is
probably a faulty output or input port in the PoE hub or a bad RJ-45 connection.
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“Overload” Indications
1. Verify that you are not using a cross-over cable between the PoE output port and the AP.
2. Verify that there is no short over any of the twisted pair cables.

3. Move the device into a different output port (remember to move the input port accordingly); if it works, there is
probably a faulty port or bad RJ-45 connection.
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Recovery Procedures

The most common installation problems relate to IP addressing. For example, without the TFTP server IP Address, you
will not be able to download a new AP Image to the AP. IP Address management is fundamental. We suggest you create
a chart to document and validate the IP addresses for your system.

If the password is lost or forgotten, you will need to reset the AP to default values. The Soft Reset to Factory Defaults and
Hard Reset to Factory Defaults procedures reset configuration settings, but do not change the current AP Image.

If the AP has a corrupted software image, follow the Forced Reload procedure to erase the current AP Image and
download a new image.

Soft Reset to Factory Defaults

Use this procedure to reset the network configuration values, including the password, IP address, and subnet mask. The

current AP Image is not deleted.

1. Click Commands > Reset.

2. Click Reset to Factory Default; the device is reset to its factory default state.

3. If not using DHCP, use the ScanTool or use CLI over a serial connection to set the IP address, subnet mask, and other
IP parameters. See Command Line Interface (CLI) for CLI information.

If you do not have access to the HTTP or CLI interfaces, use the procedure described in Hard Reset to Factory Defaults.

Hard Reset to Factory Defaults

If you cannot access the unit or you have lost its password, you can reset the unit to the factory default settings using the
Reload button on the power injector, as described below.

1. Using the end of a paper clip or pin, depress and hold the Reload button on the side of the unit's power injector for a
minimum of 5 seconds but no more than 10 seconds. The configuration is deleted from the unit and the unit reboots,
using a factory default configuration.

NOTE: You need to use a pin or the end of a paperclip to press the button.

CAUTION: If you hold the Reload button for longer than 20 seconds, you may go into Forced Reload mode, which
erases the unit’'s embedded software. This software must be reloaded through an Ethernet connection
with access to a TFTP server. See Forced Reload below for instructions.

2. If not using DHCP, use the ScanTool or use CLI over a serial connection to set the IP address, subnet mask, and other
IP parameters. See Command Line Interface (CLI) for CLI information.

Forced Reload

With Forced Reload, you bring the unit into bootloader mode by erasing the embedded software. Use this procedure only
as a last resort if the unit does not boot and the procedure did not help.

CAUTION: By completing this procedure, the embedded software in the AP will be erased. You will need to reload the
software before the unit is operational.

To do a forced reload:

1. Disconnect and reconnect power to the unit; the unit resets and the LEDs flash.

2. Using the end of a paper clip or pin, immediate press and hold the Reload button on the side of the unit's power
injector for about 20 seconds. Image and configuration are deleted from the unit.

3. Follow one of the procedures below to load a new AP Image to the Access Point:
— Download a New Image Using ScanTool
— Download a New Image Using the Bootloader CLI
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Because the CLI option requires a physical connection to the unit’s serial port, Proxim recommends the ScanTool
option.

Download a New Image Using ScanTool

To download the AP Image, you will need an Ethernet connection to the computer on which the TFTP server resides and
to a computer that is running ScanTool (this is either two separate computers connected to the same network or a single
computer running both programs).

ScanTool detects if an Access Point does not have a valid software image installed. In this case, the TFTP Server and
Image File Name parameters are enabled in the ScanTool’'s Change screen so you can download a new image to the
unit. (These fields are grayed out if ScanTool does not detect a software image problem.)

Preparing to Download the AP Image

Before starting, you need to know the Access Point’s IP address, subnet mask, the TFTP Server IP Address, and the AP
Image file name. Make sure the TFTP server is running and configured to point to the folder containing the image to be
downloaded.

Download Procedure
Follow these steps to use ScanTool to download a software image to an Access Point with a missing image:

Download the latest software from http://support.proxim.com.

Copy the latest software updates to your TFTP server.

Launch ScanTool.

Highlight the entry for the AP you want to update and click Change.
Set IP Address Type to Static.

PO A=

NOTE: You need to assign static IP information temporarily to the Access Point since its DHCP client functionality is not
available when no image is installed on the device.

5. Enter an unused IP address that is valid on your network in the IP Address field. You may need to contact your
network administrator to get this address.
6. Enter the network’s Subnet Mask in the field provided.

7. Enter the network’s Gateway IP Address, if necessary. You may need to contact your network administrator to get
this address. You should only need to enter the default gateway address (169.254.128.133) if the Access Point and
the TFTP server are separated by a router.

8. Enter the IP address of your TFTP server in the field provided.

9. Enter the Image File Name (including the file extension). Enter the full directory path and file name. If the file is
located in the default TFTP directory, you need enter only the file name.

10.Click OK.

The Access Point will reboot and the download will begin automatically. You should see downloading activity begin
after a few seconds within the TFTP server’s status screen.

11.Click OK when prompted that the device has been updated successfully to return to the Scan List screen.
12.Click Cancel to close the ScanTool.
13.When the download process is complete, configure the AP.

Download a New Image Using the Bootloader CLI

To download the AP Image, you will need an Ethernet connection to the computer on which the TFTP server resides.
This can be any computer on the LAN or connected to the AP with a cross-over Ethernet cable.

You must also connect the AP to a computer with a standard serial cable and use a terminal client, such as
HyperTerminal. From the terminal, enter CLI Commands to set the IP address and download an AP Image.
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Preparing to Download the AP Image

Before starting, you need to know the Access Point’s IP address, subnet mask, the TFTP Server IP Address, and the AP
Image file name. Make sure the TFTP server is running and configured to point to the folder containing the image to be
downloaded.

Download Procedure

1.

Download the latest software from http://support.proxim.com.

2. Copy the latest software updates to your TFTP server’s default directory.
3.
4. Open your terminal emulation program (like HyperTerminal) and set the following connection properties:

Use a straight-through serial cable to connect the Access Point’s serial port to your computer’s serial port.

* Com Port: <COM1, COM2, etc., depending on your computer>

* Baud rate: 9600

+ Data Bits: 8

»  Stop bits: 1

* Flow Control: None

* Parity: None

Under File > Properties > Settings > ASCII Setup, enable the Send line ends with line feeds option.
HyperTerminal sends a line return at the end of each line of code.

Press the RESET button on the AP.

The terminal display shows Power On Self Tests (POST) activity. After approximately 30 seconds, a message
indicates: Sending Traps to SNMP manager periodically. After this message appears, press the ENTER key
repeatedly until the following prompt appears:

[Device name]>
Enter only the following statements:
Device name]> show (to view configuration parameters and values)

[ ]

[Device name]> set ipaddrtype static

[Device name]> set ipaddr <Access Point IP Address>

[Device name]> set ipsubmask <IP Mask>

[Device name]> set tftpipaddr <TFTP Server IP Address>

[Device name]> set tftpfilename <AP Image File Name, including file extension>
[Device name]> set ipgw <Gateway IP Address>

[Device name]> show (to confirm your new settings)

[Device name]> reboot

Example:
Device name show

Device name set ipaddrtype static

set ipaddr 10.0.0.12

set ipsubmask 255.255.255.0

[ 1>
[ 1>
[Device name]>
[ 1>
[Device name]> set tftpipaddr 10.0.0.20
[ 1>
[ 1>
[ 1>
[ 1>

Device name
Device name set tftpfilename MyImage.bin
Device name set ipgw 10.0.0.30
Device name show

Device name reboot
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The AP will reboot and then download the image file. You should see downloading activity begin after a few seconds
within the TFTP server’s status screen.

8. When the download process is complete, configure the AP.

Setting IP Address using Serial Port

Use the following procedure to set an IP address over the serial port using the CLI. The network administrator typically
provides the AP IP address.

Hardware and Software Requirements

» Standard straight-through serial data (RS-232) cable with one DB-9 connector and one mini-DIN plug (included with
shipment).

» ASCII Terminal software, such as HyperTerminal.

Attaching the Serial Port Cable
1. Connect one end of the serial cable to the AP and the other end to a serial port on your computer.
2. Power on the computer and AP, if necessary.

Initializing the IP Address using CLI

After installing the serial port cable, you may use the CLI to communicate with the AP. CLI supports most generic terminal
emulation programs, such as HyperTerminal (which is included with the Windows operating systems). In addition, many
web sites offer shareware or commercial terminal programs you can download. Once the IP address has been assigned,
you can use the HTTP interface or the CLI over Telnet to complete configuration.

Follow these steps to assign the AP an IP address:

1. Open your terminal emulation program (like HyperTerminal) and set the following connection properties:
*  Com Port: <COM1, COM2, etc., depending on your computer>
* Baud rate: 9600
» Data Bits: 8
»  Stop bits: 1
* Flow Control: None
* Parity: None
2. Under File > Properties > Settings > ASCII Setup, enable the Send line ends with line feeds option.
HyperTerminal sends a line return at the end of each line of code.
3. Press the RESET button on the AP.

The terminal display shows Power On Self Tests (POST) activity, and then displays a CLI prompt, similar to the
example below. This process may take up to 90 seconds.

[Device name]> Please enter password:

4. Enter the CLI password (default is public).
The terminal displays a welcome message and then the CLI Prompt:
[Device name]>

5. Enter show ip. Network parameters appear:
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[Device Namel> show ip
IP/Network Group Parameters

ipadde e 1A.8.8.1
ipsubmask S 255.8.8.8
ipgw 2 18.8.8.1
ipttl H 64
ipaddrtype 2 static

[Device Namel> _

Figure 7-1 Result of “show ip” CLI Command

6. Change the IP address and other network values using set and reboot CLI commands, similar to the example below
(use your own IP address and subnet mask). Note that IP Address Type is set to Dynamic by default. If you have a
DHCP server on your network, you should not need to manually configure the Access Point’s IP address; the Access
Point will obtain an IP address from the network’s DHCP server during boot-up.

After each entry the CLI reminds you to reboot; however wait to reboot until all commands have been entered.
Device name]>set ipaddrtype static
Device name]> set ipaddr <IP Address>

]

]
Device name]>set ipsubmask <IP Subnet Mask>
Device name]>set ipgw <D